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 Welcome
Thanks to the ease of connecting to the internet these days, 
we spend an increasing amount of time plugged into our 
PCs, tablets or smartphones. Many hours are spent looking 
at the same screen everyday. 

As you might decorate your house to make it more 
pleasant to live in, this issue we’re going to show you to 
make your PC’s desktop a more habitable place to spend 
time at with a complete guide to customising Windows, on 
page 14. 

You’ll be surprised at the difference tiny changes can make 
to your routine, and that ‘new’ feeling is just too good to 
ignore. If your computer is feeling a little long in the tooth, 
the guide will show you how to give it a Windows 8 lick of 
paint, for free! Conversely, if you have the newer operating 
system already, you can find out how to restore some of the 
features you love and miss from Windows 7.

THE ONLY COMPUTER MAG TO HELP 
YOU GET MORE FROM WINDOWS

We pride ourselves in being the only magazine 
on the shelves to show you exactly how to get 
the best from the Windows operating system, 
whether it’s 7, 8, Vista or even XP. Windows 7 
Help & Advice also comes with a disc, on which 
you can find some of the great apps covered  
in the magazine. If you get a chance, take a look  
at how you can even read the magazine on your 
laptop, phone or tablet.

Includes guides for 
Windows 8 as well!
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8 Discover Make friends and influence 
people with social networking

23 Next month Gaze into the 
future… What’s happening in October?

32 Subscriptions Save up to 35 
per cent when you subscribe today!
 
42 Reader offers We’ve a selection 
of money-saving deals just for you
 
75 Overseas reader? Get your 
mag for less with a subscription 
 

76 Four pages of essential 
expert help for all your 
tricky technical queries

ReGulaRS

FeatuReS

SuppORt

Includes guides for 
Windows 8 as well!

14 Customise your PC 
Get those creative juices flowing and  
give your computer a personal touch

60 Build a media centre
Create a media pC that will send films, 
music and photos straight to your tV
 
72 Speed up your computer 
10 of the best tips, apps and websites 
to give your pC a new lease of life

explORe The best PC tutorials

Want more? Visit our website at 
www.facebook.com/windowsmag

26 Batch process  
photos quickly

30 prevent strangers  
from shoulder surfing

34 Manage your files  
quickly and easily

38 Make an Internet  
explorer super-homepage

44 Fix hardware problems  
with Device Manager 

48 Install free software  
effortlessly with Chocolatey

50 Fix your pC with  
the Windows Repair tool

54 Speed up your  
computer in five minutes

56 Sort out your budget  
with libreoffice Calc 
 
 

Your guide Nicholas Odantzis says…
“each month we include as wide a range of tutorials 
as possible, to help you use your computer more 
efficiently and inspire you to try new things.”
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Follow us on…

www.twitter.com/windowsmag

www.facebook.com/windowsmag

80 Our expert reviews  
and recommendations
82 pioneer Se-Cx8-t
82 Shure Se425
83 Monster iSport Strive
83 Sol Republic Relays
83 Bose Quiet Comfort 20i
84 asus Zenbook ux301la
86 Microsoft Surface pro 3
88 Medion erazer x7611
90 tropico 5
92 Smite
94 Warlock 2: the exiled
96 trials Fusion

97 Wargame: Red Dragon 

upGRaDe

60 Turn your television  
into a cornucopia  
of digital delights

14 Make your  
computer a  

hub of individuality 

Customise 
your PC

ultimate 
media  
centre

CuT-PRICe 
SuBS OffeR

Find out more on page 32

Save up to 35% – pay just £23.49 every six months

72 10 ways to 
give a sluggish 
computer a boost

Speed up your  
Windows 7 PC
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 NEW thiNgs to do  amaziNg WEbsitEs  fasciNatiNg facts

Lockdown cybercrime can be a big worry – but  
it just takes a little common sense to prevent it
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The Knowledge…

Ever Googled yourself? Often it’s 
harmless, but occasionally you may find 
an unsavoury result. Fortunately, thanks 
to a recent ruling by the European Union’s 
Court of Justice, you can tell Google to 
remove certain results. You’ll need the 
addresses of any websites you’d like 
removed, as well as a scan or digital photo 
of a document that verifies your ID, such 
as your driving licence or passport. You’ll 
find Google’s form at http://bit.ly/1oAsezu.

How to disguise your 
tracks on the internet

Identi ty crisis

T
hanks to the ubiquity of internet-
connected devices, we’re online 
more often and in more places 
than ever. But there is a dark side 

to this world: cyber criminals want our 
money, our identities and our information, 
and they’re often successful in getting 
them. We’ll show you how to stay safe and 
cover your tracks when you’re online.

Of course, you don’t need to cover 
your tracks if you don’t make any in the 
first place. Using a 
PC in an internet 
cafe is a secure 
way to browse the 
internet, providing 
you don’t log in to 
any sites. Having to go to a specific place 
to access the internet kind of defeats the 
point of mobile, unlimited internet access 
though. Fortunately, most browsers come 
with incognito or private browsing modes, 
which mean anything you enter is wiped 
when the window is closed down.

In Internet Explorer, pressing 
[Ctrl]+[Shift]+[P] opens an InPrivate 
window, while [Ctrl]+[Shift]+[N] opens 

an Incognito window in Chrome. These 
modes are particularly useful if you don’t 
want sensitive information – such as 
passwords – to be stored by your browser. 
They’re also useful for checking out 
suspicious internet links as they prevent 
websites accessing personal information.

However, incognito modes won’t stop 
spyware or malware accessing your 
keystrokes or passwords. For these you 
need a robust antivirus package that’s 

kept up to date. It’s 
a good idea to run 
scans regularly to 
stop nasties getting 
in, and to use any 
identity protection 

tools included with the software.
Google’s internet searches tend to 

deliver the best results, but at a price – the 
company tracks the things you search for 
so it can deliver relevant adverts to you. 
If you’re not happy about this, you can use 
Duck Duck Go’s (http://duckduckgo.com) 
search to find what you’re looking for 
without being tracked. We’ve found it to 
be as accurate and useful as Google.

staying safe when you’re online is more important than 
ever. these handy tips allow you to avoid its dodgy bits

Microsoft Cortana
I think my dad used to drive one of those 
back in the 1970s…
You’re thinking of a Cortina. Cortana is 
Microsoft’s new voice search system, and 
it’s named after an artificial intelligence 
system in the company’s Halo video 
games. We’ll ignore the fact that in those 
games it goes a bit wrong…

So what does this cortana do?
Like Google Now and Apple’s Siri, Cortana 
is designed as a virtual personal assistant 
that can understand your voice and speak 
back to you. Ask it what the weather’s 
doing and it’ll tell you. It can solve 
mathematical equations and search the 
internet for words or phrases.

what makes it different to now or Siri?
Microsoft reckons that Cortana takes 
the best from both systems, delivering 
Now’s in-depth analysis with Siri’s more 
personable nature. So it’ll figure out when 
you like your phone to be switched to 
silent mode, or warn you about travel 
issues on your route to work.

where can I use it?
While Now and Siri are locked into 
Android and Apple devices respectively, 
Cortana will be available to developers 
so that it can be integrated into just 
about anything. Microsoft has already 
demonstrated it with Facebook and Skype.

when can I try it?
Cortana is set for beta testing in the US 
in the next few months, with launches 
planned for the US, UK and China by the 
end of the year. You’ll be able to access it 
via a Windows Phone 8.1 device, but it’s 
rumoured to be heading to the Xbox One 
and Windows machines too.

InformatIon Start by entering your country of 
residence, as well as your name and email address.

be forgotten attach your Id and submit. google 
will assess whether the results should be removed.

UrLS copy and paste the relevant web addresses, 
and tell google why you want them removed.

IdentIty WIpe Tell Google to forget you

“google’s internet searches 
tend to deliver the best 
results, but at a price”

Discover
Online security
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HENRY WINCHESTER 

TECH EXPERT

Tip of the month Bye-bye Bing

Struggling to get something to work? Need a tip? 
Then email us your woes (to windowsmagazine@futurenet.com with the subject line 
‘Windows Insider’) and we’ll share your perfect Windows tweaks in a future issue.

A desktop jam-packed with icons doesn’t 
make for a productive computing 
environment, but simply shifting them all 
into your My Documents folder can make it 
hard to find things. There is a third option 
though, and it’s rather underutilised: adding 
files and folders to the Start Menu. To move 
an icon here, right-click on it and drag it into 
the Start Menu, pausing to open folders if 
necessary. Once you’ve found its destination, 
release the right mouse button and you’ll see 
a pop-up asking you if you want to copy the 
icon, move it or create a shortcut. Choose 
one of these options and the file will be 
copied or moved here. It’s very handy if 
there’s a diagram or instruction manual PDF 
relating to a particular program.

Pin to Start Menu

The good ol’ Windows key, which sits 
between the [Ctrl] and [Alt] keys on your 
keyboard, was introduced with Windows 95, 
but it really got going with Windows XP. Just 
pressing it will bring up the Start menu, but 
there are also lots of nifty shortcuts attached 
to it. Press [Windows]+[Break] and you’ll see 
your system’s properties, including memory, 
processor and Windows version details. 
[Windows]+[D] jumps to the desktop, and 
pressing it again brings up all your windows, 
while [Windows]+[M] minimises everything. 
Open My Computer with [Windows]+[E], and 
use [Windows]+[F] to search your computer.

Windows key shortcutsBy default, empty optical drives or memory 
card readers don’t show up in Windows 7’s 
file explorer. This means that it’s easier to get 
straight to external files or folders, but if 
you’re having problems with your drive or 
reader it helps to know that it’s been 
detected by Windows. However, it is possible 
to show your empty drives by opening an 
Explorer window and choosing ‘Organize’ 
followed by ‘Folder and search options’ and 
then clicking the ‘View’ tab. Untick the box 
next to ‘Hide empty drives in the computer 
folder’ and then click on the ‘OK’ button. Next 
time you go to My Computer you will see all 
the drives currently attached to your 
computer – even if they are empty.

Hide empty drives

Microsoft’s Internet Explorer – the 
default web browser provided with 
Windows 8 – has a bit of a reputation 
for being notoriously rubbish, thanks 
to numerous bugs and a lack of 
features. However, the latest version is 
rather impressive, and we love the way 
it renders fonts and pages. Its search 
engine, Microsoft’s Bing, is still a bit of 
a sore spot though, as it isn’t quite as 
good as Google for delivering relevant 

results. To switch your search engine, 
launch Internet Explorer from the 
desktop, then click the ‘Settings’ gear 
icon, followed by ‘Manage Add-ons.’ 
Next, choose ‘Search providers’ and 
‘Find more search providers’. You’ll 
now be taken to Internet Explorer’s 
Add-on gallery, which is full of useful 
search engines and mini apps. Click 
one to install it, and use the settings 
icon to manage your Add-ons.

Change Internet Explorer’s search
It’s really simple to swap to another search provider 
in IE – and you’ll find a bunch of mini apps too

Switch your Search other search engines available for 
internet explorer include yahoo! and Duck Duck Go, the latter of 
which doesn’t track your searches
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Download this…

Follow us on…

www.facebook.com/windowsmag

www.twitter.com/windowsmag

FRIDAY

August 2014
NEXT ISSUE ON SALE

29

W
hen it was released a couple 
of years ago, Microsoft’s 
Windows 8 operating system 
promised to reverse the 

company’s fortunes in the face of stiff 
competition from Google’s Android and 
Apple’s iOS devices. Critical to this was 
its ability to run on tablets – the small, 
low-power touchscreen computers that 
have now become ubiquitous.

It hasn’t quite gone to plan 
though. According to analyst 
Gartner, although almost 
200 million tablets were 
sold in 2013, just 2.1 per 
cent shipped with 
Windows 8. It’s a 
figure which is 
easily dwarfed 
by Android’s 
61.9 per 
cent market 
share, and 36 per 
cent for Apple’s iOS. 
However, Microsoft could be 
about to play its trump card by making 
Windows 8.1 free for tablet manufacturers 
to install on their devices.

The cheapest Windows 8 tablet – Dell’s 
Venue 8 Pro – costs around £250/$250. 
Apple’s similarly-specified iPad Mini is 
the same price, but you can pick up a 
decent Android-powered tablet with a 
comparable screen size and processor for 

about £100/$100, which makes you see 
how Google has conquered the market.

A big part of the problem with 
Windows 8 tablets is that manufacturers 
have to pay a licensing fee to install the 
operating system, as well as splashing out 
on the components and distribution costs 
involved in making a tablet. It’s always 
been this way – buy a computer and the 
price includes a £50 premium to own the 
copy of Windows that resides on it.

Operating systems must be 
paid for somehow, 

though. Android 
raises cash 
through Google’s 

understanding of 
advertising. Microsoft’s 

free version of Windows 8, 
dubbed Windows 8.1 with Bing, will 

work similarly, with Internet Explorer 
and Bing search enabled by default so 

the company can reap some cash.
Microsoft has also slashed the system 

requirements for Windows 8.1, so it 
will run on cheaper and less powerful 
hardware. Potentially, this will result in 
the release of a raft of cheap Windows 8.1 
tablets, beginning with Toshiba’s Encore 
2, which will be priced at £119/$199. 
The move to a free operating system is 
exactly what Microsoft needs right now, 
and hopefully it will turn a two-horse 
race into a three-horse one.

Microsoft has finally decided to give away its famous 
operating system – but only for small tablets

Everyone’s talking about...

1Which creature took 

a ‘selfie’ using a 

dropped phone at West 

Midlands Safari Park?

A) A chimpanzee
B) A gorilla
C) An elephant

2Which actor will be 

in Call of Duty: 

Advanced Warfare?

A) Arnold Schwarzenegger
B) Jeremy Irons
C) Kevin Spacey

3 What speed will the 

next generation of 

Wi-Fi, 802.11ax, achieve?

A) 10 gigabits per second
B) One terabit per second
C) 56 kilobits per second

4 What’s the retail 
price of luxury 

phone manufacturer 

Vertu’s latest device?

A) £19,750
B) £10,750
C) £6,750

5 Which Hollywood 

studio is giving away 

its animation software?

A) Pixar
B) DreamWorks
C) LucasFilm

6 What is Google’s 
latest proposed 

method of distributing 

the internet?
A) Low-orbiting satellites
B) Refracting telescopes
C) Ultraviolet laser beams

Pens at the ready, your time starts now!The 60-Second Quiz

Answers 1C, 2C, 3A, 4C, 5A, 6A

Windows for free Spell Up
https://spellup.withgoogle.com
Google’s latest Chrome Experiment (its 
name for interesting add-ons for its web 
browser) sits somewhere between a 
Countdown conundrum, hangman and a 
voice-activated computer from a science 
fiction film. It’s a game that invites you to 
spell words correctly, solve anagrams and 
fill in missing letters. The twist is that you 
do so by listening and speaking to your 
computer, so you’ll need a microphone 
and speakers as well as the Chrome 
browser. You’ll also need to make sure 
your family or friends know what you’re 
doing or they might think you’re shouting 
random words and letters at your PC.

We have a sneaking suspicion that Spell 
Up is Google’s sly method of enhancing 
its voice recognition and speech synthesis 
algorithms, but it’s still a fun way to 
improve your spelling and pronunciation.

Spell Up Build yourself a tower of words  
with Google’s latest Chrome experiment

Discover
Tech talk
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…of South Australian smartphone users 
haven’t locked their phone with a passcode 
or password, according to the University of 
Adelaide’s Communications Department. 
Some 63 per cent of public Wi-Fi users never 
run virus checks, and two thirds of those who 
disposed of phones were unsure if they’d 
wiped their data. The University recommends 
installing a virus scanner, and being cautious 
when signed in to public Wi-Fi networks.

Are older people getting 
more internet sAvvy?

Which gaming systems 
Were most popular in 
2013?

We typically think of the internet as a hip place 
inhabited by technologically-minded young people, 
but research conducted by digital marketing firm 
iProspect paints a rather different picture. It found that 
people over 50 regularly and confidently shop online, 
and 92 per cent of those aged over 70 feel that their 
age isn’t a barrier to online use.

‘Brand value’ is calculated annually by 
research agency Millward Brown, using a 
combination of a company’s turnover and 
its standing among customers. Google has 
been declared the top brand of 2014, with 
its partnership with Ray-Ban owner Luxottica 

adding to its value. 
Google’s promotion 

kicked Apple off the 
top spot for the first 
time in three years, 

with IBM, Microsoft 
and McDonald’s 
making up the 

rest of the top five.

Which technology 
company has the  
highest brand value?

40 per cent…
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Henry Winchester reveals a host  
of fascinating digital facts

brand value

34%  
seventh 

generAtion 
consoles (XboX 360, 

plAystAtion 3)

19%  
smArtphones  
And tAblets

6% 

4% 
33%  

personAl 
computers

4% eighth  
generAtion  

consoles (XboX one, 
plAystAtion 4)

6% gAming-dedicAted 
hAndhelds  

(nintendo 3ds, 
plAystAtion  

vitA)



Primary school 
children prefer to 
text, email or play a 
game than interact 
with their families 

during mealtimes. Just seven per 
cent of children eat without any 
technological distractions, and 
12 per cent said they never want 
to eat dinner with their parents. 
Table Table, the pub chain that 
conducted the research, said: 
“We encourage parents to spend 
less time serving up square eyes 
with their square meal.”

The modern commuter doesn’t 
spend hours on a train with 
their face in someone’s armpit, 
or wait for an age in slowly-
moving traffic to get to work. 
Instead they ‘telecommute’, 
using the internet to work from 
home. It’s a growing trend – in 
2001, 2.1 million UK workers 
telecommuted, a number that 

rose to 2.8 million in 2011. 
Some 59 per cent of employers 
let workers telecommute, and 
they save an average of $1,000 
(£597) a week by doing  
so according to a report  
by Intuit.

nine  
out of 10...

should we use 
emoticons  
At work?

Are older people getting 
more internet sAvvy?

Which gaming systems 
Were most popular in 
2013?

Emoticons – such as a 
smiley face or a wink – 
are generally frowned 
upon in the workplace, 
and are more suited to 
casual conversations. According 
to corporate mobile messaging 
company Cotap, 81 per cent of 
workers struggle to convey emotions 
in professional communications, 
with disappointment and frustration 
being the trickiest feelings to get 
across. Seventy-five per cent of 
workers would be willing to use 
emoticons at work.

Are you A telecommuter?

The site was started as an experiment by Kevin Rose, Owen 
Byrne, Ron Gorodetzky and Jay Adelson in November 2004.

The ‘social news aggregator’ allows users to share and 
recommend web content, ‘digging’ stories they like and 
‘burying’ ones they don’t.

Digg was refined with v2 and v3 in 2005 and 2007 respectively. 
Each update added new features and functions.

In 2007 Kevin Rose was named as one of the top 35 innovators 
in the world under 35 by MIT Technology Review TR35.

By 2008, the site’s popularity had rocketed, and it attracted 
over 236 million visitors within the year.

To cope with its immense success, the site underwent a huge 
redesign in August 2010, dubbed Digg v4.

However, the launch was marred by sitewide glitches and 
bugs, and Rose resigned in March 2011.

The Digg brand, website and technology were sold to internet 
company Betaworks in July 2012 for a mere $500,000.

Betaworks redesigned the site from scratch, launching an 
all-new Digg v1 in August 2012.

Top Digg facTs
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cuStomiSe
your Pc

Don’t leave your Windows machine looking grey and 
drab – it’s time to get those creative juices flowing with 
our guide to making your PC a hub of individuality

T
hink of the hours you spend 
using your PC – browsing 
the web, organising your 
photos and working in 

Office. The chances are that it occupies 
a fair proportion of your time. Yet few of 
us take the opportunity to make its 
environment as comfortable as the 
room that it’s placed in. Windows 
includes a number of ways to make 
your desktop look and feel different to 
everyone else’s. We’re not all clones, so 
why should we put up with computers 
that might as well be identical?

It doesn’t take much to find a truly 
individual image for your wallpaper. 
However, this simple change can make 

a huge difference. Once you start 
altering the appearance of Windows 
and the sounds that accompany system 
events, you have the beginnings of a 
custom environment. With a little more 
effort, you can even modify the icons 
used to identify programs and 
Windows components. You could 
design your own or make use of some 
of the many free icon sets that are 
available online. With Windows 8 now 
popular, why not give Windows 7 a 
makeover and even get it to imitate the 
newest version? Computing should be a 
fun yet comfortable experience, and 
customising the look of your desktop 
PC or laptop is just the start…

Cover feature 
Customise your PC
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ICON SWITCH Changing your desktop icons is an 
easy way to customise your PC’s look

1 Change the 
baCkground

Right-click the desktop and choose 
‘Personalize’, followed by ‘Desktop 
Background’. Here you can select each of 
the thumbnail images to see it previewed 
on your desktop. Take a look through them 
to find one that you like. Once you’ve settled 
on the picture you want, click ‘OK’ to set it  
as your background. If none of them take 
your fancy, why not try one of your own 
photographs or pieces of artwork? Click 
‘Browse’ and find the folder containing the 
picture that you want to use. Once you’ve 
found it, click ‘Open’. Select your chosen 
photograph to add it to the desktop.

Image size
Open Paint by selecting ‘Start > All Programs > Accessories’, 

then select ‘Paint’. Click the downwards arrow next to the ‘Home’ 
tab and click ‘Properties’. Select ‘Pixels’ as the unit size, then set the 
Width and Height at 32 each for a medium icon, 48 each for a larger 
icon, or 256 for the largest icons. When you’re satisified with the 
dimensions of your new icon, click ‘OK’.

Zoom and create
Select the ‘View’ tab and click ‘Zoom in’ so you can work with 

the individual pixels on your new icon. To make things a little 
easier, check the ‘Gridlines’ box. Draw your icon, referring to your 
design on squared paper. Once complete, select ‘File > Save As’, 
give it a file name and choose 24-bit bitmap as the file type. 
Finally, change the file extension to ICO.

2 get a desktop-
fIttIng Image

Not all images are desktop shaped. You can 
still use them for the background, but you 
need to decide how to fill the desktop. Use 
the options marked ‘How should the picture 
be positioned?’ to select whether to repeat 
the image all over the desktop, to surround 
it by a coloured border or to stretch the 
image to fit the desktop. Some pictures 
stretch well, while others look odd and 
distorted. It’s worth trying out each option 
to see which looks best.

3 Change  
the theme

Right-click on the desktop and choose 
‘Personalize’. Choose a theme from the list to 
quickly change the overall look and feel of 
the desktop. Windows 7 includes a number 
of ready-made themes, each with their own 
backgrounds, window colours and sound 
schemes, to give an overall change to the 
look and feel of your PC. Applying a new 
theme is the quickest way to give your 
computer a makeover. You can always 
tweak it later on to make it more personal.

4 modIfy the 
aero theme

Back in ‘Personalization’, choose ‘Window 
Colour’ then ‘Appearance’. Here you can 
change the Aero colour scheme and tweak 
the degree of transparency. Select one of 

the pre-set colours and use the slider to 
change the intensity of the colour. You can 
also turn off transparency by clearing the 
box marked ‘Enable Transparency’. To create 
your own shades of Aero colour, click ‘Show 
colour mixer’ and use the sliders to set the 
hue, saturation and brightness to taste.

5 get advanCed 
optIons

There are more ways you can customise the 
look and feel of Windows if you opt for a 
Windows classic theme. To do this, right-
click the desktop, choose ‘Personalise > 
Window Colour’ and click ‘Advanced’. Here 
you can change individual colours and fonts 
for each item in the scheme. Select the item 
you want to modify from the drop-down list 
and specify the colour or font. Click ‘OK’ 
twice to confirm your changes. Even with a 
classic template, you can still express your 
personality with a few simple changes.

6 replaCe your 
desktop ICons

A very effective way to achieve a new look  
is by switching the icons for your most 
commonly used programs. There are a few 
alternative icons available for Windows 
items and often for third-party programs  
as well. To alter a desktop shortcut icon, 
right-click it and select ‘Properties’. Click the 
‘Change’ button to see the list of available 
icons for that shortcut. If there aren’t enough 
icons in this list for you, click ‘Browse’ and 
look for any other icon files. 

1 2

Step-by-step | Create new icons for your programs
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simple custom tweaks

folder icons
Now select the folder that you would like to customise with 

your brand new icon. Right-click it and choose ‘Properties’. Now 
select the ‘Customise’ tab – click on ‘Change Icon’ to customise the 
picture that represents this folder. In order to add your new 
image, click ‘Browse’ – this will allow you to find the file that you 
created earlier in Paint.

apply the icon
Now browse to the location of your new icon file and click 

‘Open’. You’ll now be able to see the file on its own in the icon list. 
To proceed, simply select it and click ‘OK’. You’ll need to click ‘OK’ 
for a second time to clear the Folder Properties dialogue box – the 
folder now has your new, self-designed icon for all to see. Apply it 
as you see fit and marvel at your funky new icon.

3 4

Cover feature 
Customise your PC
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fIles on desktop
There’s a jumble of files 
stored on the desktop, 
making it hard to navigate.

standard wallpaper
This desktop has 
the default 
Windows 7 
wallpaper, so it 
doesn’t stand out 
at all.

seleCted wIndow
The selected window 
in the dock is 
magnified and its title 
is displayed below. 
Click it to maximise.

unused desktop shortCuts
All unnecessary desktop files 
and shortcuts are now tidied 
away inside this folder.

musIC fIles
This desktop is cluttered 
with random music files, 
which make it hard to find 
real program shortcuts.

roCketdoCk
RocketDock provides an 
attractive way to browse 
this PC and to manage 
open Windows.

wIndow theme
This window has 
Aero transparency, 
but it’s the default 
sky blue, which is 
hardly inspiring.

wIndow Colour
By selecting the 
Nature Theme, the 
Aero glass in each 
window becomes  
this attractive 
autumnal colour.

nature baCkground
The wallpaper comes from the Nature 
theme. It changes every 30 minutes.

Improve navigation and the look and feel of Windows 7

Before After



RAINMETER Get customisable skins, such as 
weather forecasts, on your desktop

record a sound
An easy way to really stamp your own personality on your 

computer is by replacing the sounds with ones you’ve recorded or 
collected yourself. Use Audacity (http://audacity.sourceforge.net), 
which is an intuitive audio manipulation program – it’s also free to 
use! Connect a microphone to record each of the sounds you 
want to use and save each of them as separate WAV files.

windows sounds
Right-click the desktop and select ‘Personalize’, followed by 

‘Sounds’. In this dialogue box you can modify the existing sound 
scheme, save a new one or apply one that you saved earlier. To 
ensure you can change the audio files around, make sure that 
you’re in the ‘Sounds’ tab. This lists the sounds played with each 
Windows event. Select a sound scheme to modify.

7 Create ICons 
from a photo

Browse to http://icofx.ro and download and 
install IcoFX. Choose ‘File > Import image’ 
and select a picture you’d like to turn into an 
icon. If it’s bigger than 256 x 256, enter its 
dimensions here – or cancel, resize it in your 
usual graphics program and import it again. 
Choose ‘Icon > Create icon from image’ – 
now supply the resolution and colour depth 
of each of the icons that you want to 
generate, then click ‘OK’. You can now edit 
and save each one individually.

8 brIng baCk the 
start menu

If you’re using Windows 8, you might miss 
the Start menu of old, which used to reside 
in the bottom left-hand corner of the 
screen. You can easily get it back though – 
just install Classic Shell (www.classicshell.net) 
which will restore the original Start menu, 
giving you back features like Search and Run 
boxes, a Recent Items menu, a familiar 
shutdown menu and more. You also get 
useful extras, like a menu of your Windows 8 
apps which you can launch.

9 Install 
raInmeter

To make more fundamental changes to your 
desktop, try installing a skinning program 
such as Rainmeter, which you can download 

from http://rainmeter.net/cms. This is an 
open source program, which provides lots  
of room for additional tweaks to really 
customise your system. There’s quite a lot to 
it, but don’t feel too overwhelmed as it’s 
relatively straightforward to navigate. At its 
most basic, you can install the program plus 
one of its recommended skins for a quick 
desktop makeover.

10 emulate 
wIndows 8

Why not keep up with the Joneses and  
get a feel for Windows 8 by making 
Windows 7 look the same? There are  
several toolkits available, but the most 
straightforward is Omnimo, which you can 
download from http://omnimo.info. This is a 
skin for Rainmeter (see above) that can make 
your PC look as though it’s running the 

Windows 7 Phone interface, or you can opt 
to add the Windows 8 start theme to your 
desktop. There’s also a full Windows 8 pack 
available to download, too!

11 download 
roCketdoCk

Finding your way around the clutter of 
shortcuts on your desktop, Start menu  
and Taskbar can be a real pain, and may 
make you hanker after a Mac OS-style dock. 
If so, download and install RocketDock from 
http://rocketdock.com to browse your 
system with a bit more style.

12 Clear the 
desktop

Back in the days of Windows XP, there was a 
desktop clean-up wizard that tidied away 
older items on the desktop every 60 days. 
For a simple alternative, right-click the 
desktop and choose ‘New > Folder’. Call it 
unused desktop shortcuts and drag 
anything you don’t want to see into it.

13 hIde the 
taskbar

You can free up some screen space by 
hiding the Taskbar so that it only shows 
when you need to use it. Right-click an 
empty part of the Taskbar, choose 
‘Properties’ and select ‘Auto-hide’. To access 
it, just drag the mouse to the bottom of 
your screen and it pops up.

1 2

Step-by-step | Modify the sound scheme
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Change a sound
Select one of the Windows events with a sound icon next  

to it. Press the ‘Play’ button and you’ll be able to listen to the 
current sound linked to that Windows event. Click ‘Browse’ and 
locate one of the sounds you recorded earlier. When you’ve found 
it, click ‘Open’. We advise testing the sound again to ensure that 
you have the correct one selected.

save as a sound scheme
Replace as many of the Windows sounds as you like to 

personalise your PC, by simply repeating the previous steps. 
We’ve found the most effective ones to replace are those played 
when you enter and exit Windows. If you don’t like your own 
sounds, there are plenty of ready-made ones to be found online. 
When you’re done, be sure to save your customised scheme.

3 4

Cover feature 
Customise your PC
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deeper customisation

baCkground
Admittedly, this is 
an attractive 
wallpaper picture, 
but it’s still used by 
many and it could 
be tied into the 
theme better.

taskbar
WindowBlinds ensures that 
the Taskbar matches the 
windows, so this, too, looks 
as though it’s been hewn 
from polished marble.

lIbrary ICons
These Library icons  
were swapped with 
IconPackager to match the 
other core Windows icons. 

wIndow Colour
This colour comes from the 
selected theme. It’s better 
than the default, but we 
could do more.

lIbrary ICons
These are the default Windows 
icons for each of the libraries 
on this PC. They look okay, but 
they won’t win awards.

new ICons
All core icons have 
been swapped using 
IconPackager. The 
Recycle Bin looks like 
a laundry basket.

taskbar
The Taskbar matches 
the colour of the Aero 
glass in the windows. 
There’s no texture.

marble wIndow
Thanks to 
WindowBlinds, this 
window now looks  
as though it’s been 
constructed from 
attractive marble.

baCkground
This is a custom wallpaper that 
makes the desktop look like wood. 
This comes from www.getcliparts.com.

Skin your windows and swap your icons for a new look

Before After

Core ICons
The Windows core icons for 
folders and items such as the 
Recycle Bin are the system 
standard ones. Boring!



14 add texture  
to wIndows

If you want to go a bit further than just 
changing the colour of your windows,  
try giving them some texture with 
WindowBlinds. You can get a 30-day trial 
from www.stardock.com/products/
windowblinds. If you’re impressed and 
want to upgrade it, the full program costs 
$19.95 (£13). Be sure to choose a texture 
and click ‘Apply Changes’ to give your 
Windows 7 a real makeover. 

15 download 
more skIns

You can vastly increase the number of skins 
available to WindowBlinds by downloading 
new ones from the extremely useful www.
wincustomize.com. Pop the URL in your 
internet browser, select ‘WindowBlinds’ and 
click ‘More’ to browse through a large 
collection of skins that have been designed 
and uploaded by the WinCustomize 
community. You can also choose ‘Get more 
skins’ within WindowBlinds itself.

16 downloads  
In start menu

To add your Downloads folder to the Start 
menu, right-click the ‘Start’ button and 
choose ‘Properties’. Click the ‘Customize’ 
button. In the resulting dialogue box, scroll 
down to Downloads and choose ‘Display as 
a link’ or ‘Display as a menu’. Click ‘OK’ to 
confirm your selection and check the Start 
menu to see the new link.

17 alter the sIZe 
of jump lIsts

You can change the number of items shown 
in Windows 7 jump lists. As a default, 10 
items are normally shown. Right-click the 
‘Start’ button and choose ‘Properties’, then 
click ‘Customize’. At the bottom of the 
dialogue box that appears, change the 
number of recent items to display in jump 
lists. Once you’re done, simply click ‘OK’.

18 swap the Core 
set of ICons

We’ve already told you how to change 
individual icons, but Stardock’s  
IconPackager enables you to swap the 
standard set of Windows icons for  
matching custom suites. You can get a 
30-day trial from www.stardock.com/
products/iconpackager. The full program 
costs $9.95 (£6.50) if you want to  
upgrade. Launch it, select the icon package 
you want and click ‘Apply Changes’.

19 get more ICon 
sets for wIn7

As with WindowBlinds, you can get extra 
content for IconPackager from www.
wincustomize.com. Go to the site, scroll 
down to the list of programs, choose the 
‘IconPackager’ tab and then select ‘More’. 
Browse to a set of icons that you want to 
use, select it and choose ‘Download’. You 
can now import them into IconPackager.

20 Change the 
user pICture

Windows automatically assigns a picture  
to your user account. To change it, select 
‘Start > Control Panel > User Accounts > 
Family Safety’ and click ‘Change your 
account picture’. You can pick one of the 
available images or opt to browse for your 
own – click ‘Change Picture’ to confirm. Try 

to use a square picture where  
possible, so that its proportions  
look right when applied as your image.

21 tIle open 
wIndows

You can tile open windows spread across 
your desktop, as in Mac OS, using Switcher. 
You need to install Switcher from http://
insentient.net. Using its default settings, 
hold the left [Windows] button and [Caps 
Lock] to tile your windows. Each has a 
number assigned to it. Press the appropriate 
number to choose that window.

22 remove text 
from ICons

Sometimes icons look better without text. 
Try renaming a desktop shortcut to a single 
space and Windows doesn’t let you. But you 
can force it to accept a space as the name 
by holding down [Alt] and typing 255 on 
the number pad. Rename multiple shortcuts 
by using additional spaces.

23 swItCh maIn 
desktop ICons

You can change the core Windows icons 
that appear on the desktop by opening 
Control Panel and choosing ‘Appearance 
and Personalization’, followed by 
‘Personalization’ and ‘Change Desktop Icons’ 
in the left-hand pane. Now check or clear 
the boxes for each of the main icons. You 
can also change the icons here, too.

FEEL IT Pick colours and textures you like

USER PICTURE Customise your account image by picking one that reflects your mood or personality
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nicholas’ conclusion

Nicholas Odantzis acting editor

With all these different ways to make your computer look and feel like a unique environment, 
there’s really no excuse not to dive in and start making some changes. There are loads of free 
wallpaper images available online, so why not have a quick search to find something that 
matches your mood? Even better, set one of your own photographs as your desktop 
background. You can’t get any more individual than that!

Put a bit of thought into how you want items such as your windows and icons to appear. It 
may be enough to set your own colour scheme in Aero, or you could use a third-party 
program such as WindowBlinds to apply a new texture. Ensure that the window colour and 
texture complement the background images that you’re using. The effect is so much more 
pleasing if icons, colours, background and sounds all work together to create a consistent 
environment. If you want to get a bit more advanced, why not try modifying the logon 
background and screensaver? Don’t forget that there are many useful programs such as 
Switcher that change the behaviour of Windows to add yet more customisation. Above all, 
make sure that you have fun and be individual!

24 modIfy mouse 
poInters

Right-click the desktop and choose 
‘Personalize > Mouse Pointers’. You can 
modify individual pointers by selecting one 
in the current scheme and clicking ‘Browse’. 
Replace this with any static cursor file with 
the extension CUR or an animated cursor file 
with the extension ANI.

25 add new 
poInters

Mouse pointers are distributed online in sets 
of CUR or ANI files. Download the file, unzip 
it and then replace the pointers that you 
want to change. A good place to start 
looking is http://cursors.funutilities.com. 
Once downloaded, choose ‘Browse’ in 
Mouse Pointers to install the file.

26 Create a 
Cursor Image

You can also make your own cursor files by 
creating suitably small bitmap images and 
saving them with the CUR extension. Use a 
graphics program such as Paint to create or 
edit the image file in the same size as your 
ICO files and save it as a 24-bit BMP file.

27 dIsable  
jump lIsts

Jump lists can give away the files you’ve 
been using to anyone else with access to 
your PC. To disable them, right-click the 
Taskbar and choose ‘Properties > Start 

Menu’. Clear the box marked ‘Store and 
display recently opened items in the Start 
menu and Taskbar’.

28 get a new log-
on sCreen

You can change the background image for 
the logon screen using Tweaks.com’s Logon 
Changer for Windows 7 (http://tweaks.com/
software/tweakslogon). Once installed, 
launch the program and choose ‘Change 
Logon screen’.

29 turn folder 
Into toolbar

Right-click an empty part of the Taskbar and 
choose ‘Toolbars > New Toolbar’. Select the 
item that you want to use as a toolbar and click ‘OK’. Your new toolbar appears as a 

button on the Windows Taskbar. Click this to 
see an expanding menu of its contents.

30 bypass a 
welCome

To bypass the welcome screen, type run 
into the Start search, then type control 
userpasswords2 in the Open bar. Click ‘OK’ 
and clear the box ‘Users must enter a user 
name and password to use this machine’.

31 add a desktop  
toolbar

Right-click the Taskbar and choose ‘Toolbars 
> Desktop’. This adds the word Desktop to 
the Taskbar. Click the arrow to the right of 
this to get access to these shortcuts. ■

MENU PROPERTIES You can customise what 
appears in your Start menu

NEW POINTER Bored of the same old arrow 
mouse pointer? If, so choose a different one
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on your disc
Install the free windows 
essentials suite from the 
Extras section.
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Get more from Windows, software and all your favourite sites

packed with informative tutorials
Every issue, we guarantee to pack the 
magazine with great tutorials teaching 

you all the best things you can do with your PC. 
Each article features step-by-step instructions 
to make learning new skills fast and enjoyable.

customise windows to work your way
We all know how to do the basics but 
getting the most from Windows isn’t 

always easy. Our dedication to the operating 
system means you get the very best tips and  
tricks for all versions of Windows.

Get more from your favourite websites 
We all have our list of favourite sites  
but often we miss out on great features 

because they’re difficult to use or hidden from 
sight. We’ll show you how to do more online, 
for a more satisfying web life.

use our full software to try new things
Our exclusive industry access enables us  
to pack your free disc with full commercial 

software. From speed-up and security software 
to superb photo apps, there’s always 
something new to try on your PC.

Welcome
Whether  
you’re stuck for 
inspiration or 
want to become  
a master of your 

Windows computer, our 
Explore section is the place 
to come. Each month we pack 
it with tutorials covering  
a range of subjects suitable for 
all levels of expertise.

This month, Mayank shows 
you how to install and update 
free software in moments, Dan 
helps you resolve the hardware 
problems that are plaguing 
your PC, and Matt explains 
how to use free software to 
get your finances in order. 
There’s never been a better 
time to see how your PC can 
make your life easier than ever!
Nicholas Odantzis,  
acting editor 
nick.odantzis@futurenet.com Turn to page 34 for more

Full listing…

Your guide  
Nick Peers says…
“Dropit is a tiny free 
tool that’s designed to 
speed up common file 
and folder operations 
such as copying, moving, 
renaming and encrypting.”

This issue’s free disc is packed 
with full software, essential 
toolkits, apps and resources  
to help you get the most  
from your computer.

Look out for the badge 
(below) pointing to key files  
for the article you’re reading.
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Learn how to…
Batch process 
photos quickly

“Rename, convert, resize and 
retouch dozens of photos at once 
with FastStone Image Viewer.”

enaming, converting and 
editing images can be slow, 
laborious and – above all – 

monotonous. Open image, resize, 
save as JPEG to share online, rename, 
repeat ad infinitum. Install FastStone 
Image Viewer, however, and you’ll 
never have to slog through this 
process again. FastStone is primarily 
an image-viewing tool with some 
editing capabilities built in, but it’s 
the Batch Convert/Rename tool that 
makes it an essential addition to your 
photographic toolkit.

The tool lets you select a group of 
images from different folders, then 
convert, rename and edit them in 
moments. You can even make major 
adjustments to all of your selected 
photos with just a few clicks – see 
the annotation for details. Read on 
to discover how to revolutionise the 
way you process your photos in the 
future, leaving you more time to get 
out and about with your camera.

1 Get your tools
Install FastStone Image Viewer from the cover disc – it’s 

completely free for personal use. Launch the program and then 
select ‘Tools > Open Batch Convert / Rename Dialog’ to open the 
batch processing tool. You’ll see two tabs: Batch Convert and 
Batch Rename. Both tools work independently of each other. If all 
you want to do is rename some files, select that tab to get started.

2 Select files
Click ‘…’ next to the C:\ path in the left-hand pane to select 

the folder containing all (or some) of the files you wish to rename. 
Select each file by holding [Ctrl] as you click on it, then click ‘Add’ 
to include them in the list of files you wish to process. Switch 
folders to find more files if you need to. If you inadvertently add 
the wrong file to the Input List, select it and click ‘Remove’.

Step-by-step Speed up image processing with FastStone

Your guide Nick Peers says… Before/After
Use these preview 
windows to gauge 
the effects of your 
selected adjustments 
on the currently 
selected image. 

Input LISt
This lets you select 
any of your photos 
as the preview 
image, letting you 
see how each photo 
will be affected. 

R
Anyone can do it 
Straightforward
Tricky in parts

 Windows 8
 Windows 7
 Windows Vista
 Windows XP

At a glance…
SKILL LeVeL

tIme tAKen

SuItABLe for

15 minutes
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In  the next  issue  Enhance summer photos

3 Rename using template
You have two choices when renaming: ‘Use filename 

template’ renames all your files based on a single template. The 
default choice renames the files Image00001, Image00002 and 
so on. Use the Template drop-down box to choose a different 
template, or click the ‘?’ button to see what options are available 
to you. Click inside the drop-down box to add your own text.

4 Rename with replaced text
Choose ‘Search and replace’ to replace specific text in the 

filename; up to three phrases or words can be replaced this way. 
Tick ‘Case sensitive’ only if you want to differentiate between ‘Tree’ 
and ‘tree’, for example. When you’re done, click the magnifying 
glass to preview your changes – make further refinements as you 
see fit. When you’re happy, click ‘Rename’.

AdjuStment 
controLS
Use the sliders to 
set the adjustment 
levels – click the ‘X’ 
button next to a 
slider to reset it.

photo effectS
Tick these boxes 
to create grey 
scale, negative or 
sepia-tinted photos, 
or a combination of 
all three effects. 

mAIn VIew
The selected 
image is displayed 
here in more detail. 
Click ‘Hold down to 
preview’ to see your 
proposed changes.

AdjuSt VIew
These controls let 
you adjust the size 
of the preview. You 
can click and drag 
inside the image to 
pan around it. 

NIck’s best tiP!
Output converted photos to 
a new folder to try different 
settings without fear of 
damaging the original files.

Explore 
Batch process photos quickly
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9 Watermarks and borders
Use the ‘Text’ tab to write a text caption or watermark over 

each photo; you can use a number of preset variables such as 
filename and image dimensions. The text can be positioned in 
the corners or centre, and even made semi-transparent. Add an 
image-based watermark using the ‘Watermark’ tab, and frame 
your photos with one of five border effects.

7 Access editing options
Tick ‘Use advanced options (resize…)’ and then click the 

‘Advanced options’ button. To resize all your images, tick the 
‘Resize’ box. Four options are available – choose ‘Percentage’ or 
‘Resize based on one side’ if your photos are a mixture of portrait 
and landscape shots. Use the ‘Rotate’ tab to flip or rotate your 
photos if required, and select ‘Crop’ to crop by size or aspect ratio.

5  Batch convert
To convert and edit a group of files using the same settings, 

switch back to the ‘Batch Convert’ tab. Select your files following 
the same procedure outlined in step two. Use the Output Format 
drop-down menu to select a different image type if you wish to 
convert your files to a new format, and click ‘Settings’ to fine-tune 
that file type’s settings to optimise quality or prioritise file size.

10 Ready to process
A preview button lets you see the effects of all your 

edits before you commit to them. Your current settings are also 
preserved for future use, but you can save them as an options 
file if you wish to be able to switch quickly between different 
settings in the future. Click ‘OK’ when you’re done editing, then 
click ‘Convert’ to apply all the changes to your selected photos. ■

8  Image adjustments
The ‘Color depth’ tab lets you reduce the number of colours 

in a photo, typically to reduce its file size. The ‘Adjustments’ tab 
includes specific settings for brightness, contrast, gamma and 
more. You can also create greyscale, sepia and negative images. 
Click the ‘Design and Preview’ button to edit these with more 
precision, using the annotation on the previous page as a guide.

6 Output folder and rename
Click ‘Browse’ next to Output Folder to select the folder you 

want your converted images placed in – we suggest creating a 
new folder – or untick ‘Output Folder’ if you want them saved 
in the same folder as the original images (not recommended if 
you’re simply editing or renaming photos). You can rename your 
files at the same time using the template method outlined earlier.

28  |   Help & Advice  |  September 2014



full office power 
without the cost

or find us in your nearest supermarket, newsagent or bookstore!

delivered direct to your door 
Order online at www.myfavouritemagazines.co.uk

OUT 
NOW!
WiTh 
FREE 
DiSC



Learn how to…
Prevent  
shoulder surfing

“Worried about strangers peeking at your laptop 
when you’re using it in public? This simple tool will 
make any information on your screen glance-proof.”

houlder surfing is one of 
the oldest tricks in the book 
to glean information from 

unsuspecting users. You can encrypt 
all your data and protect it with 
secure passwords, but once you’ve 
unlocked it in a public place, there 
is little you can do to stop anyone 
from peeking over your shoulder and 
seeing your personal information or 
documents. This issue is becoming 
more acute as corporate workplaces 
become more public and transparent.

AntiSnooper helps you reclaim 
your personal space by letting 
you obscure the contents of open 
windows. You can use it to protect 
the contents of your Facebook wall 
while you’re chatting with a friend 
in another window, or obscure the 
text of one document while you’re 
working on another. You can test 
the tool by using a 15-day free trial 
version, after which you’ll need to 
buy a licence for £9.39/$15.

1 Download and install
The tool is available as an executable installer or a zipped 

archive from www.bagrify.com/AntiSnooper.html (web address 
is case-sensitive). Download the installer and double-click on it 
to start the setup process. During setup, you’ll need to decide 
whether you want it to create a Start menu folder and a desktop 
icon. Once installed, AntiSnooper will start automatically.

2 Basic settings
The tool will take you to the ‘Options’ tab, where you 

can configure some basic settings. The section contains three 
checkboxes. The first starts the tool automatically when the 
computer boots up, the second minimises the tool to the system 
tray instead of the Taskbar, and the third keeps the software 
updated. For best results you should enable all three options.

Your guide Mayank Sharma says…

S

Mayank’S beSt tip
If you use multiple monitors, 
the tool can obscure the 
contents of windows open in 
other displays.

Step-by-step Protect your privacy

Anyone can do it 
Straightforward
Tricky in parts

 Windows 8
 Windows 7
 Windows Vista
 Windows XP

At a glance…
SKILL LEVEL

TImE TAKEn

SuITAbLE for

10 minutes
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7 Customise profiles
Repeat steps 3-6 to obscure other windows as well. Once 

you’ve finished, switch to the ‘Protected Profiles’ tab to review and 
customise the behaviour of the protected profiles. This window 
lists the name of the program that the window belongs to and 
the method of protection – screensaver or text obscurity. Click on 
the corresponding buttons to edit a profile or delete it.

8 Done
You can now minimise AntiSnooper to the System Tray and 

get back to using Windows as usual. When you move focus away 
from one of the open windows protected by AntiSnooper, it will 
be obscured as per the specified settings. You can temporarily 
disable protection for a window by bringing up the tool from the 
System Tray and heading to the ‘Window Protection’ tab. ■

5 Protection options
When you select a window to protect, you’ll be presented 

with AntiSnooper’s Protection Options. Use the ‘Protection 
Time-Out’ dialler to specify the period of inactivity (in seconds) 
after which the window will be obscured. Then use the ‘Obscure 
Factor’ dial to specify the level of obscurity. You can preview the 
results in the Test Application window at the top.

3 Select windows
Go to the ‘Windows Protection’ tab to select the windows 

you wish to obscure. Under this tab, click on the bar that reads 
‘Mouse Window Selection’ to bring up the Finder Tool. Now 
open the windows you wish to obscure – it could be an Explorer 
window, a browser window or any other application. Click and 
hold the magnifying glass icon and drag it to the window.

6 Window screensaver
In addition to obscuring text, AntiSnooper also lets you 

protect the window by displaying a screensaver on top. To try 
this, click on the bar that reads ‘Window Screensaver’ to bring up 
the list of supported screensavers. Click on the ‘Play’ button next 
to each screensaver to have a look at it in the preview window. 
To use a screensaver, click on the corresponding radio button.

4 Protect windows
If the windows you want to protect are already open, you 

can also obscure them by clicking on the bar that reads ‘Manual 
Window Selection’. This will list all of the open windows. From this 
list, select the entry corresponding to the window that you wish 
to protect and click the ‘Window’ icon to highlight the window. 
To protect the window, click on the ‘+’ icon.

Explore 
Prevent shoulder surfing

September 2014  |   Help & Advice  |  31



     

Includes guides for 
Windows 8 as well!

SubScribe 
and Start 
Saving today!

Start SubScribing from aS 
little aS £23.49 every 6 monthS 

TERMS AND CONDITIONS This offer is  
for new UK print subscribers only. You will 
receive 13 issues in a year. Full details of  
the direct debit guarantee are available on 
request. If you are dissatisfied in any way 
you can write to us or call us to cancel your 
subscription at any time and we will refund 
you for all unmailed issues. Prices correct  
at point of print and subject to change.  
For full terms and conditions please visit 
www.myfavm.ag/magterms. Offer ends:  
2nd September 2014.

Save a fantastic 35%  
when you subscribe to 
Windows 7: help & advice

S ubscribe to Windows 7 Help & Advice 
and get the only guide you’ll ever 
need for getting more from your 
Windows computer, whether you 

own a desktop, laptop or tablet.
if this world of computers is new to you, we’ll 

show you how to get to grips with the different 
operating systems, whether that’s Windows XP, 
vista, 7 or Windows 8. We also go in-depth with 
a wealth of features and tutorials which, for 
example, will show you how to speed up your 
Pc, reinstall your operating system should you 
experience problems, and make your computer 
secure against internet viruses and scams. you’ll 
even save money as we go to lengths to find the 
best hardware for you.

Nicholas Odantzis, acting editor 
nick.odantzis@futurenet.com

Want  
the digital edition?  turn to p53

a Windows 7 Help & Advice subscription 
also makes an ideal gift for a friend or a loved 
one. imagine the look of glee on their face, not 
only when they open your present but every 
month for a whole year!

Windows 7 Help & Advice is the essential guide 
to getting the most out of your Pc. it’s 100 per 
cent jargon free and you can get 13 issues of the 
magazine direct to your door for just £23.49 by 
six monthly Direct Debit. 

32  |   Help & Advice  | September 2014



     

tWo eaSy WayS to SubScribe
click: www.myfavouritemagazines.co.uk/WoMP2S 

call: 0844 848 2852 quoting code WoMP2S 
lines are open 8am to 9.30pm weekdays, and 8am to 4pm Saturdays 

hurry! offer ends: 2nd September 2014 

Why 
SubScribe?
n  Save up to 35% on the 

shop price  
n  Pay as little as £3.61  

per issue
n  get clear, informative 

articles and advice 
delivered to your door

n  get your copy up to a 
week before it hits the 
shops! 

hoW Much?
n  £49.99 – one year 

subscription – Save 30%
n  £23.49 –  six month 

subscription – Save 35%

don’t MiSS 
out!
n  get the boss to pay  

with our corporate subs 
scheme. for more details 
visit www.myfavourite 
magazines.co.uk/
corporate-subscriptions

n  See pages 37 and  
53 for great digital 
subscription offers

n  live overseas? turn to 
page 75 for a special 
money-saving offer!

September 2014  |   Help & Advice  |  33

Subscribe and receive  
UK subscription offer



Learn how to…
Manage your files 
quickly and easily

“Take the stress out of file management by letting 
DropIt organise and process selected files and folders 
speedily, simply and automatically.”

ropIt is a tiny free tool that’s 
designed to speed up 
common file and folder 

operations such as copying, moving, 
renaming and encrypting. You can 
set it up to monitor selected folders 
automatically, or manually drag files 
and folders on to the DropIt icon, 
which floats above all other windows 
on the desktop.

DropIt uses a series of ‘associations’ 
to select files, filtering them by name, 
type or even properties. It then 
performs a specific action on the 
selected files, which you can 
customise to suit your personal 
needs. You can set up multiple 
associations covering a wide range of 
files and types, and even organise 
your associations into profiles for 
specific tasks. If you regularly find 
yourself performing the same 
file-based tasks over and over again, 
you’re going to love DropIt.

1 Set up DropIt
Install DropIt from the cover disc, or download and run the 

portable version from www.dropitproject.com. If installing, tick 
‘Launch DropIt’ at the end of the setup before clicking ‘Finish’. 
You’ll see an arrow appear on-screen – this is the DropIt tool, 
which floats on-screen above other windows. Click on it and drag 
it somewhere less distracting – a right-hand corner, for example.

2 Your first association
DropIt works by creating ‘associations’ that process files 

based on a set of rules. For our first example we’re going to create 
a simple association that moves any JPG file dragged on to the 
DropIt icon to your Pictures folder. First, locate a JPG file and drag 
it on to the DropIt icon. Click ‘Yes’ when prompted, then give it a 
suitably descriptive name to help you identify it.

Your guide Nick Peers says…

D

Nick’s best tiP
Right-click the Dropit icon 
and choose ‘Hide’ to place it 
in the taskbar notification 
area instead of the desktop.

Step-by-step Get started with DropIt

Anyone can do it 
Straightforward
Tricky in parts

 Windows 8
 Windows 7
 Windows Vista
 Windows XP

At a glance…
SKILL LEVEL

TIME TAKEn

SuITAbLE for

30 minutes
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7 More filter options
You can also apply filters based on file properties, attributes 

and even file content. Click the funnel button next to the ‘i’ button 
to choose these. Tick a filter to enable it, then click the ‘>’ drop-
down menu to make the filter apply when the file is greater than 
(>), equal to (=) or less than (<) the given attribute. File content 
lets you match based on words or text strings.

8 Actions: compress
Click the ‘Action’ box to reveal different actions you can 

perform on a file – one action can be performed per association. 
Use ‘Compress’ to pack together all the files selected by the filter 
into a single archive file, for example. Note how the final box 
changes depending on what option you select – for compressed 
files, click ‘Configure’ to choose an archive type, for example.

5 Create second association
Right-click the DropIt icon and select ‘Associations’ to 

manage existing associations and create new ones from scratch. 
You’ll also see a Default drop-down menu. Clicking this reveals 
that DropIt supports profiles, allowing you to organise and switch 
available associations depending on specific circumstances. We’ll 
cover those later – for now, click ‘+’ to create another association.

3 Verify rules and action
You  will notice that the Rules box is already pre-filled with 

*.JPG, indicating that the association will only apply to files whose 
names end in .JPG. Click the ‘Action’ drop-down menu to see a list 
of all 18 actions you can perform using the program. As this rule is 
designed to simply move all JPG files that are dragged on to the 
DropIt icon to your Pictures folder, leave ‘Move’ selected for now.

6 Apply more complex rules
Each rule uses a set of filters to determine which files or 

folders to process. Click the ‘i’ button next to the box to see 
examples of filters you can create based on the file or folder 
name. Use the * character as a wildcard for files, and ** characters 
for folders. Use the / character to exclude items. To apply multiple 
filters, separate each one with either a semi-colon or | character.

4 Complete action
Click the folder button next to Destination Folder to select 

your Pictures folder (if you try to select your Pictures library, 
DropIt will simply create a Pictures folder on the desktop for your 
files), then click ‘Save’. You’ll notice that the association isn’t 
performed immediately – instead, click the ‘Play’ button and the 
file will be magically moved. Test it with another JPG file.

Explore 
Manage your files quickly
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13 Manage profiles
To set up and manage profiles, right-click the DropIt icon 

and choose ‘Profiles > Customize’. Click ‘+’ to create a new one. 
Give it a suitable name, then click the ‘Search’ button to pick the 
icon DropIt will use when the profile is selected. Alter its 
dimensions to change its size and use the Opacity slider to adjust 
transparency, if required. Click ‘Save’ when you’re done.

11 Use profiles
DropIt supports profiles – collections of related associations 

that can be applied for specific purposes. The program includes a 
number of profiles with pre-built associations for a variety of uses, 
including creating music playlists and compiling text lists of files. 
To switch profiles, right-click the DropIt icon and select your 
profile from the Profiles drop-down menu.

9  Actions: rename
The Rename option is good for quickly renaming digital 

camera photos that have unhelpful filenames, such as GEDC0500.
jpg. After selecting ‘Rename’, click the book icon next to the file 
name to reveal a list of options that can be inserted into the 
renamed filename. Select ‘Images’ to see a list of naming options 
including file dimensions and the date when the photo was taken. 

14 Monitor folders
To have DropIt monitor folders automatically, right-click the 

DropIt icon and choose ‘Options > Monitoring’. Tick ‘Enable scan 
of monitored folders’, then click ‘Add’ to choose a folder using the 
folder button. Select the profile whose associations you want to 
process on any files in the selected folder and click ‘Save’. Repeat 
for any additional folders you wish to monitor. ■

12  View profile associations
You’ll see the DropIt icon change to the profile icon that’s 

been selected to help identify which one you’re using. To see 
what associations this profile performs, right-click the icon and 
choose ‘Associations’. You can transfer any of these to another 
profile: right-click one and select ‘Copy to’ to do so. Select another 
profile from the drop-down menu to view its associations.

10 More actions
Other handy actions include creating image galleries, music 

playlists and shortcuts, changing a file’s properties, or even 
ignoring it altogether. The latter option is best used for creating 
exclusion filters, so files matching the rule are immune to any 
other associations you’ve set up. To make this work, click the star 
button next to its name to prioritise it over other associations.
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Learn how to…
Make an Internet Explorer 
super-homepage

“Make your Internet Explorer homepage the best 
place to be by adding all your favourite websites. 
You’ll find it more useful than ever.”

hen you open Internet 
Explorer, the first site you 
see is your homepage. 

This could be the site that your PC 
manufacturer put on there, or it could 
be one you’ve subsequently chosen 
yourself. If you visit lots of the same 
sites regularly – as many of us do – 
rather than typing each URL into the 
address bar every time you want to 
open them up, or laboriously finding 
them from your Favorites list, you can 
create a homepage which opens your 
best-loved websites automatically 
when you start up Internet Explorer. 
These sites will be displayed as tabs 
along the top of the window, or they 
can be viewed as large thumbnails, 
which you simply click on. 

It’s easy to create a homepage 
featuring all your favourite sites  
in individual tabs, and it will  
save you lots of time and effort.  
Once you’ve done it you’ll wonder 
how you ever lived without it!

1 Download the latest version
To create a multi-tab homepage, you’ll first need to make 

sure you’ve downloaded the latest version of Internet Explorer 
– unless you’re already using it. You can download it free from 
http://bit.ly/1nE4Fmp. The installer will guide you through each 
step of the process. Once it’s done, you’re ready to open Internet 
Explorer and move on to the next step.

2 Select homepages that you want to use
Start by selecting all of the websites you’d like to see open  

on your homepage. The easiest way to do this is to choose your 
preferred sites from the ones that you’ve saved in your Favorites 
folder. Click on the ‘Favorites’ folder at the top of the Internet 
Explorer toolbar, right-click on any website you want to include 
and click on ‘Open in new tab’. 

Your guide Nick Odantzis says…

W

Nick’s best tip
Consider adding your email 
inbox and Facebook to your 
homepage, plus a news site 
to help you stay up to date.

Step-by-step Put all your favourite websites on your homepage

Anyone can do it 
Straightforward
Tricky in parts

 Windows 8
 Windows 7
 Windows Vista
 Windows XP

At a glance…
SKILL LEVEL

TIME TAKEn

SuITAbLE for

30 minutes
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7 Quickly manage tabs
There are lots of handy shortcuts available in Internet 

Explorer, and if you’re planning to use tabs a lot when browsing, 
learning them will save you valuable time. Our favourites are 
[Ctrl]+[T] to open a brand new tab, while [Ctrl]+[W] closes the 
currently open tab. Alternatively, you can switch between your 
open tabs by using the [Ctrl]+[Tab] keys.

8 You’re all done
Congratulations – you’ve created a homepage that displays 

all your favourite sites as soon as you open Internet Explorer, 
no typing required. You’ll no longer have to waste precious time 
opening tabs and browsing to the sites that you use every day. 
One final word of warning, though: don’t choose too many 
websites as this can slow down your computer. ■

5 Remove website tabs
Likewise, if you get bored of any of the sites on your 

homepage, you can remove single tabs just as easily without 
having to start from scratch. Again, underneath the Homepage 
area, just delete tabs you don’t want to see any more and click 
‘OK’. If you want to remove them all, just select all the websites 
and delete them – easy!

3 Create a homepage of tabs
Click on the cog to the right of the little ‘Favorite’ icon in 

the top toolbar of Internet Explorer and select ‘Internet Options’. 
When a new window appears, click on ‘Use current’ underneath 
the Homepage area, and Internet Explorer will automatically add 
all your current tabs as homepages. Now just click ‘OK’ to set these 
pages to your homepage.

6 Save your homepage
If you’re planning to create more than one homepage of 

websites, it’s a good idea to save each of these to your Favorites, 
so you can swap between them when you like. Click on ‘Favorites’ 
in the toolbar, click on the arrow to the right of the ‘Add to 
Favorites’ button, select ‘Add current tabs to Favorites’ and choose 
a name to easily distinguish between homepages.

4 Add single tabs to your homepage
You can add more tabs at a later date without the hassle 

of creating a new homepage simply by adding single tabs to 
your current homepage. Just click on the cog to the right of the 
Favourite icon once more, and underneath the area where it says 
Homepage, click ‘Use new tab’, enter the name of your additional 
site and click ‘OK’.

Explore 
Make a super-homepage
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Set up multiple user 
accounts for your family

Create a handy wireless 
network in minutes

Learn how to…
Set up multiple user 
accounts in Windows 7
Everyone should use multiple accounts for different users on their 
home computer, even if it’s just to prevent silly accidents

ome is where the heart  
is, as the saying goes. It’s 
also where your PC is. It’s a 

machine you may share with your 
husband or wife, and possibly your 
kids, if they’re old enough to use it. 

But the last thing you want is for 
them to be able to mess up the PC by 
deleting important files or changing 
settings, or to have to put up with 
your partner’s awful choice in 
desktop wallpaper when you’re 
trying to get some work done. 
Thankfully, with the easy process of 
setting up additional user accounts 
on a Windows 7 PC, you can keep all 
of your computing lives separate and 
ensure that your kids can’t uninstall 
any safeguards – such as Windows 
Live Family Safety – that you’ve put 
there to keep the family PC safe. 

Everyone should use multiple user 
accounts on their home machine, and 
you can get started in 10 minutes, so 
there’s no reason not to.

1 Control Panel
The tools we need to create new user accounts on our PC 

are tucked away in the Windows Control Panel. Begin by clicking 
the ‘Start’ orb on the left of your Taskbar, then click ‘Control Panel’, 
on the right-hand side. In the window that pops up, you should 
see the option ‘Add or remove user accounts’ listed under User 
Accounts and Family Safety. Left-click it.

2 A new account
You’ll see a screen that lists your current user accounts. If 

you’re like most people, these are your own account and a guest 
account, which is switched off. It theoretically allows people 
without accounts to use your PC without any risk of harming it, 
but it’s much more secure to leave it switched off. Left-click 
‘Create a new account’ to continue.

7 Parental controls
You should be back at the ‘Make Changes’ page at this point 

– if you’re not, double-click the account you want to tweak. The 
‘Set up Parental Controls’ link enables you to set up various 
restrictions on standard user accounts. Click it, then click on the 
account you want to change. You can set time limits for computer 
use, block certain applications and more – ideal for children.

5 Customising
Click the ‘Create Account’ button to finalise this new 

account. Now let’s give it a bit of personality. Double-click on  
the account and click ‘Change the Picture’ to choose from a vast 
selection of images to represent the account on the login screen. 
Click the one you want to use, then click the ‘Change Picture’ 
button at the bottom of the window to select it.

3 Pick a name
Now type the name of the new account in the box. This 

might be the name of the person who will use it, or anything you 
like – but bear in mind that this will be displayed on a login screen 
when you start up Windows, so keep it clean! Next you need to 
choose the type of account you wish to create, ‘Administrator’ or 
‘Standard’. But which to choose?

8 Switch and test
It’s time to test your new account. Click the ‘Start’ orb on the 

left-hand side of your Taskbar, then click the arrow to the right of 
‘Shut Down’. Choose ‘Switch User’ to go back to the Windows login 
screen, click your new account and then log in using the 
password you set. You’ll see a clean, unfettered desktop, 
indicating that your new account is now active. ■

6 Password protect
Click ‘Create a Password’ to begin the process of protecting 

your newly created account with, yes, a password. You don’t have 
to do this – you could keep your kid’s account password-free, for 
example – but it’s a good idea. Type the password in both of the 
boxes at the top, then a hint (don’t make it too easy to guess) in 
the bottom box. Now click ‘Create Password’.

4 To administrate?
If you want the user of the new account to be able to easily 

install and modify software, by all means make it an administrator 
account. Any other user, however, should definitely have a 
standard account. It’s actually more secure if you use a standard 
account day to day yourself, and save your administrator account 
for major changes.

Step-by-step Make a new account

TOP TIP!
If you choose ‘Log Out ’ rather 
than ‘Switch User ’ when 
changing accounts, your 
applications are closed.

Works with…
OS H

Essential 
guide

     Windows 8
     Windows 7
     Windows Vista
     Windows XP

Learn how to…

If you’re not connecting wirelessly, you’re 
missing out on a lot of networking flexibility!

3 What’s around? 
Left-click the stepped icon and you’ll see all the networks in the 

area. These might include those owned by your neighbours, because 
Wi-Fi signals readily travel through walls. You can check the signal 
strength and various other information about each network by 
hovering the mouse pointer over them.

4 Pick your network 
You need the log-in details of your desired network – its name, 

otherwise known as the SSID, and its password – before you can 
connect to it. That’s not something we can help you with, because it’s 
different for everyone. Click on the network name you want to 
connect to, then click the ‘Connect’ button. 

BREAK FREE If you ever want to 
disconnect from a network, click 
here. This can be handy if there  
are multiple networks close by and 
you want to make sure you’re 
connected to the right one.

SEE THE STRENGTH The green 
stepped icon displays the at-a-
glance strength of any networks in 
the vicinity. We can see here that the 
‘onion’ network is the strongest in 
our neighbourhood.HARDWARE SETTINGS From here 

you can change the settings for the 
physical  network adapter that is 
inside your PC. You can prevent or  
allow your machine’s visibility.

FIX PROBLEMS If you’re having 
network connection problems, then 
this is the place to go. You’re taken 
step by step through the things you 
need to fix.

EASY ACCESS Everything you  
need for your network can be found 
by clicking this icon, from new 
connections to the status of your 
current connection.

Get a wireless 
network

 Dongle
This is a colloquial term 
given to a small bit of 
hardware that extends  
your computer’s 
capabilities – a USB 
Wi-Fi module, for 
example, or an external 
sound card.
 

 Router
A router or access point 
is a piece of hardware 
that manages multiple 
connections on  
a network, and 
broadcasts and 
receives Wi-Fi signals. 
Your router might 
include a modem to 
connect to the internet, 
or it might connect to a 
separate cable modem.
 

 SSID
The Service Set 
Identifier is the name 
given to a wireless 
network. Each network 
in the vicinity needs a 
different SSID, or their 
signals will clash.

1 Plug it in 
This won’t be applicable if you have a relatively recent laptop, 

but you may need to plug in a wireless dongle before you’re able to 
pick up a Wi-Fi signal. Insert it into a USB port and Windows 
automatically sets it up. Wait for the appropriate message to pop up 
before continuing.

2 Check the status 
All being well, you’ll have a small icon similar to a set of steps in 

your Taskbar at the very bottom-right of the screen. Hover your 
mouse over this and you’ll see the current status of your wireless 
connection. If you’re currently disconnected, it has a yellow flash over 
the top of it, too.

i-Fi isn’t just the next 
generation of networking – it’s 
true digital freedom. Forget 

sitting next to your internet connection. 
If you can hook your laptop (or 
smartphone, or even desktop 
computer) up to a wireless network, 
you can wander about where you 
please and enjoy mobile access with no 
additional charges. Of course, you need 
to stay in range of your access point. 
Most have a realistic range of 50 feet or 
so, but if you can get access to the 
actual router hardware, and if it has 
external aerials, it’s worth pointing 
them in the direction you’re likely to be, 
so that you get a stronger signal. You’ll 
find a wireless network gives you so 
much more freedom, enabling you to 
use your PC wherever in your home is 
most convenient. Read on to connect 
wirelessly today! 

Essential 
guide

Step-by-step Get hooked up to Wi-Fi

WWorks with…
OS

     Windows 8
     Windows 7
     Windows Vista
     Windows XP

Jargon buster!

Every month in Windows 7 Help & Advice we include all the best 
tutorials to help you do more with your Windows PC, whether 
you’re a beginner or you’re looking for more advanced help. For 

those of you who are new to the magazine, and – possibly – new to 
Windows, we want to make sure you’re able to learn the basics of what 
your machine can do. In each issue, we are now going to include eight 
of the handiest tutorials to get you started, all of which can be found  
on the cover disc in PDF format. Just load the disc and enjoy!

Our new range of tutorials shows you 
how to get to grips with Windows

Master 
the basics

Everyone should use multiple accounts for different 
users on their home computer, even if it’s just to 
prevent silly accidents, such as children disabling 
programs that they’re not supposed to.

If you’re not connecting to the internet wirelessly, 
you’re missing out on the freedom that it offers. 
Speeds are good, too – most modern routers are 
fast enough to rival an Ethernet connection.

Learn how to…
get the guides here

You can find all the 
tutorials in PDF format 
by either tapping here 

or using this link 
http://bit.ly/OQNy4r
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Back up your files in case 
the worst happens

Transfer all your old files  
to a new computer

Manage all your emails 
using Windows Mail

Create the perfect desktop 
environment for your PC

Learn how to…
Back up your files in case 
the worst happens
Would you want to lose everything if your computer went kaput? Of course not, 
so it pays to create a backup of your PC – here’s how to do it

hen you buy a new PC 
or build your own, you 
should make it a priority 

to back everything up. If you don’t 
and something goes wrong, you 
could lose everything on it. 

Creating a backup doesn’t 
require any specialist knowledge, 
and takes the same amount of 
time as it does to watch an 
episode of Coronation Street. The 
initial backup takes a little while 
to complete, but subsequent 
backups don’t take anywhere near 
as long, because you’re only 
making copies of files you’ve 
recently changed or added. 

To make a backup, you need 
something to save your files on. 
Most people use an external 
hard drive because they’re 
cheap, have a very large 
storage capacity, and you can 
plug them in with a USB cable 
and use them immediately. 

1 Choose a drive
To start backing up files from your PC, plug in your external 

hard drive and click ‘Start > Control Panel > System and security > 
Backup and restore’. Now click on ‘Set up backup’ and select your 
external hard drive from the list of possible destinations. Before 
you proceed, make sure that the external hard drive is bigger than 
the internal drive you’re backing up. 

2 Different location
If you have more than one PC, you might prefer to back up 

to a network drive. The benefit of this is that all the PCs on your 
network can access it, so you don’t need an external hard drive 
for each one. To save files to a network drive, click on ‘Save on a 
network’. Enter the location of the network (browse for it on your 
PC), then enter the username and password.

Create a backup right now

7 Resurrect your PC
If something goes wrong and you want to restore your PC 

using your backup, go to the Backup and Restore Center and click 
on ‘Restore my files’. If there’s a serious problem and you can’t 
even access Windows, press [F8] on your keyboard before the 
Windows logo shows during startup, insert your Windows 7 CD 
and choose ‘Repair your computer’. 

5 Make an image
Keep the ‘Include a system image of drives’ 

tick box checked if you want to be able to easily 
restore your PC if something goes wrong, then click 
‘Next’ and confirm that you’re backing up the right 
folders. If you want to change how often you back 
up your PC, click on ‘Change schedule’. 

3 Back up everything
Select what you want to back up. The easy 

option is ‘Let Windows choose’. This backs up most 
of your files and folders, except ones that aren’t 
needed, or can’t be backed up. It also creates a 
system image, like a mirror of your PC, so if there’s 
a problem with your PC, you can easily restore it.

8 Breathe a sigh of relief
You should now be feeling much more confident, because 

your PC is a lot safer. You’ve created a backup of your PC on an 
external hard drive or network drive, and you can restore it to its 
old settings if anything gets wiped accidentally. You can even get 
everything back if you have a more serious problem that prevents 
you loading Windows. ■

6 Change schedule
By default, backups 

are made once a week, but 
if you use your PC a lot, it 
might be a good idea to 
increase the frequency of 
backups. On the other 
hand, if you don’t use your 
PC much – perhaps only a 
few times a week – you can 
reduce how often you 
perform a backup. The best 
time to make a backup is 
when you’re not likely to be 
using your computer, such 
as overnight or when you’re 
at work. This is especially 
true if you have a lot of  
files to back up. Use the 
drop-down menus to 
change the schedule. Click 
on ‘OK’ and your computer 
begins making a backup.

4 Pick and choose
If you only want to select a few folders to back 

up, rather than most of what’s on your PC, select the 
‘Let me choose’ option from the list. This also gives 
you the opportunity to change when you perform a 
backup. Click on ‘Next’ and select the folders that 
you would like to include in your backup. 

Jargon buster!
 Network 

Two or more PCs 
linked together using 
Ethernet cables or a 
wireless connection 
so they can 
communicate with 
each other and share 
files, printers and an 
internet connection.
 

 USB
Short for Universal 
Serial Bus, USB is the 
de facto standard for 
connecting things to 
your PC. 

FIND THE SOLUTION! Save hard drive space 
Go to the Backup and Restore Center, click ‘Manage space > 
View backups’ and delete all but the most recent backup.

Works with…
OS W

Essential 
guide

     Windows 8
     Windows 7
     Windows Vista
     Windows XP

Step-by-step Create a backup right now

1  Find it 
To start transferring files from one Windows 7 computer to 

another, type Windows Easy Transfer into Start Search and hit 
[Return] to open it. The process for Windows 8 is almost identical. If 
you’re transferring from a Windows Vista or Windows XP computer, 
you need to download and install it from http://tinyurl.com/n8ge3b.

7  Transfer it 
Once the file is saved, click ‘Next’, then ‘Next’ again, then ‘Close’. 

Now turn on your new PC, plug in the external hard drive you copied 
the Windows Easy Transfer file to, browse to it and double-click it. 
When prompted, enter the password and on the next screen click 
‘Transfer’. Your old items are transferred over.

5  Select less 
If you’d like to customise which files or settings Windows 

transfers, click on ‘Customize’ underneath your computer’s name, and 
select or deselect folders you’d like to copy. To delve even deeper and 
further customise what you transfer, click on ‘Customize > Advanced’, 
select more folders and then click ‘Save’.

3  Which PC? 
First of all, you’re going to transfer files over from your old 

computer, so you need to select ‘This is my old computer’ from the 
two options that appear. Windows now takes a good look through 
your hard drive to see what sort of items you can transfer to your new 
Windows computer. 

2 Choose how to transfer 
Once you’ve opened Windows Easy Transfer, click on the ‘Next’ 

button in the box that opens. The following screen asks you how you 
want to transfer items to your new PC. If you’ve got an Easy Transfer 
cable, choose this option – if not, opt to use an external hard disk or 
USB flash drive, or transfer via a network.

8 Moving stuff 
You now have a new PC that looks like your old one, and all 

your files have been transferred to the hard drive, so there’s little left 
to do except install old programs. Click ‘See a list of programs you 
might want to install’ for a report of which apps you should install, 
based on what you were using on your old computer. n 

6  Protect and save 
All your files and settings are saved in one file, which you can 

password-protect. This prevents anyone tampering with it before it’s 
moved. Next choose where to save the file – we saved it to a portable 
external drive. Saving can take a while depending on how big the file 
is, so do something else while you wait.

4  Select what to transfer 
If you’re happy with everything Windows has found on your 

computer to transfer, click on ‘Next’. Windows Easy Transfer tells you 
how big the files you’re transferring are in the bottom right-hand 
side, so check there’s enough space on your external drive if that’s 
how you’re going to transfer them.

Learn how to…
Transfer files to  
your new computer
Save heaps of time when moving files from an old computer to a new 
one – just use Windows Easy Transfer. It’s easy, and we’ll show you how!

eople often make life more 
difficult for themselves than 
they need to. They buy a new 

computer, and then spend hours 
needlessly copying files across from 
their old PC, folder by folder, tweaking 
the desktop so that it looks the same as 
it used to, and adding all their shortcuts 
to the menus. 

Sometimes, you’ve just got to step in 
and lend a hand, and we’ve 
recommended to many a friend that 
they do the job with Windows Easy 
Transfer instead. It helps to migrate files 
and settings, such as photos, contacts 
or favourites, from one PC to a new one 
– so everything is ready to use just like 
before. Windows Easy Transfer is 
pre-installed in Windows 7 and 8. If 
you’ve got Windows Vista or Windows 
XP, though, don’t worry because you 
can download and install it for free. 

Works with…
OS P

Essential 
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Step-by-step Transfer data from one PC to another

     Windows 8
     Windows 7
     Windows Vista
     Windows XP

FIND THE SOLUTION! Some installation required
Using Easy Transfer copies all your old program settings to your 
new computer, but you still need to install the old programs.

1 Download and install Windows Mail
Windows Mail is a free Microsoft email program. Download 

it from http://download.live.com/wlmail. Click ‘Download’ and 
when the File Download – Security Warning box opens, click ‘Run’. 
Follow the instructions and click ‘Install’. For a faster install, make 
sure only Windows Mail is checked.

2 Run Windows Mail
Recently installed programs are highlighted in your Start 

menu. Click ‘Start’ and type mail into the search box. When you 
run Windows Mail for the first time, you are asked to add an email 
account. If you’re not asked for one, click ‘Add email account’ 
under Quick Views.

7 Send emails from your accounts
You can start writing emails by clicking ‘New’. Click the 

address book icon to add your contacts, or type the recipient’s 
name into the ‘To’ field. You can add pictures and stationery to 
your emails and you can select which webmail account you send 
the email from if you have added more than one.

5 Import your Windows Hotmail address book
You can also import your address book from your webmail, 

so you can quickly send emails to friends and families. If your 
webmail is Hotmail, all you need to do is click ‘Sign in’ to access 
your contacts. When you create a new email, you can select your 
contacts from a list.

3 Add your webmail account
After clicking ‘Add email account’ you’ll be taken through 

a wizard that can help you add and configure your webmail 
account in Windows Mail. Enter in your email address and the 
password you use to log into your webmail account into the 
relevant text boxes.

8 You’re all done!
There you have it. You’ve imported your webmail account 

into Windows Mail. You can send and receive emails as before – 
but with the added benefit of using Windows Mail’s advanced 
tools to sort and store your emails. And don’t worry – your emails 
are still online for you to access anywhere. ■

6 Import a different address book 
To import an address book from a different webmail, view 

your contacts on your webmail’s site and click ‘Tools > Export’. 
Save as a Comma Separated Value (CSV) file, then in Windows Mail 
click ‘Contacts’ and press [Alt]+[M]. Select ‘Import > Comma-
separated values (CSV)’. Select the file you downloaded.

4 View your emails
Once you have added all the information and clicked ‘Next’, 

your emails are downloaded into Windows Mail. Depending on 
how many you have, this might take a while. Once completed you 
can view your emails, place them in folders, designate them as 
junk mail or add the sender to your contacts list.

ebmail accounts can be very 
useful for allowing access to 
your emails away from 

home. With them you’re able to read 
and send emails from anywhere in 
the world – all you need to do is log 
on to the webmail service’s website 
to view your inbox. This is useful 
when you’re travelling, but when you 
are at home you can also import your 
webmail account into Windows Mail, 
enabling you to use all of the great 
features of Windows Mail with your 
webmail account. 

You can get visual indications 
when you receive new emails – 
something you can’t get with normal 
webmail accounts. Even better, if 
you have a number of webmail 
accounts, you can access them all 
straight away without having to log 
on to each website. Just enter your 
password once, and get all your 
emails in one place.

WWorks with…
OS

     Windows 8
     Windows 7
     Windows Vista
     Windows XP

Learn how to…
Access webmail 
through Windows Mail
Import your webmail account into Windows Mail and access all your emails 
straight from your PC – no more messing with multiple mail accounts.

Step-by-step Import your webmail accounts into Windows Mail

Essential 
guide

Learn how to…
Create the  
perfect desktop
Bored of the wallpapers and screensaver that came with your computer? I’ll show 
you how to tweak your Windows theme until it’s just the way you want it.

f you’re still staring at  
that peaceful Windows 7 
goldfish, chances are you 

think it’s time for a change on 
your computer. It’s incredibly easy 
to replace your desktop wallpaper 
with a favourite family photo or 
film poster, and you can even set 
the computer to cycle through a 
selection of your best shots if you 
can’t make  
up your mind which one you 
want. Personalising your 
computer needn’t stop there, 
though. With Windows desktop 
themes, you can tweak  
every aspect of your computer’s 
appearance, from the screensaver 
to the exact amount of 
transparency in your windows 
borders. It’s really simple to 
create the computer 
appearance of your dreams – 
just pick your pictures and follow 
the steps below.

1 Get personal
Right-click on your desktop and select Personalize to open 

the applet. If you’ve previously made changes to your theme, 
you’ll see these at the top under My Themes. To start from scratch 
with today’s changes, select one of the pre-installed Windows 
themes underneath, and start to tweak.

2 Picture perfect
Select the theme you want to personalise, then click on 

Desktop Background. You’ll see a selection of images – probably 
the standard Windows backgrounds. To make your wallpaper 
more personal, click on the drop-down menu by Picture location 
and select ‘Pictures Library’. You now see all your own images.

Create a backup right now

7 Hear the noise
One final change you may want to make is to your theme’s 

sounds – though we recommend turning them off. It can be fun 
to choose a different noise for everything your computer does, 
but it gets annoying. Click on ‘Sounds’, and you can select any 
computer event, then choose a sound file to go with it. Click ‘OK’.

5 The perfect mix
Click on ‘Window color’ to choose the colour 

of window borders, as well as the Start menu and 
Taskbar. Pick from the colours available, or click 
‘Show color mixer’ to create a shade. You can also 
enable the transparent borders that give Windows 
Aero its stylish look (but can slow down your PC). 

3 More or less
If you just want one main image to be your 

wallpaper, select it now and click ‘Save changes’. 
However, you can also select more than one image 
using the [Shift] or [Ctrl] keys, which creates a 
slideshow on your desktop, cycling through your 
favourite shots. 

8 The personal touch
Your theme should now be much more to your tastes, 

showcasing your favourite photos, colours and images. For more 
ideas, click ‘Get more themes online’ in My Themes for a huge 
range of pre-packaged themes, including ones created around 
recent films, that can all be tweaked to your tastes. ■

6 Screen select
To pick a screensaver, 

click the link at the bottom, 
then select a screensaver 
from the list. Some are  
just repeating moving 
images, such as Ribbons, 
but others, such as 3D  
text, can be customised  
by clicking on ‘Settings’. 
Click ‘Windows Live Photo 
Gallery’, then click ‘Settings’ 
to choose which photos to 
cycle through – you can 
choose specific folders, tags 
or ratings, plus speed and 
whether the images are 
shuffled. Specify how long 
you want your PC  
to wait before activating 
the screensaver.

4 Shuffle your shots
If you’ve selected more than one picture, you 

can adjust the drop-down menu at the bottom of 
the screen, to choose how long each image remains 
on your desktop. You can also tick the box next to 
this menu to shuffle your images, showing them in 
a random order. Once done, click ‘Save changes’.

Jargon buster!
 Windows Aero 

The fantastic look of 
Windows Vista and 
Windows 7. The 
transparent windows 
look great and are 
handy for seeing 
what’s behind them.
 

 Windows Live 
Photo Gallery
A free program  
from Microsoft  
that enables you to 
organise, edit and 
share photos. It’s on 
on your free disc.

Works with…
OS I

Essential 
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     Windows 8
     Windows 7
     Windows Vista
     Windows XP

Step-by-step Personalise your desktop

FIND THE SOLUTION! Dream themes
You can save as many different themes as you like – try a family 
photos one, or one based around your favourite artist.

Would you want to lose everything on your 
computer if your drive went kaput? Of course you 
wouldn’t, so it pays to create a backup of your PC 
in case anything bad happens. We show you how.

Save heaps of time when moving files from an old 
computer to a new one – just use Windows Easy 
Transfer. It’s simple, and we’ll show you how to get 
your new machine ready to use in minutes.

Import your webmail into Windows Mail and you 
will be able to access all of your emails straight 
from your computer – no more messing about 
with multiple email accounts. What a time-saver!

Bored of the wallpapers and screensavers that 
came with your computer? We are going to show 
you how you can tweak the Windows theme until 
you’ve got it precisely to your liking.
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Learn how to…
Fix hardware 
problems

“Device Manager is your best ally 
against hardware issues and old, 
problematic drivers.”

ach piece of hardware 
inside your PC needs a 
software component, so 

that Windows knows how to access 
and use it properly. This software 
element is known as a driver, and 
it handles everything from solving 
little problems with the hardware 
that have been spotted after it was 
manufactured, through to providing 
funky capabilities for that device, 
such as letting you assign functions 
to any extra buttons on your mouse, 
enabling visual effects on your 
webcam, or making sure that the 
latest games run properly on your 
graphics card. As you can imagine, 
handling all these drivers can be 
tricky, and there’s a lot of them, but 
Microsoft has created a handy tool 
to look after all the hardware in your 
machine and ensure there are no 
incompatibilities. That tool is called 
the Device Manager, and here’s how 
to get the most from it.

1 Launch Device Manager
There are several ways to access the Device Manager. The 

usual way is to click ‘Start > Control Panel’ and then, depending 
on your view, either select ‘Hardware and Sound > Device 
Manager’ or, if you have Control Panel showing the Classic View, 
select Device Manager directly. You can also launch it in  
Windows 8 - hit the [Windows] key and type Device Manager.

2 Find problem devices
The first thing you should do is get acquainted with Device 

Manager. It works in a similar way to Windows Explorer, with 
devices represented in a tree-like way, so you’ll find your webcam, 
if you have one, under the Imaging Devices tree. Have a look 
around and see if there are any devices that have marks next to 
them, which generally shows there’s a problem or conflict.

Step-by-step Sort out hardware problems

Your guide Dan Grabham says…

ChangeS
The ‘Scan for hardware changes’ 
icon is mostly used when you’ve 
just uninstalled a device and want 
Windows to update its drivers. 
Simply click this and see which 
hardware devices are found. 

ConFliCtS
If a device is causing a problem 
with another piece of hardware in 
your machine, then the conflicting 
device list under the Resource tab 
can be useful.  

E

 Windows 8
 Windows 7
 Windows Vista
 Windows XP

Anyone can do it 
Straightforward
Tricky in parts

at a glance…
SKill leVel

time taKen

Suitable For

30 minutes
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3 Uninstall a device
If you spot a problem, the easiest way to fix it is to uninstall 

the driver that goes with it. Simply expand the tree to show the 
item you want to fix, right-click the item itself and then select 
‘Uninstall’ from the drop-down list. Don’t worry, this won’t do any 
serious harm, because the driver will still be available for that 
device and it’s easy to reinstall it, as we’ll see shortly.

4 Scan for changes
Device Manager now redraws its display and, if that was the 

only device under that branch, it disappears. If you need to get it 
back, simply hit the ‘Scan for hardware changes’ button in the top 
button bar. This checks for new hardware, meaning it will find the 
device that you’ve just uninstalled and automatically try 
reinstalling the driver that you’ve just removed.

Jargon buster!
 Driver

The software 
component for a 
hardware device,  
which enables 
Windows to use that 
device. The driver is 
generally produced 
by the hardware 
manufacturer, but 
Microsoft also 
produces a lot of 
standard drivers.

 environment 
Variable
Windows uses the 
Registry to store 
most settings, but as 
the Registry is so big 
and complicated  
for users, it makes 
sense to have  
some variables 
stored in this more 
accessible form.

 resource tab
Hardware devices in 
your PC need access 
to certain resources 
to run. These are 
listed under the 
Resources tab for 
each device in the 
Device Manager.  
You generally can’t 
change these, but 
any conflicts are 
listed here.

upDate
You can right-click an 
entry to search for driver 
updates, or you can click 
this icon to perform the 
same job. Windows 
keeps most hardware 
up to date itself, but it’s 
worth trying this if you 
have a problem. 

DiSable
If you’ve got a problem with 
a device that you don’t use 
very often, then you might 
decide that you want to 
disable it. It’s not ideal, but 
it can mean your machine 
at least works. 

uninStall
Uninstalling a device can be 
the easiest way of sorting out 
conflicts. Uninstall the device, 
then perform a scan to see if 
Windows can sort out the issue 
itself – most of the time it can. 

Explore 
Fix hardware problems
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9 USB fun
Another tree that’s likely to contain an alarming number of 

entries is Universal Serial Bus controllers. Every USB stick you’ve 
ever plugged into your machine has its own driver stored here. 
Deleting these can reduce the time your PC takes to recognise a 
new USB stick, and also sorts any problems you’ve had with USB 
drives. Use the [Delete] key to uninstall them quickly

7 Show hidden devices
Start Device Manager as before. You probably won’t see any 

difference straight away. In order to see those missing devices, 
you have to select ‘Show hidden devices’ from the View menu. 
This usually just shows system devices that you wouldn’t normally 
touch, but thanks to our previous step, it now shows devices that 
have been installed previously.

5  Update drivers
Because the device is going to use the same driver, there’s  

a chance that this won’t solve the problem. The next stage, 
therefore, is to see if there’s a newer driver available for that 
device. After your scan, simply right-click the device in question 
and select ‘Update driver software’ from the drop-down list. Elect 
to search automatically and confirm that it’s fine to search online.

10 Job done
Well done, you’ve not only learned how to remove and 

update drivers that may be causing problems with your machine, 
but you’ve also seen how you can get rid of devices that you 
don’t use any more. This is great if you’ve had problems with 
some hardware in the past, but also means your machine can 
be quicker at recognising some of the devices that you plug in. ■

8  Remove old devices
Search through the list of devices for items that you know 

you no longer use. This is particularly useful if you’ve upgraded 
your PC, but still have old peripheral entries visible. If you’re 
anything like us, you’ll have several mice listed under ‘Mice and 
other pointing devices’. Pick an item you know you no longer use, 
right-click it and select ‘Uninstall’ from the drop-down list.

6 Old conflicts
Device Manager can also show devices that aren’t currently 

connected. Close Device Manager first, then right-click ‘My 
Computer’, select ‘Properties’, click ‘Advanced System Settings’ and 
select the ‘Environment Variable’ button. Under System Variable, 
click the ‘New’ button. Enter a variable name of DEVMGR_SHOW_
NONPRESENT_DEVICES and set the Variable value to 1. 
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Learn how to…

“If you frequently install free software from the 
internet, try using Chocolatey to simplify the process. 
You’ll be amazed how quick and easy it is!”

etting up new software is an 
involved process. You need 
to download the software’s 

installer, make sure your computer 
has any necessary extra tools and 
then run through its setup. It might 
not sound intimidating, but it is 
time-consuming – especially when 
you’re setting up a new computer. 

Chocolatey helps save time and 
effort by smoothing out the software 
installation process. Whenever you 
install software via Chocolatey, it will 
automatically download the program 
and any necessary extra bits and 
pieces, and silently carry on the 
installation without prompting you 
for any input. Furthermore, you can 
also update the installed software 
with a few simple keystrokes. 

Although very simple to use, 
Chocolatey is a command line tool 
and you will need to run it inside a 
command prompt window. Don’t be 
alarmed, though – it’s not hard!

1 Install Chocolatey
Click ‘Start > All Programs > Accessories > Command 

Prompt’, and enter the following: @powershell -NoProfile 
-ExecutionPolicy unrestricted -Command “iex ((new-object net.
webclient).DownloadString(‘https://chocolatey.org/install.
ps1’))” && SET PATH=%PATH%;%systemdrive%\chocolatey\bin. 
To avoid errors, it’s best to copy this from www.chocolatey.org.

2 What did I just do?
Let’s break down the command. The -NoProfile switch starts 

a PowerShell session without loading any custom profiles. The 
-ExecutionPolicy makes sure you can download the software, 
which is specified with the -Command switch. When the software 
is installed, you can run it from under any directory on the system 
since it has been added to the system path with SET PATH.

Your guide Mayank Sharma says…

S

Step-by-step Install software with Chocolatey

Install software 
effortlessly

Anyone can do it 
Straightforward
Tricky in parts

 Windows 8
 Windows 7
 Windows Vista
 Windows XP

At a glance…
SKILL LEVEL

TImE TAKEn

SuITAbLE for

10 minutes

Mayank’S beSt tip
Expert users can write scripts 
with Chocolatey commands 
to flesh out new Windows pCs 
with software and updates.
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7 Install web development tools
If you are a web developer, you should install the Microsoft 

Web Platform Installer Command Line. This will make it easy to 
install web development tools with the command choco install 
webpicmd. Enter clist -source webpi to browse the list of 
available programs. You can install any of these with the -source 
switch (choco install IISExpress -source webpi, for example).

5 Browse packages
The Chocolatey repository contains over a 

thousand pieces of popular software. You can 
browse the catalogue at www.chocolatey.org/
packages. You can use the search command to look 
for software via the command prompt, and use the 
choco list command to list all installable software.

3 Install packages
Chocolatey is now all set and you can use it to 

download popular software. To install the Firefox 
browser, type the following command inside a 
command prompt window: choco install Firefox. 
You can also specify multiple packages such as 
choco install Thunderbird Skype.

8 Graphical interface
You can also use Chocolatey via a graphical interface. 

Use the choco install ChocolateyGUI command to install the 
graphical interface. This interface replicates the most commonly 
used Chocolatey features, and lists all the installed software along 
with buttons to update and uninstall them. You can also search 
and install software from Chocolatey’s repository. ■

6 Advanced usage
You can also use 

Chocolatey to install 
Windows components 
via the Deployment 
Image Servicing and 
Management tool. The 
command clist -source 
windowsfeatures will 
list all the available 
components, such as the 
Telnet client. You can then 
install the components 
with the command -source 
switch. For example, choco 
install Telnet -source 
windowsfeatures.

4 Manage packages
The command chocolatey update Firefox 

will upgrade the browser if there is a new version in 
the Chocolatey repository. You can update multiple 
pieces of software at the same time by adding their 
names to the command. Use the cuninst command 
to remove an installed app, such as cuninst Skype.

Jargon buster!
 PowerShell

This is an integral 
part of the Windows 
operating system 
and can be used to 
manage server 
environments.

 Deployment 
Image Servicing and 
management
DISM is a command-
line tool that is useful 
for installing and 
configuring Windows 
features, packages, 
and drivers.

Explore 
Install software effortlessly
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Learn how to…
Fix problems 
with your PC

“Is Windows acting up? Let the 
Windows Repair tool check and 
repair your PC for free.”

roubleshooting PC problems 
can be a real pain, 
particularly if you can’t easily 

pinpoint a cause – and therefore 
solution – to your woes. Windows 
does its best, but if you’re currently 
struggling to fix a problem that 
seems deeply embedded, then 
Tweaking.com’s All-in-One Windows 
Repair tool could be a lifesaver. It 
performs a series of basic checks, 
takes key backups and then presents 
you with a list of repair tools that can 
fix all manner of issues.

Many of the tools can be run even 
if they don’t appear to be linked to 
your problem; sometimes your 
symptoms may point to a series of 
underlying glitches that aren’t 
obviously linked. In this tutorial we’ll 
take you through the program 
step-by-step, hopefully guiding you 
towards that elusive solution to your 
problem, and saving you the effort of 
a full Windows reinstall.

1 Download and launch
Visit www.tweaking.com and click ‘Programs’ then‘Windows 

Repair (All In One)’. Some problems may prevent you from 
installing new programs, so click the ‘Direct download’ link under 
Portable and save the zip file to your Downloads folder. Double-
click this zip file and copy the folder on to your desktop. Open it 
and double-click the ‘Repair_Windows’ shortcut to begin.

2 Power reset
Click ‘Yes’ when prompted. Windows Repair will check it has 

the files it needs – if any are missing, you’ll need to re-download 
the zip file and start again. You’ll then be prompted to do a 
‘power reset’ – as instructed, power down your PC, remove all 
power cords and batteries, then hit the power button a few times 
to clear all power. Then reboot and restart Windows Repair.

Step-by-step Fix your PC

Your guide Nick Peers says…

AvAilAble rePAirS
Thirty repair 
categories are 
currently available. 
To select one, click in 
the box to place a 
tick next to it. 

Sub-rePAirS
Some categories let 
you choose what 
exactly gets repaired 
– click the ‘+’ button 
to review and select 
your options. 

reSet
Click the ‘Defaults’ 
button to select only 
those repairs that 
can be applied 
safely even if you 
don’t need them. 

T
Anyone can do it 
Straightforward
Tricky in parts

 Windows 8
 Windows 7
 Windows Vista
 Windows XP

At a glance…
SKill level

time tAKen

SuitAble For

30 minutes
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3 Scan for infections
Switch to the ‘Step 2’ tab. Run a full scan with your security 

software, then – if it’s installed – run a full scan with Malwarebytes 
Anti-Malware. If it’s not, click ‘Download & scan system’. Windows 
Repair will download, install and update a copy of the program, 
then run a scan automatically. If threats are found, follow the 
instructions to remove them, rebooting if prompted.

4 Check drive for errors
Once Malwarebytes has run and corrected any problems, 

close it and click ‘Next’. The following step is worth following even 
if you think your hard drive is fine. First, click the ‘Check’ button to 
scan for errors. If any are found, click ‘Do it’ and let your PC reboot. 
The drive will be scanned again and fixes applied. Once done, 
restart Windows Repair, jump to step 3 and repeat the check. 

Jargon buster!
 Command prompt

A window where 
system and repair 
tools can be run 
using text 
commands rather 
than a graphical user 
interface.

 Power reset
A process whereby 
the user shuts down 
their PC, disconnects 
all power and then 
attempts to drain 
any remaining 
electricity from the 
PC before restarting.

 System File 
Checker (SFC)
A command prompt 
tool that checks key 
system files for 
corruption, replacing 
damaged files with 
working backups.

rePAir inFo
Each of the repair 
categories comes 
with its own full 
description – click 
one to find out 
exactly what it does. 

reStArt when done
It’s a good idea to shut 
down or restart your 
PC after the repairs 
have been applied.  
You can do this 
automatically here. 

betA rePAirS
Hit this to try repairs 
currently being 
tested, but be careful. 
A System Restore 
repair tool is available 
at time of writing. 

Nick’s best tiP!
switch to the ‘backup’ tab and 
click ‘Restore’ under ‘Registry 
backup’ to undo any Registry 
repairs if they go awry.

Explore 
Fix PC problems
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9 Disable antivirus
Your security program may interfere with any repairs you 

attempt to perform. Before disabling it as recommended, 
physically disconnect your PC from the internet; the simplest way 
is to switch off your modem or router, or unplug your PC’s 
Ethernet cable. Once done, open your security software’s 
configuration tool and choose to disable its auto-protect feature.

7 Review fixes
Read the disclaimer about the fixes offered, then click ‘Start’. 

A window will open that lists all available repairs on offer – 30 are 
in place at the time of writing, and more are being developed all 
the time. Some repairs are ticked by default – these can be safely 
applied even if they don’t directly refer to your problem. To find 
out more about an individual repair, click its name in the list.

5  Run System File Check
When your drive has been given a clean bill of health, click 

‘Next’. Read the instructions – XP users will need their installation 
CD at this point – then click ‘Do it’. A command prompt window 
will open and the System File Check tool will perform its scan. If 
errors are found, press any key to exit, then restart your PC before 
running the check again to verify that all is now well.

10 Apply fixes
Once you’ve selected which fixes to apply, tick ‘Restart/shut 

down system when finished’. Hit ‘Restart system’ and finally click 
‘Start’. Depending on the repairs you’ve selected, the process may 
take a while. Once complete, your PC will reboot and hopefully 
the issues you’ve been having will be fixed. Don’t forget to switch 
on your security software before reconnecting to the internet! ■

8  Select fixes
Some fixes can take a while to process, so if you have an 

older PC and can see which fix or fixes should resolve your 
problem, click ‘Unselect all’ and then simply select each fix by 
clicking the box next to it. If you’re unsure what could be causing 
your problem, start by clicking ‘Defaults’ to select those repairs 
you can safely try without worrying about any side effects.

6 Take fail-safe backups
Click ‘Next’ to move on to the ‘Step 5: Backup’ tab. Start by 

backing up the Registry files – click ‘Backup’ under Registry 
Backup followed by ‘Run’ twice if prompted. Wait a minute or two 
– if nothing happens, click ‘Use fallback method’. Once complete, 
click ‘Create’ under System Restore to add another level of backup. 
The cloud backup option isn’t required, so click ‘Next’ when done.
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In  the next  issue  Automate your  online life

Learn how to…
Speed up your  
PC in five minutes

“ReadyBoost is a free way to speed up your system 
using a USB stick, and it’s great for extending the life 
of your PC. Here’s how to make the most of it!”

here’s little more frustrating 
than realising your once 
speedy computer, which 

served you well just a few months 
ago, is starting to feel slow and 
unresponsive. Don’t worry though – 
you don’t need to fork out for an 
upgrade yet. You can turn to page 
72 for our top 10 tips and tricks for 
recovering lost performance, but 
Windows also offers a quick and 
easy solution. ReadyBoost is an 
extremely useful built-in tool that 
uses removable flash memory, such 
as USB sticks and SD cards, as extra 
RAM to speed up your system.

In Windows 7 or 8, the amount of 
memory that can be used for 
ReadyBoost has been given a huge 
increase, and you can now use more 
than one form of removable memory, 
giving you extra scope to speed up 
your machine. It’s particularly useful 
for systems running with less than 
2GB of RAM, such as netbooks.

1 Insert your USB stick
First, make sure that you have your choice of removable 

flash memory to hand. To start the ReadyBoost process, you 
need to insert your USB stick into your computer and wait for 
the AutoPlay menu to appear. If you’re opting to use an SD card 
instead, just place it into the slot on your laptop or desktop PC, 
or use an external card reader. 

2 Choose ReadyBoost
Once the AutoPlay window pops up, you can start using 

ReadyBoost. The relevant option appears at the bottom of the list, 
where you’d normally choose to either browse the device or load 
images from an SD card straight into Windows Live Photo Gallery. 
When you click on the ‘Readyboost’ option, you’ll be taken 
straight to a configuration screen.

Your guide Dan Grabham says…

T

Dan’s best tip
For a permanent performance 
boost, consider upgrading 
your pC’s RAM. Learn how 
at http://bit.ly/1pz8koA.

Step-by-step Give your PC an instant speed boost

Anyone can do it 
Straightforward
Tricky in parts

 Windows 8
 Windows 7
 Windows Vista
 Windows XP

At a glance…
SKILL LEVEL

TImE TAKEn

SuITAbLE for

30 minutes
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7 Double up
In Windows Vista, ReadyBoost only supported one device 

with a capacity up to 4GB, but with Windows 7 or 8 you can use 
multiple fast devices, with nearly unlimited memory. If your 
laptop or desktop computer has an SD card that’s unused for 
the majority of the time, why not consider making this a semi-
permanent ReadyBoost slot?

8 Enjoy!
You should now have a noticeably more responsive 

computer, and be able to perform daily tasks faster than before. 
Although Readyboost won’t help you transform a basic machine 
into a gaming behemoth, you should feel a real change in your 
system’s performance, and it might even stave off the need for a 
new computer for a little while to come. ■

5 Partition a USB device
If you still want to be able to use your USB stick’s memory 

for storing your documents, photographs and other files, but 
you also need to speed up your computer, a different option is 
required. This will have a less dramatic effect than making it a 
dedicated device, but can still be helpful. Insert your USB stick or 
SD card and click the ‘Speed up your system’ option as before.

3 Create a dedicated device
If you’re planning on using this USB flash drive just for 

ReadyBoost and don’t intend to store any data on it as well, you 
should turn it into a dedicated device. To do this, simply check 
the second option in the list, ‘Dedicate this device to ReadyBoost’. 
This option makes all of the USB drive’s storage space available to 
be used by Windows.

6 Slide to increase
You can use the slider to allocate a portion of the disk’s 

space to ReadyBoost, while still leaving a certain amount of room 
for your files. Move the slider left or right until you’re happy with 
the amount of space. We wouldn’t recommend dedicating less 
than 256MB to ReadyBoost, otherwise you won’t see much 
difference in the speed of your system.

4 Prepare it for use
Now that your USB stick is a dedicated device, it’s ready 

to give your computer the performance boost it so badly needs. 
Click ‘OK’ and your device is prepared for use by the system. From 
now on, whenever you insert that drive into your PC, Windows 
recognises it and adds its capacity to the system, so your 
computer has more memory to use.

Explore 
Speed up your PC
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Learn how to…
Sort out your 
cash with Calc

“Balance your budget using Calc 
spreadsheets to help you see 
where your money is going.”

aving money can be a 
struggle – especially these 
days – but with a bit of 

careful planning using the Calc 
spreadsheet application in 
LibreOffice, you can keep an eye on 
all of your regular incomings and 
outgoings, making it far easier to 
identify any areas that you may need 
to cut back on. The stable version of 
LibreOffice is free to download at 
www.libreoffice.org.

Once you’ve set up a spreadsheet 
with the right sums and formulas, 
Calc can perform calculations on the 
data you enter. You can also create 
graphs to give you a better 
understanding of all your finances. 

After setting up and using your 
budget in Calc, it should only take a 
few weeks before you begin to see 
positive effects, making it easier than 
ever for you to save up for a rainy day, 
or perhaps a well-deserved holiday in 
sunnier climes!

1 Column names
The first thing to do is create column and row names. Along 

the top, starting with cell B1, we’ll enter the days of the week. 
Type Monday in B1, then click the cell and a small black square 
will appear in the lower right-hand corner. Click on this and drag 
it to cell H1. Calc will assume that you’re entering days of the 
week, and will populate the cells for you.

2 Row names
In column A (starting in cell A2) we’ll give each row a name 

for regular outgoings. These might include things such as food 
shopping, petrol, gas bills, council tax and nights out. It might 
help to look through a bank statement to see where your money 
goes, and it’s a good idea to include a miscellaneous expenses 
option to cover any other expenditures.

Step-by-step Master your finances

Your guide Matt Hanson says…

NEgativE NumbErS
Calc automatically 
formats negative 
values in a cell by 
colouring the fonts red. 
This is helpful when 
creating a budget.

S
Anyone can do it 
Straightforward
Tricky in parts

 Windows 8
 Windows 7
 Windows Vista
 Windows XP

at a glance…
SKiLL LEvEL

timE taKEN

SuitabLE for

40 minutes
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3 Income
Now that we’ve listed our expenditure, it’s time to enter 

our regular income as well. We can add this underneath our 
expenditure rows. Some possible row headers that you might like 
to use include wages, benefits and eBay sales. You could also add 
a miscellaneous income category for any unexpected bonuses 
that come your way.

4 Colour code headings
To make the spreadsheet easier to understand, it’s worth 

giving the row and column headers colours. Select all the column 
headers, then click the ‘Background colour’ icon (shown above). 
Choose a pale colour that doesn’t make the text difficult to read. 
Do the same for the outgoing row titles, and then choose a 
different colour for the incoming rows.

WorKShEEt tabS
You can create 
multiple spreadsheets 
within one document 
and flick between 
them quickly using 
these tabs.  

CurrENCy format
Click this icon to turn 
the content of a cell 
(if it’s a number) into 
your local currency.

baCKgrouNd 
CoLour
Click on this icon to 
change the colour of 
a particular cell. 

aNNotatioN
When creating a budget 
spreadsheet it is a good 
idea to create cells that 
add up the totals so you 
can easily see where 
you need to cut back. 

Explore 
Sort out your finances with Calc
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9 Weekly total
We also want weekly totals of incomings and outgoings, 

plus a weekly balance. Here, we’ve made a mini table with the 
appropriate cells. For each of these we’ve used a formula similar 
to the one we used in step six, but instead of adding the cells 
vertically in a column, we’ve added cells horizontally in rows – for 
example =SUM(B19:H19).

7 Calculations continued
Press [Enter] on your computer keyboard when you’ve 

finished. Now you need to do the same steps for the total income 
cell, but this time select only the income cells in Monday’s 
column. Now click on the cell, and then click on the small black 
square that appears and drag it across so that the formula is 
copied to each day of the week. 

5  Add borders
Adding borders to certain cells can also make your 

spreadsheets a little easier to read. To add a border, simply select 
the cell (or the range of cells) that you want to make stand out, 
then click the ‘Borders’ icon (just to the right of the ‘Background 
colour’ icon). Now you can choose which sides of the cells should 
have a border.

10 Create new worksheets
This spreadsheet is for one week, so it makes sense to create 

three more for the rest of the month. Rather than having them all 
on the same worksheet, we’ll create three new worksheets. To do 
this, click the green ‘+’ icon at the bottom of the spreadsheet. 
Create three new sheets and double-click on each one to name 
them Week 1, Week 2 and so on.

8  Incomings and outgoings
For balance, we want to subtract the data in the total 

expenditure cell from the total income cell. Monday’s total 
expenditure cell is B19, so we would type the following formula 
into the balance cell: =SUM(B20-B19). Type in some numbers to 
make sure the calculations work, then drag the black square to 
copy the formula into the other balance cells.

6 Create total rows and calculations
Now add three new rows: total expenditure, total income 

and balance. Give these colours and borders as well. For total 
expenditure we want Calc to add up all the costs in a day’s 
column and display them. Click Monday’s total expenditure cell, 
click the ‘Sum’ icon and drag your mouse to select all the 
expenditure rows in Monday’s column.
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15 Use charts to illustrate the report
Charts can make your finances even easier to understand. 

To create a quick and easy chart using Calc, select all three of the 
total cells in the Month worksheet, then click the ‘Chart’ icon (a 
red pie chart). Leave the default settings and Calc will create a 
simple bar chart. Click ‘Data range’ and select ‘Data series in rows’, 
then click ‘Finish’.

13 Create a monthly report part one
Make a new worksheet and name it ‘Month’. Create ‘Total 

expenditure’, ‘Total income’ and ‘Balance’ cells. Now we need to 
add all of the data from the corresponding cells in each 
worksheet. Select the cell next to total expenditure and type =. 
Next, click the ‘Week 1’ tab and select the cell next to total 
expenditure, then type +.

11  Display data as currency
At the moment, when you type a digit into a cell in the 

spreadsheet, it will appear as a single number. If you want to 
make Calc automatically format those numbers into currency, 
click and drag your mouse to select all the cells you want to type 
numbers into, and then click the ‘Number format: currency’ icon 
(depicted as a pile of coins).

16 Fill in the data
You can experiment with a number of different charts. For 

example, you could create a pie chart that shows how much you 
spend on items, so you can see how much money goes on fuel 
compared to clothes. Fill in your data and make sure the balance 
at the end of the month is positive rather than negative, and you’ll 
soon find that your finances are much healthier. ■

14  Create a monthly report part two
Do this for the next three weeks and you’ll get a formula 

similar to: =‘Week 1’.K19+‘Week 2’.K19+‘Week 3’.K19+‘Week 4’.K19. 
Now you need to do similar for the total income cell, selecting the 
total income cells of each workbook. For the monthly balance, 
subtract the total expenditure cell in the Month worksheet from 
the total income cell.

12 Copy the spreadsheet to the other worksheets
Now we need to copy the spreadsheet for Week 1 and paste 

it into the other worksheets. To do this, click the ‘Week 1’ tab and 
press [Ctrl]+[A] on your keyboard to select everything. If you 
entered test values, clear these first. Next, click the ‘Week 2’ tab 
and press [Ctrl]+[V] to paste the spreadsheet. Repeat this process 
for the other two worksheets as well.

Explore 
Sort out your finances with Calc
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ultimAte
mediA centre

We’ve seen the television go from 
being the non-interactive giant 
box in the corner of the room to 
an all-singing, all-dancing 

flatscreen capable of just about everything. 
The latest generation of games consoles allow 
you to play the newest 3D games, a Sky Plus 
box lets you pause and record live television, 
and even a humble Freeview television gives 
you quick access to hundreds of TV channels 
and radio stations.

But the biggest change of all has been as a 
result of the media centre PC. This is a 
computer that’s dedicated to powering your 
television, and it can do all of the above 
things and much, much more. Everything, in 
fact, that your computer can do. You can 
watch shows on iPlayer, chat to friends via 
Skype, browse the internet and see all your 
digital photos and videos on your television.

This guide takes you through everything 
you need to make your television every bit as 
good as your laptop or desktop PC, as well as 
all the software and hardware you need to 
get it going. We’ll begin by showing you all 
the core ingredients of a decent media centre 

PC and then take you through the alternatives 
and show you how to make the most of it.

And don’t think that a media centre PC is 
just for watching shows and films on your 
television. If you’ve got a music service like 
Spotify, then you can connect it to your Hi-Fi 
to listen to music. Connect it to your mobile 
and you’ll be able to control it remotely, and 
even stream media to and from it.

Don’t be put off by the cost – setting up a 
media centre doesn’t need to be prohibitively 
expensive. In fact, you may already have some 
of the bits and pieces you need to build a 
media centre PC, or you might even have a 
device that’s capable of recording television 
or showing films without realising it.

Setting up a media centre PC is great fun, 
too, and the results are rather more 
impressive than just plugging in a monitor or 
opening a laptop. They’re computers that are 
designed to be used by everyone in the 
home, and it turns computing from a lone 
pursuit in a home office to a shared activity in 
the living room. It will completely change the 
way you think about both computers and 
your television.

Computers are taking over our living rooms.
Henry Winchester shows you how to turn your 
television into a cornucopia of digital delights
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1 Download and install XBMC
Visit www.xbmc.org and click ‘Downloads’ at the top of the 

page. Click ‘Get XBMC’ and then choose ‘Windows’. When 
prompted to run or save the program, select ‘Run’. The XBMC 
set-up wizard will begin. Click ‘Next’, agree to the terms, and then 
de-select anything you might not need on the next screen. Click 
‘Next’ twice more, then click ‘Install’.

2 Getting started and navigation
Once the installation process is complete, click ‘Finish’ and 

XBMC should start automatically. You may be prompted to 
unblock Windows Firewall – click ‘Allow access’ if needs be. You’ll 
now be presented with XBMC’s homepage. You can navigate the 
bar using the scroll wheel on your mouse, the cursor keys on your 
keyboard, or the arrow keys on a Windows media remote control.

This 12-year-old media centre program 
is still one of the best we’ve come 
across. We show you how to use it

Don’t be put off by Xbox 
Media Centre’s (XBMC) 
nomenclature – you won’t 
need a games console to 

make use of it. It began its life as an 
add-on for Microsoft’s games 
console, before being ported to 
Windows – among other platforms. 
It’s free to download and use and 
has features that aren’t available in 
Windows Media Center.

Like Windows Media Center, 
XBMC features a 10-foot user 
interface, which is designed to be 
readable on a television screen from 
10 feet away, so you won’t be 
squinting at the screen to see 
what’s going on. It achieves this 
through large fonts and high-
contrast colour schemes, but it also 
has an array of Skins, so you can 
customise the layout and fonts.

XBMC is over a decade old now 
and in that time many add-ins and 

handy extras have been developed 
for it. You can view YouTube and 
BBC iPlayer videos without having 
to use Internet Explorer, listen to 
music through services such as 
GrooveShark and Pandora, and 
watch the latest trailers with a 
dedicated add-in.

Any films or music on your 
computer are automatically 
updated thanks to scrapers, which 
scour the internet for information 
and artwork. This makes organising 
your media nice and easy, with a 
visual guide popping up whenever 
you play music or watch a film.

There are hundreds more features 
in XBMC, including the ability to 
record live TV and downloadable 
remote control apps for Windows 
Phone 7 devices. It’s incredibly 
powerful and customisable, as well 
as being easy to use. Here we’ll 
show you how to get started with it.

Metadata XBMC automatically 
scours the internet for artwork and 
information about all your media – be 
it a CD, DVD or music or videos stored 
on your PC. This is called metadata. It 
makes it easy to organise your media, 
and ensures the XBMC experience is 
sleek and seamless.

Power XBMC doesn’t include 
Windows’ normal minimise and exit 
icons, but you can access everything 
you need here. As well as closing 
XBMC, you can also set it to power 
off your entire system, or shut it 
down after a set period.

Sort out your 
digitAl life  
witH XBmc

Step-by-step | Install XBMC
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3 Adding pictures, videos and music
Click on each section to add relevant media. To add pictures 

click on ‘Pictures’, then choose ‘Add Source’. From here click 
‘Browse’ and then find the relevant folder containing your pictures 
– ‘My photos’, for example. Click ‘OK’ when you’re ready. Now you’ll 
be able to browse through your pictures, using the cursor keys or 
mouse to move forwards and backwards.

4 Adding add-ons
Add-ons are the lifeblood of XBMC, allowing access to more 

features and functionality. Hover over Videos, then choose 
‘Add-ons’. Click ‘Get More’ and you’ll see an array of different 
services. Once you’ve found one of interest, click ‘Install’. Once it’s 
installed, go back to the homepage, click ‘Add-ons’ again and click 
on the new add-on to view the content.

Jargon buster!
 Metadata

Small files that 
contain information 
on media, such as 
release dates, track 
lengths, record labels 
or directors. XBMC 
finds these files  
and integrates them 
with your media 
automatically.

 add-ons
These extra 
programs run within 
XBMC’s ecosystem, 
much like programs 
installed within 
Windows. They’re all 
thoroughly tested 
within XBMC so you 
won’t download 
anything dodgy.

Main bar Here you’ll find quick and 
easy access to your pictures, videos, 
music, and add-on programs. If you want 
to play a DVD or listen to a music CD, you 
can select ‘Play disc’. To the far right, 
‘System’ lets you change the theme of 
XBMC, as well as holding those nitty-
gritty settings.

ControlS These can be used 
to pause, fast-forward and 
rewind your current media, as 
well as skip backwards and 
forwards through the current 
playlist. The Stop square stops 
everything and takes you back 
to XBMC’s main page. 

weather XBMC automatically detects your 
location and loads weather information. 
Clicking ‘Weather’ in the main bar gives you 
a four-day forecast for your local area, and 
the current temperature and outlook are 
shown here, as well as the date and time.
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eSSentiAl 
progrAmS
Supercharge your media centre PC with 
these fantastic Windows programs

Amedia centre PC wouldn’t 
be complete without a 
few media-centric 
programs. The good 

thing about building or buying 
such a computer with Windows 
installed is that all your favourite 
programs can be installed on it, 
too, including programs that 
update or replace Windows’ own. 
Which isn’t to say that Windows 
software is bad. In fact, you’ll find a 
suite of perfectly adequate 
programs for watching and even 
creating media.

Your first stop on setting up your 
media centre PC should be 
Windows Media Center. This is a 

go-to program for your media 
needs, nicely presenting all the 
pictures, movies and music stored 
on your computer with an easy-to-
navigate interface. It’s designed 
from the ground up to be used on 
a big television, and if you’ve got a 
TV tuner card it will also record and 
play live TV.

Windows Media Player is a 
separate entity to Windows Media 
Center and it’s more designed for 
use on a desktop PC than a media 
centre one. It does have its uses 
though, particularly if you want to 
listen to music while you’re 
browsing the internet. Both 
Windows Media Center and 

Windows Media Player are 
compatible with Windows Media 
Center remotes, as well as play and 
pause media keys that may be built 
into your keyboard.

Not to be overlooked are the free 
programs provided by Windows 
Essentials at http://bit.ly/KgwMow. 
These include Photo Gallery, which 
does a superb job of rendering 
your photos on a big screen, and 
Movie Maker, which can turn the 
humblest home movie into a 
high-definition cinematic 
masterpiece. If those aren’t 
enough, read on to discover more 
about our favourite media 
programs for Windows.

SPOTIFY
www.spotify.com
Spotify’s subscription model has revolutionised the way we 
buy and listen to music. The most basic version of Spotify – 
Spotify Free – lets you listen to Spotify’s comprehensive 
music catalogue for free, but you will get occasional adverts. 
Spotify Unlimited costs £4.99 a month and removes the 
adverts, as well as introduces Radio mode to play music 
similar to your favourite artists.

Pay £9.99 a month and you get Spotify Unlimited. This 
version works on smartphones, too, and enhances the sound 
quality, which is essential if you’ve connected your media 
centre PC to some nice speakers or a decent Hi-Fi. Unlimited 
also connects to media devices, such as Logitech’s Wi-Fi 
Squeezebox radio or a Boxee media centre.

Spotify has also turned listening to music into a social 
experience, connecting with Facebook so you can see what 
your friends are listening to, or share tracks with them. But at 
its core Spotify is about the music and it’s a must-have for 
aficionados of any genre.

iTUNES
www.apple.com/itunes/
The service that made the iPod and iPhone sought-after 
gadgets is still going strong and remains one of the best 
pieces of music and video software on the PC. If you’ve got an 
iPhone or iPod, chances are you’ve already got iTunes 
installed. If not, you can download it for free from Apple’s site.

Boot up iTunes and it’ll automatically search and find music 
on your PC, neatly sorting it by artist and album. But where 
iTunes really comes into its own is in its in-depth store, which 
hosts loads of music to buy and download. Once you’ve got it 
in your iTunes account it’s yours forever, too, and you can 
easily copy it onto your iPhone or iPod.

A recent addition to iTunes is films, which are available to 
buy or rent for £5.99 or £3.49 respectively. Buying means you 
own the film forever on your iTunes account, whereas renting 
gives you access to the film for 30 days, and 48 hours to 
watch it after you’ve hit the play button. You can buy TV 
shows, too. Films and TV shows work across most popular 
Apple devices such as the iPhone, iPad and recent iPods.
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1 Download the plugin
Before you start you’ll need a 

Amazon Prime account – sign up at www.
amazon.co.uk. Next, visit www.milliesoft.
co.uk and click ‘Download’ under ‘MCE 
LoveFilm’. Click ‘Run’ when prompted to 
run or save it.

2 Loved up
Run through the installation process, 

then fire up Windows Media Center. Under 
Milliesoft you’ll find MCE LoveFilm. Open 
the app and then you will need to set the 
country that your Amazon account 
originates from.

3 Linked account
Click on a genre to see a list of films 

that you might like, scroll left or right to 
navigate through the results and then 
click on a film or TV show to start playing 
it. You will need to log into your Amazon 
account once, the first time.

Amazon Instant Video
www.amazon.co.uk
Amazon.co.uk is perhaps best known 
in the UK for its onling shopping 
service, which includes DVD and 
Blu-ray purchases. Recently, it bought 
branched out into online movie 
streaming by purchasing LoveFilm, so 
you can stream films and TV series 
straight to your PC. This is ideal for 
slimline media centre PC setups 
without DVD drives.

With Amazon Instant Video you can 
watch films and TV series online, or if 
you have an Amazon Prime account 
you can instantly stream content from 
the Amazon Prime catalogue. If you 
have an Amazon account you can pay 
as you go for movies or TV, or if you 
want to go the Prime route, it costs 
£5.99 a month, or £79 for a year’s 
subscription, though you can get a 30 
day free trial, if you like.

Before Amazon Instant Video came 
along, LoveFilm was used to watch 
content using Windows Media Center, 
allowing you to get your 
entertainment fix using just your PC. 
LoveFilm no longer exists, but the 
LoveFilm app for Windows Media 
Center now supports Amazon Instant 
Video (US, UK and Germany)- you can 
install the app (still called LoveFilm) 
using the step-by-step guide below.

iPLAYER
www.bbc.co.uk/iplayer
As well as producing thousands of hours 
of high-quality entertainment, the BBC’s 
licence-funded model means that UK 
residents can access recent television 
and radio shows online. This almost 
makes being able to record TV on your 
PC irrelevant – pretty much everything 
from the last seven days is available to 
watch via the internet.

While you can watch everything via 
the iPlayer website, we’d recommend 
downloading the desktop program 
from www.bbc.co.uk/iplayer/install. The 
site only allows you to access 
programmes from the past seven days, 
whereas the desktop version hosts up to 
30 days of content. It also lets you save 
programmes onto your computer 
(essential if you’re on a slow internet 
connection) and can be set to 

YOUTUBE
www.youtube.com
YouTube may have become ubiquitous 
with awful teen songs and kittens doing 
cute things, but there’s a lot of decent 
content on YouTube, too. Thanks to its 
support for high-definition and  
full-screen, videos look amazing on big 

automatically record all the episodes in 
a series. If you’re a licence fee payer 
you’ll be able to watch live TV via iPlayer, 
too, and the site occasionally hosts films 
recently screened on BBC channels. It’s 
an amazing service and essential to get 
the most out of your media centre PC.

televisions. Just click on the cog to the 
lower right and choose 1080p or 720p, if 
the options are available.

YouTube also offers movie rentals 
(www.youtube.com/movies) at a 
reasonable £3.49 per movie, with some 
older films available completely free. 
Once paid for, these can be watched in 
your browser, or on most Android 
devices. There are frequent genre sales, 
too, so you can watch the latest action 
movies or chick flicks for just 50p.

As well as films, YouTube also offers 
dedicated channels for TV shows (most 
of which are free), including live sports 
and entertainment channels, educational 
programs and music videos. It’s a good 
idea to start liking videos, too. This way  
YouTube will figure out what you like, and 
recommend new videos based on your 
preferences, even if they are just awful 
teen songs and kittens doing cute things.

Step-by-step | Install LoveFilm on Windows Media Center
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Build A  
mediA centre

off-tHe-SHelf 
optionS

Create and customise your own living 
room computer – we take a closer look 
at the equipment required

The first thing to bear in 
mind when creating a 
media centre PC is how you 
want it to fit in with your 

living room. A great big neon-lit 
towering desktop-style case is 
probably going to be a big no-no, 
but if you’ve already got a separate 
Hi-Fi, cases are available that will 
inconspicuously fit in with its looks 
and size. The third option is a 
mini-ITX case, which is absolutely 
tiny but requires a special tiny 
motherboard to fit.

Once you’ve decided on a case, 
you can choose your motherboard 
and processor. The latest Intel Core 
series of processors don’t draw 
much power and have the added 
advantage of being able to handle 
high-definition 3D video and 
fantastic quality sound without the 
need for additional cards to plug 
into your computer.

A big hard drive is also necessary, 
particularly if you want to watch 

high-definition content. Two 
terabyte drives can be picked up 
relatively cheaply, and they’ll give 
you plenty of space for videos, as 
well as music and photos. We’d also 
recommend a Blu-ray drive, but if 
you’re building a really small PC 
you’ll need to get a slimline one. 
These aren’t too costly, but you’ll 
need extra software to make them 
play Blu-ray discs in Windows. Often 
the drives come with free software 
to do just that – if not, Cyberlink’s 
PowerDVD does the job.

To watch and record TV shows 
you’ll need a TV tuner, too. These 
connect to your aerial and decode 
the digital signal so you can view it 
through your PC. Internal cards are 
neat and plug straight into the 
motherboard, whereas USB tuners 
connect via external ports on the 
computer’s case. Look out for dual 
and quad tuners, which let you 
receive extra broadcasts such as 
FreeSat and hi-def digital TV.

Control Logitech’s 
K400 wireless keyboard 
cleverly incorporates a 
laptop-style trackpad. 
The remote is compatible 
with Windows Media 
Center, letting you 
control most essential 
functions from your sofa.

blu-ray This high-definition video 
format has usurped DVDs and makes 
films look just as good as they do in the 
cinema, but you’ll need a Blu-ray drive to 
play them. Drives like this one cost about 
£50, but they’ll burn DVDs too.

If you don’t feel like getting your hands dirty and your head 
around building a media centre PC, there are plenty of pre-built 
options. In fact, most major computer manufacturers offer media 
centre PCs alongside standard desktops and laptops.

As with building a media centre PC, there are a number of 
things to look out for. Smaller media centre PCs omit Blu-ray or 
DVD drives in order to provide a smaller package. This isn’t a 
problem if you’re only going to be streaming content over the 
internet, but it does render your DVD collection somewhat 
redundant. If you want to connect it to your Hi-Fi or speaker 
system, make sure it has a digital audio output for decent sound. 
Most importantly, though, make sure it’s got an HDMI output so 
you can connect it to your TV and enjoy the hi-def goodness.

Tranquil PC MediaOne 2014
Manufactured from aerospace grade aluminium, Tranquil’s media 
centre PC is super-slim and utterly silent. It contains just about 
everything you need for a media centre set-up, too, including a 
slot-loading optical drive, 4GB of memory and HDMI and S/PDIF 
support for high-definition video and audio. Its subtle design is 
stunning and it’ll fit in with any other media components.
£500 www.tranquilpcshop.co.uk
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Jargon buster!
 hdMi

HDMI, or high-
definition media 
interface, carries 
video and sound 
from devices to your 
television. You’ll find 
it on the majority of 
media centre PCs.

 S/PdiF
S/PDIF, which stands 
for Sony/Philips 
Digital Interface, is 
designed to transfer 
high-quality digital 
audio from your 
computer to your 
Hi-Fi or speakers. You 
may need an adaptor 
to connect some 
computers, though.

CaSe It may not look 
like much from the 
outside, but this 
Silverstone case 
looks the business 
when it’s all put 
together. Ensure you 
have one that’ll suit 
your motherboard – 
these generally 
come in Mini-ITX, 
Micro-ATX and  
ATX varieties.

Motherboard and 
ProCeSSor We’ve used an 
Asus H77 motherboard in 
this build, which is coupled 
with an Intel Core i5 
processor. It’s capable of 
hi-def 3D video as well as 
astounding sound quality.

tV tuner Internal TV tuners 
plug into the motherboard, but 
this external one connects to a 
spare USB port. Windows Media 
Center will automatically detect 
it and load channels accordingly, 
from which you can record and 
pause live television.

PSu A power supply unit feeds 
electricity to all your PC’s 
components. Go for one that’s 
capable of more than 500W 
and make sure it’s rated 80 
plus – this means it’s efficient.

hard driVe A capacious 
hard drive is a definite 
requirement for any 
media centre PC. We’ve 
used a 3TB drive for our 
build, which will hold a 
whopping 360 hours of 
hi-def video.

Zotac Zbox nano AQ02 Plus
The Zbox is one of the tiniest PCs we’ve ever seen – it’s about half 
the size of a paperback book. But it’s also very accomplished, 
packing a quad core AMD processor, 4GB of memory and an 
HDMI output. It’s capable of high-definition video playback, but 
it’s supplied without an operating system so you’ll have to pick up 
your own copy of Windows.
£376 www.amazon.co.uk

Acer Aspire Z3-615
All-in-one PCs combine all a computer’s internal bits with a 
screen, resulting in a tidy package that serves as an ideal media 
centre. This svelte and good-looking Acer entry includes a 
gorgeous 1080p IPS screen for eye-popping entertainment, as 
touch control, so you can easily navigate your way around your 
media using just your hands.
£636 www.amazon.co.uk
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LAPTOPS
The vast majority of modern laptops 
feature some way of connecting to an 
external display. Cheaper laptops 
include a VGA output, which is a blue 

GAMES CONSOLES
Games consoles can be used for more 
than just playing games. All current 
consoles, such as the Microsoft Xbox 
One, the Nintendo Wii U and the Sony 
PlayStation 4 include media 
functionality. The addition of iPlayer 
and Netflix to the Xbox One and 
PlayStation 4 makes them ideal for 
playing media. The PlayStation 4 also 
includes a Blu-ray drive, so you can 
watch your films in high-definition. 

Don’t worry if you’ve got older 
versions of consoles. The PlayStation 3 
can record and pause live television 
with the addition of the PlayTV 
peripheral. This small box includes an 
RF socket, so you can connect it to 
your aerial, and it even enables you to 
organise and watch your media via a 
PlayStation Portable (PSP), Sony VAIO 
laptop or certain Sony Ericsson 
phones. And see the opposite page 
for more about the Xbox 360’s media 
centre capabilities.

SMARTPHONES
Modern phones are a cornucopia of 
miniaturised tech, so it makes sense that 
you can plug them into your TV and 
enjoy the content. You’ll need a 
smartphone with the mobile hi-def link 
(MHL), as well as a small box that turns 
the mini-USB out into an HDMI output. 
Most new Android phones come with 
this capability. See if your phone is 
MHL-ready here: http://bit.ly/1j4ymhx

It’s then simply a question of tuning 
your TV to the relevant input and using 
your smartphone as you would 

WD TV
Made by hard drive company Western 
Digital, the WD TV Live is an all-in-one 
media centre that can be connected to 
any television. It boasts 1080p playback 
for amazing high-definition video, and it 
has the ability to play or display just 
about any file type.

normally. You won’t be able to record 
TV, but given the astounding jumps in 
smartphone technology we’re sure it’s 
only a matter of time.

It doesn’t end there – it also supports 
Netflix and YouTube for video streaming, 
Spotify and Pandora for music, and 
Picasa for photos. If you’ve already got a 
huge media collection on your desktop 
PC but don’t fancy splashing out on a 
media centre, the WD TV Live could solve 
all your problems in one tiny package.

15-pin connector. These can be linked to 
monitors and some TVs to display what’s 
on screen, but they can’t handle hi-def 
output, and you’ll have to listen to sound 
through the computer’s speakers or via 
an external set of speakers.

A more versatile option is an HDMI 
output, which transmits in Full HD and 
includes surround sound. Simply 
connect your laptop and choose the 
relevant display from within Windows. 
Media-centric laptops include the ability 
to switch off the inbuilt display to avoid 
distractions, and some come with a 
built-in Blu-ray drive. 

mediA pc 
AlternAtiveS
You don’t necessarily need a media centre  
PC to enjoy media on your TV. Here are five  
of the best alternatives NETTOPS

Nettops are essentially laptops 
without a screen or battery, designed 
specifically for desktop use. They 
make great media centre computers, 
though, and their small size and sleek 
looks mean they work well in any 
living room. They’re surprisingly 
powerful – look out for Nvidia’s Ion 
graphics processor to handle high-
definition content.

Unfortunately, nettops don’t tend to 
come with a Blu-ray drive, so you’ll 
have to either stick with downloaded 
material or buy a USB drive. You’ll also 
have to purchase a USB TV tuner to 
watch and record programs. The good 
news is that they’re cheap – some can 
be picked up with a wireless mouse 
and keyboard for under £150.
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3 Start it up
When the setup is complete, tap ‘Launch’ on the Xbox 360. 

Windows Media Center may ask to access the firewall on your PC 
– allow it through. You’ll now be able to access all your media in 
Windows Media Center via your Xbox 360 and anything you add 
to your PC will be added to the Xbox 360’s media collection.

1 Power up
Ensure both your PC and Xbox 360 are powered on and 

connected to the same network. On your PC, start Windows 
Media Center, go to ‘Tasks’, choose ‘add extender’, click ‘Next’  
and then go to your Xbox 360. Use the controller to scroll to  
My Xbox and then choose ‘Windows Media Center’.

4 Navigation
The Media Center on your Xbox 360 works exactly like the 

one on your computer, only you use the controller to browse 
through it. Press ‘A’ to select and ‘B’ to go back. It may take a while 
for the Xbox to build its library, but you’ll soon be able to see your 
photos and videos and listen to music.

2 Get the key
On the Xbox, tap ‘Continue’ and follow the instructions to 

get an eight-digit setup key – this is used to pair the Xbox and PC 
over the network. Make a note of the key and enter it in the space 
provided by Windows Media Center. Click ‘Next’ to continue and 
Windows will apply the settings. This may take a while.

eXtend your mediA
How to access media on your 
computer through your Xbox 360

M icrosoft’s Xbox 360 is 
already a fairly 
functional media device, 
capable of playing DVDs 

and streaming music and videos 
over the internet. But you may not 
realise that it’s also able to play any 
media you’ve got stored on your 
computer over your home network.

It’s all part of Microsoft’s Windows 
Media Center Extender, a protocol 
which means that PCs can be 
connected to other media devices. 

The functionality is built into 
Windows 7 and Vista as well as the 
Xbox 360, so you won’t need any 
other downloads to make it work.

It’s very easy to set up, too – you 
just need to make sure your Xbox 
360 and computer are connected 
to the same wired or wireless 
network in your home. Then run 
through the following steps and 
you’ll be able to enjoy your home 
media in stunning high-definition 
on your television.

Step-by-step | Set up an extended network
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uSe your pHone  
AS A mediA centre  
remote control
Touchscreen mobile phones make  
ideal media centre controllers

Once you’ve bought or 
created your media 
centre PC, you’ll need 
something to control it. A 

wireless mouse and keyboard are 
ideal, while a media centre remote 
control is tailor-made for Windows-
based media PCs and doesn’t take 
up much room. But there is a third 
option: your phone.

Thanks to wireless networks, you 
can control just about everything 
on your PC with a touchscreen 
phone. Android, iPhone and 
Windows Phone devices all have 
free, easy-to-use apps available to 
do just that. For Windows Phone 7, 
the does-what-it-says-on-the-tin 
Media Centre Remote is ideal.

You’ll (obviously) need a 
Windows Phone mobile, as well as 
a Windows PC running Windows 
Media Center. Search the Windows 
Marketplace for Windows Media 
Remote and you’ll find it a little way 
down the results under the 
publisher singhisoumya. Tap it and 
install it on your phone.

Next, return to your media PC, 
boot up Internet Explorer and visit 
www.pcremoteserver.com. Click on 
‘Setup’. When prompted, click on 
‘Open’, and when it’s downloaded 

double-click on ‘PCRemoteSetup.
exe’. Run through the installation 
process and click ‘Close’ when it’s 
finished. Click the Windows Orb or 
Start button, find PC Remote and 
open it.

Go to the apps list on your phone 
and choose ‘Media Center Remote’. 
Tap the plus icon next to Computers 
and enter the IP address shown in 
PC Remote on your PC. Windows 
Media Center will start automatically 
and you’ll now have complete 
control over it using your phone.

Initially your phone will show 
Shortcuts, which will take you to 
relevant parts of Windows Media 
Center, such as photos, music or 
videos. A swipe to the left takes you 
to navigation, which emulates your 
computer’s cursor keys, with Enter 
in the centre. Swipe once more and 
you’ll be able to control play, pause, 
fast-forward and rewind.

At the bottom of the screen you’ll 
find a row of icons to access the 
keyboard, mouse and volume, with 
the close icon to the right for 
exiting Windows Media Center. It’s 
immensely handy, and once you’ve 
got the hang of it you’ll be able to 
de-clutter your living room of 
wireless mice and keyboards. ■

Nicholas Odantzis acting editor

nick’s verdict
The past few years have seen a revolution in 
the way we buy and consume media, and 
computers have been at the heart of it. No 
longer do we have bookcases filled with 
DVDs and CDs – almost everything is stored 
on a hard drive, or accessed over the 
internet. And while it’s sad to see 
independent record shops close, online 
services can cater to a far larger and more 
diverse audience.

Computers have always been at the heart 
of this revolution, with services like Napster 
and iTunes paving the way for Spotify and 
Netflix. It makes sense, then, to have a 
computer connected to your television and 
stereo to enjoy films, TV shows and music. 
There are added benefits, too, such as live TV 
pausing and recording, and checking 

updates on social networks without leaving 
the comfort of your sofa.

The future is likely to bring the TV, 
computer, mobile phone and games console 
into an even more tight-knit unit. We’ve 
already seen phones capable of running 
games on big-screen televisions, as well as 
games consoles that can be operated 
without controllers. The PC always has been 
– and always will be – at the forefront of this 
revolution, though, and now’s a great time  
to experience it for yourself.
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Clean sweep The Disk Cleanup tool takes the hassle out of deleting caches of temporary 
files that are using your computer’s resources

First, let’s tackle any unnecessary files that are using up 
your computer’s valuable resources. Type disk into the 
Start menu search box and select ‘Disk Cleanup’ from 
the list of results. Choose the drive that you want to tidy 
(if you have more than one hard drive or partition) and 
click on ‘OK’. The Cleanup tool will calculate how much 
space could be saved on your machine by deleting 
superfluous files, and will present you with a checklist 
of file types that could be removed. Tick the ones that 
you want to purge, then click ‘OK’. The options here 
include temporary system files, the contents of your 
Recycle Bin and web pages that you’ve saved for use 
offline, so be careful what you remove!

Take ouT 
The Trash

ways to speed 
up your 
windows 7 pC
If your PC is starting to dawdle, these tips and 
tricks will soon get it back up to scratch

1
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BeTTer Than new new pCs often come packed with software you’ll never use, but 
check online first to make sure you don’t remove anything important

self-
assembly

DIsInfeCT 
your DrIve

DeeP  
Clean

beaT 
bloaT

PC manufacturers are notorious for 
installing unnecessary software that 
slows down your brand new 
machine. Type remove into the Start 
search bar and select ‘Add or remove 
programs’. Here, you can uninstall 
any unnecessary applications that 
were supplied with your PC. Be 
careful not to remove anything 
important; if you’re not 100 per cent 
sure about a particular program, visit 
www.shouldiremoveit.com and 
search for its name in the top right 
corner for more information.

Once you’ve finished cleaning up, you need to 
defrag your hard drive to make sure it’s running 
efficiently, without bits of files scattered around. 
We recommend using Auslogics Disk Defrag, 
which you’ll find on your free disc. The program 
starts by scanning your system and showing you 
how fragmented your hard drive currently is. 
Defragging can take a long time, so you can set 
the program to turn your PC off automatically 
once it’s finished, while you do something else. 
Remember, SSDs shouldn’t be defragmented as it 
can shorten their lifespan.

sCan anD Clean Keep your pC running smoothly with regular scans for 
viruses and malware. There are lots of free tools available online

Malware and viruses can really slow your 
computer down, hogging its valuable RAM 
and disk space. There’s no need to fork out for 
an expensive antivirus program, though. AVG 
Free (http://free.avg.com) is an excellent 
alternative that will scan your hard drive and 
remove malicious programs, and won’t cost 
you a penny. It’s also worth downloading the 
free version of Malwarebytes Anti-Malware 
from www.malwarebytes.org. It will run 
alongside your antivirus software, and will pick 
up any software that is doing your PC no 
good, but isn’t actually a virus.

Now it’s time to sort out your PC’s Registry. This is a 
type of database of software preferences and 
settings, and it can become clogged up with old 
entries as you install and uninstall programs. These 
slow down your computer and can cause error 
messages, so install CCleaner from your free disc and 
run the Registry Cleaner to sort things out.
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puT iT all TogeTher Defrag your hard drive regularly to ensure files are stored in single 
blocks, rather than pieces scattered over the disk

Clear up windows doesn’t always do a very good job of keeping 
its registry clean, but CCleaner will get it neat and tidy

Feature
Speed up Windows 7
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Type power into the Start search bar and select ‘Power 
options’ from the list of results. Normally, you can only 
choose between two modes (balanced and power 
saver), but there is a third option that’s designed to 
make your laptop run more quickly. Select ‘Change 
plan settings’, then click ‘Change advanced power 
settings’. Now use the drop-down menu at the top to 
select ‘High performance’. This should have a 
noticeable effect, but do bear in mind that it uses a lot 
more power than the other two options, and therefore 
isn’t a good choice if you’re on the road as it will reduce 
battery life.

The default Windows 7 Aero theme looks pretty with its translucent 
windows and toolbars, but it’s a drain on your PC’s valuable resources 
(which is why it’s no longer the default option in Windows 8). To simplify 
things, right-click on the Windows desktop and select ‘Personalize’. Scroll 
through the list of themes until you reach the basic and high-contrast 
options, and select ‘Windows 7 basic’. This doesn’t look very different from 
the Aero theme, but lacks the translucent effects. You can also save a tiny 
bit of RAM by using a plain colour rather than an image for your desktop 
background. Again, you can do this via the ‘Personalize’ options – click 
‘Desktop backgrounds’ and select ‘Solid colors’ from the drop-down menu.

Services are programs that run in the background while you’re using your 
PC. Many of them are essential for your computer to run properly, but there 
are others that you can safely disable for a performance boost. Before you 
get started, create a System Restore point, just in case something goes 
wrong (http://bit.ly/1ibns43). Now type services into the Start menu’s 
search bar and click the ‘Services’ link with a gear icon beside it. You’ll now 
see a list of all the services running on your computer. To deactivate one, 
right-click it and select ‘Properties’, then set the Startup Type to ‘Disabled’. 
For a list of services that are safe to disable, check out http://bit.ly/1gpq6rp.

Solid-state drives (SSDs) are much faster than 
conventional hard disk drives because they have no 
moving parts. This also means they run silently and are 
less vulnerable to knocks and drops, making them 
great for laptops. Early SSDs had very small capacities 
and were prohibitively expensive, but technology has 
improved dramatically in recent years, and a good 
quality 500GB SSD such as the ADATA XPG SX900 can 
be yours for £200/$270. If that’s not enough space for 
all your photos, videos and music, you can always 
archive them on an external USB hard drive. To find out 
how to move your data to a solid-state drive, follow the 
step-by-step guide at http://bit.ly/Tte32u.

Windows 7 includes handy tools called Gadgets, which 
make your desktop more useful by adding features 
such as a calendar and CPU meter. Unfortunately, they 
also slow down your computer, so if your machine is 
feeling sluggish it’s best to remove them. Simply hover 
your mouse pointer over a gadget, then click the cross 
icon in the top right. Microsoft has removed Gadgets in 
more recent versions of Windows due to a security risk, 
so you might prefer to disable the option entirely. Visit 
http://bit.ly/1jdhIGz to find out how.

soliD speeD installing a solid-state drive is one of the most effective ways to speed up 
your pC. You’ll notice the difference the moment you press the power button
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Email full details of your 
problem to the 
support team and we’ll 
do our best to help 
windowsmagazine@
futurenet.com Or 
write to the support 
team and we’ll do our 
best to help 
Support squad, 
Windows 7 Help & 
Advice magazine, 
Future Publishing Ltd, 
30 Monmouth Street, 
Bath BA1 2BW

Do you have a  
PC problem?  
Get in touch…

Windows
PROBLEMS WITH 
WINDOWS 8.1 

Q After a recent broadband 
surge in our area, I was sent 

a new Sky router and managed 
to get our connection back. 
Unfortunately this has left my 
Windows 8.1 PC with two major 
problems. First, right-clicking 
on the Windows button on the 
bottom left of the screen has 
no effect, and second, all the 

apps I’ve downloaded from the 
Windows Store have also gone 
missing. Clicking on the Store tile 
has no effect – the screen simply 
goes blank, turns green and then 
returns to the Windows Start 
screen. Can you help please?
John

Simon’s solution
After some analysis of 
John’s problem, it was 
clear there was an issue 

with some kind of corruption, 
which was presumably caused 
by the broadband surge that had 
knocked out his old router. We 
pointed John towards the brilliant 
Windows Repair (All In One) from 
www.tweaking.com, and instructed 
him on how to use the program 
– you’ll find a step-by-step guide to 
using it on page 50 of this issue.

John told us that the System 
File Checker scan halted at 21 per 
cent with the message ‘Windows 
resource protection could not 
perform the requested operation’, 
which didn’t bode well. However, 
upon restarting his PC after 
performing the backups, John 
reported that the System File 
Checker scan completed 
successfully. He then ran the repair 
tool, and he was then able to 
confirm the Windows Store was 
now working correctly again.

The repairs didn’t resolve his 
problem with right-clicking the 
Windows button, so we pointed 
him towards the Classic Shell 
(http://classicshell.net) program 
and its Classic Start component. 

Start menu 
Bring back the 

classic Start menu 
with Classic Start
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This replaces the Start button with 
a bona fide Start menu, which John 
was more than happy to use in 
place of the Quick Access menu.

Hardware
MEMORy UPgRADE 
qUERy 

Q I recently built myself a new 
computer with an Asrock 

B75-Pro3M motherboard. I’ve tried 
reusing an 8GB stick of DDR1333 
RAM from my old PC, but I keep 
getting BSOD errors during use. 
I’ve checked these out using 
WhoCrashed (www.resplendence.
com/whocrashed), but there’s no 
single cause. I’m pretty sure the 
memory’s responsible, but is there 
some way I can make it more stable 
to save me buying new RAM?
Toni Rye

Matt’s solution
Ideally, you should 
always buy memory 
using the memory 

retailer’s own system checking tool 
to ensure that it’s 100 per cent 
compatible with your computer 
and its other components. That 
way, if you run into problems, you 
can blame the stick of RAM itself. 

Toni revealed that the stick still 
worked fine in her old computer, 
and passed all memory checking 
tools, although it did freeze 
during an extended check on one 
machine, which implied problems 
with memory timings.

We suggested going into the 
motherboard’s BIOS, then selecting 
‘OC Tweaker’ followed by ‘DRAM 
Frequency’. Change this from Auto 
to 1,066 – the lowest possible 

setting. On saving her changes 
and exiting, Toni reported that the 
system appeared to be much more 
stable, but we’d still recommend 
replacing that stick of RAM sooner 
rather than later.

Internet
ADOBE FLASH  
UPDATE PROBLEM 

Q I’ve been advised to update 
Flash on my Windows XP 

PC, but while the downloader 
appears to work, it only gets as 
far as 7 per cent before claiming 
the connection is lost and retiring. 
Everything else appears to be 
working correctly – can you 
suggest a solution, please?
Peter Roberts

Quickfire questions

Find the solution! Fix workbook tab problems in Excel
There are a number of causes and solutions to workbook tab 
issues – visit http://bit.ly/tabfixexcel for some suggestions.

Windows has started 
displaying all dates as DD/
Month/YY instead of DD/MM/
YY. How do I change this?
Chris Bolton

Type region into the Start 
menu’s Search box and click 
‘Change time, date or number 
formats’. Change the Short 
Date setting from dd/MMMM/
yy to dd/MM/yy and click ‘OK’.
 
My workbook tabs and both 
scrollbars have vanished from 
my Excel 2010 documents.
Denis galvin

The workbook has become 
‘unhooked’ from the ribbon 
– double-click its title bar to 
maximise it and bring 
everything back. 

“You should use the 
memory retailer’s own 
system checking tool”

 BSOD 
Stands for Blue Screen of 
Death, and is the popular term 
for the screen that appears 
after a fatal system error.
 

 Workbook
Workbooks contain a number 
of worksheets, which are 
accessible via a series of tabs at 
the bottom of the document. 

unStaBle ram 
You can try 
underclocking 
memory if it is 
not corrupt, but 
is still causing 
your PC to crash

DVD fix try 
recreating this 

registry key and 
value to fix DVD 

recognition issues

Support 
Technical help
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2 Download EjectUSB
If the problem persists, download 

EjectUSB from www.portablefreeware.
com/?id=1425. Right-click the file named 
‘EjectUSB.zip’ and choose ‘Extract All’. Click 
‘Browse’, select the root directory of your USB 
drive and click ‘OK’ followed by ‘Extract’.

1 Check Device Manager
Open Device Manager from the Start 

or Quick Access menu, depending on your 
version of Windows. Expand the Disk Drives 
section and double-click the USB drive. Go to 
the ‘Policies’ tab and ensure the Removal 
policy is set to ‘Quick Removal (default)’.

CAN’T SAFELy  
REMOvE USB DRIvE

Q Why am I always told the 
drives are in use whenever I 

try to safely remove my USB hard 
drives in Windows 7? 
Diane Pole

Nick’s solution
Locked drives can 
often be traced to 
a file being open in 

another program, but Diane was 
adamant that this wasn’t the case. 
The following step-by-step guide 
reveals three potential ways to fix 
problems with drives that refuse 
to eject as they should.

Quickfire questions

in the left-hand pane: HKEY_
LOCAL_MACHINE\SYSTEM\
CurrentControlSet\Services\atapi. 
Then, right-click the atapi key 
and choose ‘New Key’. Name this 
Controller0 and press [Enter]. Now 
select ‘Controller0’ and choose ‘Edit 
> New > DWORD (32-bit) Value’. 
Name this EnumDevice1, then 
press [Enter] and double-click it to 
change its value to 1. Click ‘OK’, exit 
Registry Editor and reboot your PC.

Internet
UNABLE TO UPDATE  
INTERNET EXPLORER 

Q My Windows 7 PC stubbornly 
refuses to update to a later 

version than the installed Internet 
Explorer 9. Can you help at all, or 
should I stick with IE9?
Fred Jones

I’ve lost the My Music icon and 
all other traces of the original 
Microsoft music installation on 
my Windows XP netbook. Can I 
download a replacement?
Jack Anderson

You can download the latest 
version of Windows Media 
Player for XP from http://bit.ly/
winmediaplyr. Look in My 
Documents for your My Music 
folder and create a new 
shortcut from there.
 
Can you recommend an 
app that will enable me to 
quickly resize windows to set 
dimensions for the purpose of 
taking screenshots?
Liam King

Try the small, but perfectly 
formed Sizer tool from http://
brianapps.net – it works simply 
by letting you right-click a 
window so you can choose 
your target size. It’s free too.
 
I’m unable to remove a 
program from my PC because 
it tells me the installer is 
missing. What can I do?
Phil Baker

Try downloading the program 
installer and installing it over 
the top of itself (or removing 
it if the option appears during 
setup). Otherwise, try IObit 
Uninstaller’s Forced Uninstall 
tool – you’ll find the program 
on the cover disc.

James’s solution
The simplest thing to 
try here is to locate the 
full, offline installer for 

Flash and attempt to install from 
there instead – it’s hidden away 
on the Adobe site, but you’ll find 
it at http://bit.ly/fullflash – either 
version (exe or msi) should work, 
but start with the exe version. On 
downloading the file, Peter was 
able to confirm that he could 
successfully update Flash to the 
latest version.

Software
ROXIO DISABLED  
DvD DRIvES! 

Q I have been attempting to 
install Roxio RecordNow 8 

Premium on my new Windows 7 
PC – it worked perfectly on my 
older Windows XP machine. Now, 
I have been getting a message 
telling me it has disabled all my 
optical drives, including my USB 
one. It mentioned something 
about the drivers in the program 
not being digitally signed. Sure 
enough, when I checked Device 
Manager I saw the dreaded yellow 
exclamation marks. Can you help?
Alan Waller

Simon’s solution
RecordNow 8 isn’t 
listed as being 
compatible with 

Windows 7, so it’s little surprise 
that it has caused this problem. 
After he had removed RecordNow, 
we pointed Alan towards the link 
shown in the Find The Solution 
box. He diligently worked his way 
through the resolutions offered, 
but it was the final one that 
eventually restored his drives.

This step involves opening 
Registry Editor. Press [Win]+[R], 
type regedit and then hit [Enter]. 
Next, browse to the following key 

file enCrYPtion 
once installed, 
axCrypt works via 
your right-click 
context menu
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 Sandbox 
A tightly controlled and 
isolated environment in which 
programs can be safely run 
without interacting with the 
main system, thus reducing the 
risk of infection or stability 
problems. If you want to test 
out software, try it here.
 

 Root directory
The top level of a drive. Files 
that are dragged directly on 
to a drive icon in Windows are 
stored in the root directory.

4 Eject drive
Open the drive, double-click ‘EjectUSB.

exe’ and close the window – check the 
notification area for a message telling you it’s 
safe to remove. If this fails, use UnLocker to 
select and unlock any specific file known to 
be blocking the eject process.

3 Add Unlocker
Browse to http://emptyloop.com/

unlocker and download the portable version 
of Unlocker. Double-click the zip file, then 
open either the x86 folder (32-bit Windows) 
or x64 folder (64-bit Windows) and copy the 
files inside to the root of the USB drive.

“If you’re in any doubt, never click an  
email with a link in it, particularly when  

that’s all the email contains”

Adam’s solution
We spoke to Fred and 
found that he had 
looked under the 

Programs and Features Control 
Panel for a reference to Internet 
Explorer that he could try to 
update or remove, but as IE9 is built 
into Windows, there wasn’t any 
reference to it there – it is only 
when you successfully install a later 
version that you can roll back 
through that route (click ‘View 
Installed Updates’ to see them).

There are two ways to get 
Internet Explorer 11 – either go 
through ‘Start > All Programs > 
Windows Update’, or download the 
program directly from Microsoft. 
However, when Fred attempted 
either solution, he received a 
Windows Update failure message 
upon rebooting Windows, which 
subsequently reverted his changes. 
He tried calling Microsoft Support, 
but this was equally unsuccessful. 
Eventually they advised him that a 
virus may have crippled his system, 
so Fred performed a clean install of 
Windows and is now busy restoring 
his system with the help of our 
back issues.

Security
ENCRyPT SENSITIvE  
FILES FOR FREE 

Q I read the article about 
encrypting files using 

BitLocker, but I only have Windows 
7 Home Premium. Is there a free 
version I could download?
David Reece

Nick’s solution
Until recently, our go-to 
answer would have 
been TrueCrypt, but 

developers recently shut down 
the project. Sadly, there’s nothing 
free that we’d recommend for 
encrypting an entire drive or 

volume, but you do have options 
for encrypting individual files and 
folders. A small, portable option 
is QuickCrypt, which you can 
download from http://valkovatech.
net. This lets you create encrypted 
files for storing or distributing to 
others, but you have to decrypt 
files before accessing them. 
AxCrypt (www.axantum.com) is 
more fully featured, and lets you 
open, save and edit files without 
having to decrypt them. AxCrypt 
is bundleware, so install a tool like 
Unchecky (http://unchecky.com) 
first to avoid inadvertently installing 
unwanted software alongside it.

Security
CLICKINg EMAIL LINKS 

Q I recently received a 
mysterious and suspicious 

email from someone I had contact 

with a year or two ago that simply 
contained a web link. I’m inclined 
to delete it, but wanted to verify 
that it was malicious.
Les Dobinson

Simon’s solution
We checked the link in 
our sandboxed web 
browser, and it took us 

to a website selling diet products. 
Malwarebytes Anti-Malware 
(MBAM) Premium also spotted a 
malicious link in the web page and 
blocked it. If you’re in any doubt, 
never click an email with a link in 
it, particularly when that’s all that 
the email contains. Don’t blame 
the sender, though – the email 
won’t have originated from them, 
and their address was probably 
harvested from someone else’s 
address book. ■

WeB ProteCtion Block malicious websites with the help of mBam Premium

Do you have  
a PC problem?  
Get in touch…
Email full details of 
your problem to the 
support team and we’ll 
do our best to help 
windowsmagazine@
futurenet.com 
Or write to the support 
team and we’ll do 
our best to help 
Support squad, 
Windows 7 Help & 
Advice magazine, 
Future Publishing Ltd, 
30 Monmouth Street, 
Bath BA1 2BW

Support 
Technical help
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 new hardware   essential accessories   latest GaMes

the days of your 
computer being a 
grey box on your 
desk are long gone. 
You can now take 

your PC with you everywhere 
you go, ready for whenever 
you want to type out a report 
or relax and have fun.

Last month we brought you 
a preview of Microsoft’s latest 
Surface tablet. We’ve now 
completed our full battery of 
tests, and we’re excited to say 
that this could be the laptop 
replacement you’re looking for. 
If you’d rather not switch just 
yet, we’ve also looked at two 
new notebooks – one for work 
and another for play. Whatever 
you need a computer for, 
there’s something here for you!

Nick Odantzis acting editor
nick.odantzis@futurenet.com

Welcome

how we review
One of the key tenets of our 
review philosophy is that 
hardware should be compared 
against like products wherever 
possible. It is only when you pit 
the finest products of a certain 
type against one another – at 
the same time – that you can 
really come up with a definitive 

verdict as to which is the very 
best in that category. The pace 
of development in computer 
hardware means that it is very 
difficult to compare scores 
from today with those from, 
say, six months ago. Magazines 
and websites that review a new 
product on its own run the risk 
of confusing or misleading.

We guarantee to test every 
piece of hardware rigorously 
and thoroughly, using only 
acknowledged experts to 
establish the worth of a 
product. We always review 
from the viewpoint of our 
readers; the day-to-day 
practicality and quality of  
a product is paramount.

We use only acknowledged experts to review products, so you can use 
our ratings with full confidence to make your buying decision

ratinG explained Superb GoodVery good Disappointing Poor

our awards…Our review guarantee
Only the very 
finest products 
receive our Best 
On Test Award. 
These will have 
excellent marks 
for quality.

Our Best Value 
Award is given 
to products that 
quite simply 
represent the 
best value for 
your money.

88 Medion Erazer X7611
Light and slender for a gaming laptop, 
and competitively priced, but at the  
expense of high-end graphics.

82 In-ear headphones
The right tune can turn a good workout 
into a great one, and these smart earbuds 
will stay put when the going gets tough.

90 Tropico 5
As a dictator, you must retain control of 
your nation any way you can. Corruption, 
bribes and assassination – anything goes.

86 Microsoft Surface Pro 3
After last month’s preview we’ve spent  
some quality time with Microsoft’s new 
tablet, and we like what we’ve found…
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Upgrade 
What’s inside…

You can trust our reviews
Our expert reviewers are 100 per cent 
independent, with years of experience 

in the world of computing. Our rigorous 
testing procedures mean that only 
genuine, high-quality products are 
awarded high star ratings. Further, very  
few are handed our Best Value or Best  
on Test Awards. If you see an item of 
hardware bearing one of these marks,  
you can be confident that it is an excellent 
product. Always check when the award  
was given, to ensure it is still up-to-date.

we choose the best products
Thousands of new products for your 
computer are released every year and 

choosing between them can sometimes be 
an impossible task. Our experts select only 
the best hardware and software to feature 
in this magazine, making your decision on 
which one to choose easier. Even better, 
our awards and star rating system make it 
simple to find the best products for your 
needs, with our recommended products 
section giving you a fast, trustworthy guide 
to a wide range of hardware and software.

we’ll introduce you to new stuff
Wherever we can, we review new 
hardware comparatively, pitching  

it head-to-head against other similar 
products. (Full details of our policy can be 
found in the opposite page, under ‘Our 
review guarantee’.) Of course, this isn’t 
always possible with new products and 
part of our duty to you is to introduce you 
a wide range of fascinating new hardware, 
software, services and games.

The reviews of standalone hardware  
and software are just as thorough as our 
comparative reviews. However, we do not 
allocate scores to them because this can 
often be misleading. The only exception to 
this rule is on our games reviews, where 
the pace of change is a lot slower and 
single scores can be genuinely useful.

The Upgrade section is your key to finding out about the latest 
products, all designed to help you get more from your PC

“Instead of bandits, you  
get a menagerie that includes 

werewolves, vampires, dragons 
and, yes, Great Turtles.” 

Turn to page 94

82 Pioneer SE-CX8-T
82 Shure SE425
83 Monster iSport Strive
83 Sol Republic Relays
83 Bose Quiet Comfort 20i
84 Asus Zenbook UX301LA
86 Microsoft Surface Pro 3
88 Medion Erazer X7611
90 Tropico 5
92 Smite
94 Warlock 2: The Exiled
96 Trials Fusion
97 Wargame: Red Dragon 
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Full listing84 Asus Zenbook 
UX301LA: a fast,  
quiet and stylish  
new Ultrabook

Our promise to you…

88 Medion 
Erazer 

X7611: enjoy 
gaming  

on the go
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Best 
Buds
Plug in and tune out, whatever 
your surroundings, with in-ear 
headphones for every music fan

Pioneer SE-CX8-T
Price £170 | $200 (www.pioneerelectronics.com)

Aimed at those people who love to stand too 
close to the PA system, these little earbuds deliver 
bombastic sound using dynamic drivers. A built-in 
“Bass Exciter” even gives you the feeling of having 
a subwoofer stuffed into your ear canal; it vibrates 
along with your tunes so that you feel the beat inside 
your skull. If you’re a 24-hour party person you’ll love 
them – LTJ Buckem blew our ears off – but take things  
down a few notches and the audio starts to sound 
disappointingly thin. Available in copper, silver or 
black, they look slick. The fit isn’t snug enough for 
sports, but they’re commute-ready.

Shure SE425
Price £239 | $300 (www.shure.com)

Sound purists are used to paying through the nose, 
so the price here is no surprise. These offer amazing 
sound isolation, blocking a claimed 90 per cent of 
outside noise, without the need for a battery, and 
have accurate sound reproduction capable of 
reinvigorating even the most overplayed tracks – 
previously unheard amp vibrations and fret board 
squeaks all over Led Zeppelin’s first album left us with 
a lasting grin. The design is unassuming but classy and 
the cables are replaceable, ensuring the music will 
continue for years to come. In-ear buds are usually 
throwaway, but these are a real investment.
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Sol Republic Relays
Price £60 | $75 (www.solrepublic.com)

Winner of this year’s Red Dot award for innovative 
design, these are, well, a bit different. They sit flat 
in your ear, with the patent-pending FreeFlex bud 
expanding to perfectly fit your shell-like. They stay 
put for sport and look street smart in bright colours, 
but the material isn’t especially soft and they can feel 
invasive, hugging your inner ear tightly. Sonically, 
they performed admirably without ever giving us 
goosebumps. Sound is reasonably well isolated 
thanks to the tight fit and there’s a healthy dose 
of bass. For budget buds they’re decent, but can’t 
match the sound quality of more pricey options.

Monster iSport Strive
Price £59 | $70 (www.monsterproducts.com)

The most important element of sports in-ear 
headphones is the fit. The Strive nails this using its 
SportsClip design to clamp on to your lugs, hanging 
on no matter how vigorous your workout gets. The 
sound quality is quite open, keeping you well aware 
of your surroundings as you jog, but performance 
is still big, bold and impressive. There’s also a built-in 
mic for answering calls on the run. The cable refuses 
to tangle and the look is sporty without being garish. 
They’re also fully water- and sweat-resistant, with 
antimicrobial tips that prevent germ buildup. The 
ideal addition to any stylish gym bag.

Bose Quiet Comfort 20i
Price £249 | $280 (www.bose.com)

Costing more than some high-end full-ear headsets, 
these buds boast brilliant active noise cancellation, 
blocking out ambient noise without requiring you to 
pump up the volume. The slim battery pack that powers 
the silence offers 16 hours of use per charge. It’s a bit 
bulky, but sits close enough to the jack that it doesn’t 
weigh down the cable. A choice of rubber tips provides 
a secure fit. Sound quality is enjoyable, but nothing to 
excite audiophiles. These are all about the cocoon of 
calm they create, though, rather than the racket. Just 
don’t blame us when you miss your stop in the morning.

Upgrade
Earphones
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The original 2011 Asus 
Zenbook was one of the first 
laptops to adhere to Intel’s 

Ultrabook specification, which 
places strict design guidelines 
on manufacturers. To earn the 
Ultrabook label, laptops must meet 
certain requirements regarding 
dimensions, battery life and so on. 
Fast forward to today, and Intel’s 
latest mobile platform not only 
requires Ultrabooks to be no more 
than 20mm thick, but also boast 
a battery that can cope with six 
hours of HD video playback. A 
touchscreen is now also mandatory, 
along with support for features 
such as Intel’s WiDi wireless display.

This is all standard in the 2014 
Asus Zenbook UX301LA, an 
Ultrabook with a 13.3-inch IPS 
screen that retains the 13-inch 
wedge shape of its original 
incarnation. It’s been given a fresh 
look with new materials replacing 
the older version’s aluminium lid 
and chassis – a style that has 

become all too predictable from 
modern laptop designers.

The Asus Zenbook UX301LA is 
now dark blue, and appears almost 
black in dim lighting conditions. 
The lid is covered in a layer of 
scratch-resistant Corning Gorilla 
Glass, and the area around the 
chassis is made from ceramic for a 
smooth but solid feel. As with the 
majority of modern computers, the 
backlit keyboard uses the familiar 
isolated or chiclet style, which is 
great for typing, but might not 
appeal to gamers wanting big and 
chunky [W][A][S][D] keys.

Above and beyond
Asus has gone beyond the basic 
Ultrabook specification – the 
Zenbook UX301LA comes with 
802.11ac wireless networking, a 
choice of high-PPI touch-sensitive 
screen resolutions (either 1,920 x 
1,080 or 2,560 x 1,400), 8GB of 
memory, a dual-core Core i5 or 
Core i7 Haswell processor (which 

comes with Intel’s Iris integrated 
graphics), and dual 128GB Sandisk 
SSDs in RAID 0 configuration. The 
802.11ac wireless card is a two-
stream Intel 7260 adapter.

A critical issue currently facing PC 
and laptop designers is the use of 
high-resolution screens in small 
displays, when text in Windows and 
third-party applications appears 
too small to see. With the Windows 
desktop DPI set to default, a full 
HD resolution on a 13.3in screen 
is really pushing the boundary of 
usability, so we’d really hate to see 
what the 2,560 x 1,440 variant looks 
like. Windows 8.1 automatically 
adjusts the desktop DPI, which 
makes text legible and improves 
usability a lot. It has to be done 
manually with vanilla Windows 8 or 
Windows 7 though, so raising the 
DPI setting is the very first thing 
we’d do on any laptop with a high 
resolution screen, which includes 
the Asus Zenbook UX301LA, which 
arrived with Windows 8. But as with 

Asus Zenbook UX301LA
£1,500 | $2,050 www.asus.com

Is this more than just another expensive Ultrabook?
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The trackpad is generously 
sized, with no physical buttons. 
Instead, left- and right-clicking can 
be done by pressing at the bottom, 
and there’s custom software to 
allow for gestures, such as swiping 
to go back in a web page. These 
work excellently, and can all be 
customised in the software. 
However, one shortcut becomes 
highly irritating: swiping at the side 
of the trackpad to switch between 
desktop and Windows 8 Modern UI 
application. It’s very easy to do this 
accidentally, and is best disabled.

Although it’s fine for light 
gaming and older software, if you 
want a gaming laptop, or a system 
for demanding tasks such as video 
encoding, Ultrabooks are not the 
best choice. On the plus side, Asus 
has ensured the fans are quiet 
when they inevitably speed up 
once the UX301LA is under load.

The Zenbook UX301LA crams 
plenty of features into a small 
space. It’s undoubtedly a great 
example of a modern Ultrabook, 
with slim dimensions, more than 
enough battery life, and some nice 
additions such as the glass lid and 
ceramic chassis. The trackpad’s 
gesture control software works 
very well, and really helps navigate.

Asus has tried hard to give the 
Zenbook UX301LA a premium 
feel, with very little use of plastic 
or other cheap materials, but it just 
doesn’t feel like a £1,500 laptop. 
It lacks a single stand-out feature 
that justifies its price, and for 
similar money you could get a 
more powerful device, albeit 
one that’s not so portable. ■

This Ultrabook has a real premium 
feel, but it’s still not quite enough 
to justify its hefty price tag.

other laptops we’ve tested, not all 
third-party applications adhere to 
the DPI settings, and remain at their 
standard size with tiny text – an 
issue for which there is no current 
solution available.

The test model we received 
came with an Intel Core i7 4500U 
processor. The Core i7 4500U runs 
at 1.8GHz, with a maximum turbo 
processing clockspeed of 3GHz, 
and the graphics are handled by an 
integrated Intel HD 4400 graphics 
processor. There’s the option of a 
faster Core i7 4558U processor as 

well. But the CPU is a low-voltage 
processor and you get performance 
to match. Still, it’s fast for most 
purposes, even if it doesn’t have 
the power of a high-end desktop 
replacement laptop. That said, the 
Asus Zenbook UX301LA didn’t feel 
particularly quick. Although boot 
times were fast, switching between 
the Start screen and the Windows 
desktop wasn’t quite instantaneous 
and resuming from sleep took 
longer than we’d like as well.

Storage transfer speeds are 
fast as this laptop has two drives 
(981MB/s when reading data and 
586MB/s writing), but overall SSD 
performance is affected by more 
than just burst data transfer. Other 
results, such as a random 4K write 
result of 233.7MB/s are indicative of 

worse overall IOPS performance 
than some high-end single SSDs.

We tested the battery life by 
playing a file looped in Windows 
Media Player. On a full charge, it 
lasted well into the third play of the 
film, conking out after six hours and 
45 minutes. Another battery test 
wasn’t as good though, lasting five 
hours and 32 minutes.

As is often the case with 
Ultrabooks, there are only a small 
handful of ports. Mini DisplayPort, 
micro HDMI, Two USB 3.0, an SD 
card reader and an audio jack 

occupy the sides, along with the 
power connector.

Extra gloss
The Zenbook UX301LA is bulkier 
than you might expect. The glass 
surface on the lid feels pleasant, 
but shows fingerprints wherever 
it’s touched; a micro-fibre cleaning 
cloth and non-alcoholic fluid would 
definitely make a great companion 
purchase, and it seems Asus may 
has missed a trick by not including 
something similar in the laptop’s 
stylish packaging.

The main section of the device 
feels strong – we tried pushing it 
quite hard and didn’t notice even 
the tiniest amount of flexing, but 
the screen easily bends under 
comparatively little pressure.

“If you want a system for tasks such as video 
encoding, Ultrabooks are not the best choice”

Upgrade 
Asus Zenbook UX301LA
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Asus Zenbook UX301LA
Supplier www.ebuyer.com
Operating system Windows 8 64-bit
Processor Intel Core i7-4500U 1.8GHz
Storage 256GB SSD
RAM 8GB RAM
Graphics Intel HD 4400
Connectivity 2x USB 3.0, Micro-HDMI, 
Mini DisplayPort, Ethernet, SD reader 
Weight 1.2kg 
Screen size 13.3-inch 
Display resolution 1,920 x 1,080



Microsoft has certainly 
been making bold moves 
in recent times, for better 

or worse, and it clearly isn't afraid 
to fall on its face in the hope of 
landing on what in the world tech 
users want next in this turbulent 
market. With the Surface 3, it might 
have done just that.

The company has spent years 
hammering away at what it 
considers a problem with tablets. 
Since the launch of the Surface Pro, 
it has sought to create the ultimate 
mobile computing device – one 
that could replace the laptop with 
a tablet-first approach.

With the Surface Pro 3, it's close 
to making good on that vision. 
After using it for over a week, we'd 
go so far as to say that the Pro 3 is 
better than any other laptop-tablet 
hybrid released so far.

Surface impact
Microsoft has increased the Surface 
Pro's touchscreen from a tiny 10.6 

inches to a far roomier 12 inches. 
In the process, the pixel count has 
been upped from 1,920 x 1,080 to 
2,160 x 1,440. The result is a modest 
boost in pixels per inch – 207ppi 
to 216ppi – given the increase in 
screen real estate.

More important is Microsoft's 
interesting choice in aspect ratio. 
Rather than sticking with the 
Surface Pro 2's 16:9 aspect ratio 
or jumping onto the iPad's 4:9, 
the firm went with 3:2. According 
to Microsoft, this means that the 
12-inch screen can actually display 
more content. The move was also 
intended to make the tablet feel 
more like a paper notepad when 
held in portrait orientation.

Wrapped in a bright, silver-
coloured magnesium shell that's 
pleasantly cool and smooth to 
the touch, the Surface Pro 3 feels 
premium in every regard. It keeps 
the characteristic trapezoidal shape 
of its predecessors, but is both 
thinner and lighter than before, 

and its upper edges are perforated 
by vents to better dissipate heat 
pushed out by its fan.

Microsoft has also moved the 
Windows button to the left side of 
its silky smooth (albeit rather thick) 
glass bezel. This means it appears 
on the bottom when the device is 
held upright, encouraging you to 
use it in this orientation.

Adorning both sides of the Pro 3 
are 5MP cameras capable of 1080p 
video recording. Still pictures taken 
with these cameras won't blow you 
away, but the front-facing lens 
should do just fine for Skype and 
the weekly video meeting.

Write here, write now
A tablet wouldn't be much of a 
laptop replacement without an 
optional keyboard, and the Surface 
Pro's board was in desperate need 
of a boost. Luckily, Microsoft sent 
the Type Cover right back to the 
drawing board and what came 
back is the best version yet. From 

Microsoft Surface Pro 3
£849 | $999 www.microsoft.com/surface

Can Microsoft’s new Surface make laptops a thing of the past?
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revision. Between its bigger, 
sharper screen and thinner, lighter 
magnesium frame, nearly every 
box has been checked in crafting 
a superior product. The same 
goes for the Type Cover, kickstand 
and Surface Pen, all of which have 
received major improvements 
and rethinks. The redesigned 
Type Cover has resulted in the best 
typing experience we've had on 
a tablet keyboard, while the new, 
wider-angle kickstand in tandem 
with the new stylus makes for more 
use cases that simply make sense.

Two for one
This device can honestly serve 
as both your tablet and laptop in 
nearly equal measure. However, 
the device certainly isn't without 
compromise. Relatively poor 
battery life and a dearth of hard 
connections are clear hurdles for 
the Surface Pro 3, and the decision 
to make the much-improved Type 
Cover an additional accessory 
means that this is no laptop 
replacement out of the box. Just 
under four hours of battery life 
might be suitable for the average 
Ultrabook, but not for an everyday 
tablet, and it’s a real shame for such 
a highly anticipated product.

Yet, it's worth reiterating the 
point that the Surface Pro 3 is not 
only Microsoft's most striking and 
versatile device to date, but also 
the most convincing poster child 
for the hybrid category we’ve seen 
so far. It might not be perfect yet, 
but it's far and wide the brightest 
shining example of a potential 
tablet takeover. ■

The battery life is a real let-down, 
but the Surface Pro 3 is wonderful 
in almost every other way.

keys with deeper travel and 
stronger feedback to a wider glass 
trackpad that actually clicks, it 
seems nothing was off the table.

But the most important 
improvement to the Touch Cover 
is the brand new double hinge. 
Equipped with a strong magnet 
that latches onto the Pro 3's lower 
bezel, the Type Cover can now rest 
with just a portion touching your 
lap or desk. This makes writing 
with it balanced on your lap much 
easier and more stable than with 
previous Surface devices.

Tucked beside the Type Cover is 
the newly improved Surface Pen. 
The new stylus has an aluminium 
finish, and is weighted to make it 
feel more like an actual pen. Using 
Bluetooth and powered by N-trig, 
the stylus tracks closer to its 
physical position than ever before 
thanks to major improvements to 
the Surface Pro 3’s screen.

Starting at £639/$799, the Surface 
Pro 3 can be configured with an 
Intel Core i3, i5 or i7 processor, and 
between 64GB and 512GB of 
storage. That price also gets you a 
1.3GHz processor, a 9.7-inch display 
at 2,048 x 1,536 resolution, 
802.11a/b/g/n dual-channel Wi-Fi 
with MIMO and Bluetooth 4.0. 
While it's tough to compare these 
displays given their difference in 

size, the iPad Air has a tough time 
competing with the Surface Pro 3 
on paper. We had a Core i5 variant 
on test, which costs £849/$1,300 for 
a 128GB unit. 

Power vacuum
Battery life isn’t terrific, and isn't 
even close to the best we've seen 
from a tablet. In our tests (over 10 
browser tabs, Spotify streaming 
high bit-rate audio, TweetDeck 
running, a chat client active and the 
keyboard backlit) the Surface Pro 
lasted three hours and 55 minutes. 

Microsoft claims you can eke out 
nine hours of use, but that would 
be really pushing it. Lowering the 
brightness will undoubtedly boost 
endurance, and the tablet can last 
for days on standby, but this is a 
device meant to handle relatively 
heavy workloads and we can't help 
being disappointed.

The Surface Pro 3 is, without 
question, the most attractive and 
capable device that Microsoft has 
ever produced. As a result, it's not 
only the closest to realising the 
company's vision for replacing the 
laptop, but closer than any hybrid 
device to date. Everything about 
the Surface Pro 3 design screams 
style and thoughtfulness. Microsoft 
took the entire Surface Pro 2 back 
to the drawing board with this 

“The Surface Pro 3 is the most attractive and 
capable device Microsoft has ever produced”

Upgrade 
Microsoft Surface Pro 3
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Microsoft Surface Pro 3
Supplier www.microsoftstore.com
Operating system Windows 8.1 Pro
Processor Intel Core i3, i5 or i7
Storage 64 to 512 GB
RAM 4GB or 8GB
Graphics Intel HD 4000
Connectivity USB 3.0, micro SD,  
mini DisplayPort 
Weight 800g 
Screen size 12-inch 
Display resolution 2,160 x 1,440



Whether you have a 
smartphone, a tablet or 
an Ultrabook (or even 

all three!) it can’t have escaped 
your notice that mobility is all the 
rage, but sometimes there’s just 
no substitute for a good screen. 

Big portables have generally 
gone out of fashion these days, 
with one significant exception: 
powerful gaming laptops. Enter 
the Medion Erazer X7611. This 
full-on desktop replacement 
gaming portable comes with a 
monumental 17.3-inch, full 1080p 
display. It packs a full-on Intel 
quad-core processor and Nvidia 
graphics with 2GB of video 
memory. For storage, you get both 
solid state and magnetic drives. 
Oh, and there’s the minor matter 
of a mere 16GB of system memory.

It also sports a plethora of ports 
and card readers, a webcam and 
integrated sound complete with a 
subwoofer. By now you should be 
getting an idea of a system that 

doesn’t just tick the desktop-
replacement box – it  really delivers 
on the notion. Despite all that, it’s 
just 2.3cm thick. Okay, the 17-inch 
screen makes for a chassis that’s 
over 40cm wide, but that’s just one 
of those things. 

Portable power
First up, let’s take a good look at 
the processing power. Intel now 
offers a truly baffling array of 
processor models, so you may not 
have heard of the Core i7-4700HQ. 
Don’t worry though – it’s barely 
any different to any other current 
quad-core processor; the only 
notable variation is the clockspeed 
and the amount of cache memory. 
This particular item rocks in at 
2.4GHz stock speed and 3.4GHz 
Turbo, and sports 6MB of on-die 
cache memory. That puts it towards 
the low end of Intel’s quad-core 
mobile lineup, but make no 
mistake, it’s an extremely powerful 
quad-core chip by any sensible 

metric. You definitely won’t want 
for raw CPU power with this laptop.

Slightly more open to debate is 
the fitness of the Nvidia GeForce 
GTX 765M graphics for purpose. 
While a low-end Intel quad-core 
chip is very nearly the same as a 
high-end quad-core model, that’s 
not so for graphics. The GTX 765M 
is a proper discrete 3D chip that’s 
designed for gaming, but its 
specifications are pretty modest.  
For comparison, Nvidia’s fastest 
desktop graphics offer nearly four 
times the processing cores and 
increased specs in other areas 
too. As a result, it is less than half 
as powerful as the fastest mobile 
graphics chip Nvidia currently 
produces. For an idea of how well 
an older arcade-style game runs, 
GRID 2 flies along at 70 frames per 
second in full HD 1080p with all the 
settings cranked up to high, which 
looks very nice. Less impressive 
is Call of Juarez: Gunslinger. Here 
you’re looking at a sluggish 22 

Medion Erazer X7611
£1,445 | $na www.medion.com

A powerful laptop that’s just as good for work as for play
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but with smaller notebooks now 
offering something approaching 
all-day longevity, it’s not that 
wonderful either. More of an 
unambiguous win is the overall 
build and robustness of the chassis. 
It’s extremely solid and doesn’t flex 
at all during use – and that includes 
the backlit keyboard. 

The downside, apart from girth 
and weight, is usually price. On 
paper, the Medion Erazer seems to 
attack all those issues. It’s relatively 
thin and light, and pretty affordable 
for this sort of system. Medion is 
broadly a budget brand, but you 
won’t feel like you’ve cut corners 
as it is a sleek-looking, solid-feeling 
portable. The specifications are 
good on the whole too. The 
quad-core Intel CPU is all you’ll ever 
need, and there’s a mix of fast SSD 
and magnetic mass storage along 
with oodles of RAM. It’s a fine line, 
but the Nvidia GeForce GTX 765M 
probably doesn’t offer quite the 
level of gaming grunt we’re after 
from a specialist portable. This is 
a genuinely gameable system, 
but as a pure gaming laptop it  
is a bit mediocre and has little 
performance to spare. The three 
and a half hours of battery life will 
also be a deal breaker for some. 
Thankfully, the 17.3-inch 1080p 
LCD is generally a nice panel and 
well suited to gaming and there 
are plenty of ports on offer. While 
the machine is so-so for gaming, 
as a broader multimedia desktop 
replacement system the Medion 
is much more compelling. It’s a 
quality item with a nice screen and 
excellent all-round performance. ■

A good entertainment all-
rounder, but the graphics let it 
down as a gaming laptop.

frames per second, again at 1080p 
and high-quality settings. Results 
from the geometry-heavy Heaven 
benchmark, meanwhile, are down 
at just 14 frames per second at 
similar settings. Of course, you can 
always improve those numbers by 
cutting back on the eye candy, but 
the overall feeling is of a gaming 
system that will require you to 
make compromises and fine-tune 
the settings. It’s certainly not 
powerful enough for you to simply 
fire up any modern game and set 
everything to maximum.

Next up: storage. Our test sample 
came with a 128GB Sandisk SSD, 
but Medion’s official specification 
list reveals that a 64GB drive is the 
option at this price point. Alongside 
the SSD is a 1TB conventional 
magnetic drive for mass storage. 
However, it’s likely that any 64GB 
SSD will offer more modest 
performance due to the limitations 
of smaller SSDs involving boring 
stuff like memory chip counts. It’s 
unlikely to be a deal-breaker, but 
it’s still something that’s worth 
bearing in mind.

The 128GB Sandisk drive supplied 
in our review unit puts in some 
pretty decent numbers, with 
around 450MB/s sequential reads 
and 250MB/s writes. The random 
access performance is good, too.

There’s also a very healthy 16GB 
of RAM – much more than you’ll 
probably ever need. The screen is 
a 17.3-inch LED backlit item with a 
resolution of 1,920 x 1,080 pixels. It’s 
not a new IPS display, but is instead 
a less expensive TN panel. It doesn’t 
offer the expansive viewing angles 
of an IPS panel, but nor is it a really 
cheap-looking variant, either. 
Colours are pleasingly rich, and 
contrast is decent. The response 
rates are pretty nippy for a mobile 
panel, which is welcome for a 
portable with a gaming remit. 

For the record, there is no optical 
drive. Perhaps that’s surprising for 
a 17-inch laptop, especially one so 
targeted towards gaming. But then 
again, with the popularity of digital 
downloads, the days of optical are 
very nearly dead. 

Easy listening
The built-in audio system is 
another strong point. While the 
sound quality won’t impress a true 
audiophile, the volume levels are 
darn good for a laptop, and that 
means you could take the Erazer 
on your holidays without needing 
to bring a spare set of speakers. 

Unfortunately, battery life is best 
described as middling. Three and a 
half hours of 720p video playback 
isn’t bad for a 17-inch machine, 

“It’s a quality laptop with a nice screen and great 
all-round performance for more than just gaming”

Upgrade 
Medion Erazer X9611
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Medion Erazer X7611
Supplier www.medion.com
Operating system Windows 8.1
Processor Intel Core i7-4700HQ 2.4Ghz
Storage 1 TB HDD, 64 GB SSD
RAM 16GB
Graphics Nvidia GeForce GTX 765M
Connectivity 2x USB 3.0, 2x mini Display 
Port, 1x HDMI, Ethernet, card reader 
Weight 2.7kg 
Screen size 17.3-inch 
Display resolution 1,920 x 1,080



 Construction workers 
 are agonisingly slow

Rather than inhabiting the 
genre’s favoured role as the 
god-mayor of urban planning, 
in Tropico 5 you play a banana 
republic’s ruling dynasty. You 
still use the time-honoured 
top-down view to place 
buildings and trade goods, but 
are also tasked with navigating 
the island’s politics – surviving 
the international machinations 
of world superpowers, while 
managing your people’s desire 
for democracy and happiness.

Haemimont’s previous two 
Tropico games took place 
around the Cold War, but this 
time the action spans multiple 
eras. It changes the pace and 
shape of a sandbox campaign, 
offering a prolonged period of 

Refines the city-building series, but fails to advance it meaningfully
Price £35 | $40
Developer Haemimont Games
Publisher Kalypso Media   
Multiplayer 2-4 players  DRM Steam Web www.tropico5.com
Recommended specs Quad-core CPU, 8GB RAM, 1,024MB GPU

island management 
that encourages a broader 
range of industry and 
development. It also restricts 
early-game options, making it 
harder to retain power.

After declaring 
independence from the crown 
during the colonial era, my 
people asked for elections. 
Foolishly I agreed, having 
been conditioned by previous 
games to expect an easy win. 
However, without access to 
the advanced industry that 
would normally bulk up my 
war chest, I wasn’t able to 
effectively address the needs 
of the populace. So, instead of 
securing power through the 
creation of a paradise, I did it 

Frankly, I am not the 
kind of man you want 
running your country. 
Over the course of my 

presidency I’ve smuggled rum 
into a prohibition America, 
sided with Axis powers during 
both World Wars, stripped 
away the rights of my citizens, 
and assassinated a grandma 
for opposing my regime. 

I’m not proud of these 
things, but I’m glad that I felt 
the need to do them. For all 
that Tropico 5 adds to the 
city-building series – and all 
the ways it doesn’t advance 
the formula enough – its 
greatest success is in pushing 
you towards the murkier 
aspects of dictatorial rule.

Tropico 5
via the more realistic tools of 
intimidation and fraud.

Optional missions help add 
a dynamic element to the 
sandbox mode, by requesting 
specific buildings or criteria. 
But their limitations are clear, 
as instead of reacting to the 
specific choices you’ve made, 
they’re pulled – seemingly at 
random – from a pool of 
possibilities. I was offered 
objectives I’d already fulfilled, 
and was rewarded upon 
accepting them. Better 
implemented are the requests 
that come from agreeing to 
negotiate with protesters, 
which are offered in response 
to the failings of your island.

Electoral reform
You can switch between 
family members each election, 
and they all offer a different 
global bonus. These bonuses 
can be upgraded with the aid 
of embezzled funds, so when 
a faction offers you a choice 
between extra trade routes, 
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 Overlays provide extra information  
 This one is calling my city ugly

 This neighbourhood is  
 poor, but pretty with it

 Zoom in, and you’ll see guards  
 patrolling the presidential palace

 Colonial buildings are  
 plain and ineffective

 Different islands offer unique  
 economic challenges

more finance or your own 
slush fund, it feels like a more 
meaningful decision.

For all its improvements, 
Tropico 5 is still iterating on the 
template set by its forebearers. 
The formula is deceptively 
clever behind the political 
caricatures, but Tropico 5 fails 
to meaningfully move the 
series forward. Newcomers 
shouldn’t be put off, but as a 
returning ruler, I was hoping 
for more of a revolution. ■

Not a dramatic reinvention of 
the series or genre, but still 
an enjoyable game. 

Every vote counts
How to win elections, Tropico style

Total
dictator

Benevolent
leader

Systemic  
reform

Smear 
campaign

Vote  
rigging

Martial 
law

Upgrade 
Tropico 5
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 Geb, the Egyptian god of 
 earth, likes to rock and roll

abilities, and is on top of the 
next before I can even help. 
Two free kills. They didn’t see 
him because they never 
turned around. And if you 
never turn around in Smite, 
you’re probably going to die.

By taking away the genre’s 
standard top-down camera, 
Smite transforms the wizard-
’em-up into a game of 
close-range kills, clutch 
dodges and precision 
skillshots. In an overcrowded 
market, the game 
distinguishes itself not with 
what it adds to the formula, 
but with what it strips away. 

Judging distance in three 
dimensions is far harder in 
Smite than it is with a top-

A generous and accessible alternative to the bigger lane-pushers
Price Free  
Developer Hi-Rez Studios
Publisher In-house   
Multiplayer 5v5  DRM Steam Web www.hirezstudios.com/smite
Recommended specs Dual-core CPU, 2GB RAM, Radeon 7750

down camera. In LoL, many of 
the champions can land basic 
attacks and devastating 
abilities with just a simple 
click. They can’t miss. In Smite, 
however, almost everything 
can miss. In one particular 
match I played as Vulcan (the 
Roman fire god, not Mr Spock). 
I had Egyptian goddess Neith 
dead to rights. She was down 
to a sliver of health when I 
launched my Ultimate ability, a 
rocket that creates an Age of 
Empires circle as wide as a lane. 
There was no way she could 
flee in time. But at the last 
second, she used Back Flip – 
not to jump out of the circle, 
but to be in the air as the 
missile landed. She got away.

They have no idea I’m 
here,” says teammate 
Lucas Sullivan as he 
sneaks up behind two 

enemy gods in my lane. I’m 
casually killing minions in front 
of my tower in Conquest mode, 
Smite’s take on the 5v5 
lane-based game codified by 
Dota and League of Legends 
(LoL). On a strategic level, it 
plays almost identically to LoL, 
but it tucks the camera in close 
behind your character’s back, 
and feels more like a third-
person action game. 

“They have no idea I’m 
here,” Lucas repeats, as he 
moves into attack range 
behind our targets. He kills 
one with a flurry of special 

Smite
Each attack that you 

manage to land, whether it’s 
Egyptian god Anhur’s javelins 
or Poseidon’s blasts of water, 
feels like a minor victory. Each 
attack that you dodge feels 
like a major accomplishment.

Deity business
Smite’s combat is so much fun 
that I ended up spending 
more time playing in the 
action-focused Arena mode 
than Conquest mode. Arena is 
essentially a team deathmatch 
with accelerated levelling. 
Each kill peels points away 
from the enemy team’s score, 
and the whole thing is over 
inside 20 minutes. It’s a great 
way to test out a new god. 

Despite its demand for 
precision, Smite is more 
approachable than Dota 2 or 
LoL. Battles are frantic, but 
most gods have abilities that 
let them leap out of combat or 
chase a fleeing foe.

Experience and gold are 
shared within a short range, so 
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Arena mode: what happens  
when Zeus starts a bar fight 

 Not pictured: dying five seconds 
later while chasing a pentakill

 Large sword is large

 There’s a rotating 
 roster of free gods

 You might call this   
 a god’s eye view 

getting the last hit on a minion 
to kill it isn’t a critical part of 
the laning phase. The meta 
levelling progression, however, 
is missing something. 
Levelling an account to 30 
simply grants players access to 
ranked league matches, with 
no extra unlocks or rewards 

along the way. Why not let me 
jump into ranked play earlier, if 
I want to? 

A robust voice-command 
system adapted from Tribes: 
Ascend simplifies callouts such 
as ‘missing in action’, ‘retreat’ 
and so on. It makes teamwork 
with strangers very effective. 

Interestingly, Smite has one of 
the least vitriolic competitive 
communities I’ve played with.

The free-to-play economy is 
also refreshingly streamlined. 
You can’t spend money on 
anything that affects the 
game’s balance. Real money 
and in-game currency are only 

used to purchase new gods, 
skins and voice packs. 

Perhaps my strongest 
endorsement is that whereas 
in League of Legends I spent a 
great deal of time mastering 
one champion that I loved, in 
Smite I’m finding something to 
like in almost every god I play. 
I don’t think that I’ve truly 
mastered any of them yet, but 
I have, at least, learned to 
watch my back. ■

Smite makes the genre more 
approachable with smart 
tweaks to the formula.

GOd Squad
The roles of four of 
Smite’s 52 gods

Isis
Egyptian

Goddess of magic

Versatile mage with high
 crowd control

Ah Muzen Cab
Mayan

God of bees, honey

Ranged DOT, 
area denial hunter

Cupid
Roman

God of love, attraction

Ranged hunter 
with high sustain

Aphrodite
Greek

Goddess of love, beauty

Area denial specialist,
single-target support mage

Origin

In mythology

In Smite

Upgrade 
Smite
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bandits, you get a menagerie 
that includes werewolves, 
vampires, dragons and, yes, 
Great Turtles.

Yet the differences go 
beyond the use of magic. This 
is a more streamlined 
experience, with a greater 
emphasis on battle. Whereas 
Civilization V’s bandits are 
more of a Band-Aid, livening 
up the early game, Warlock 2’s 
unaffiliated foes are a constant 
threat – sometimes more 
deadly than your opponents. 
The game pushes you into a 
more militaristic campaign.  
A show of force isn’t the only 
route to victory, but 
neglecting your army is a 
certain path to defeat.

Same, but different
If you’ve played the original 
Warlock: Master of the Arcane, 

See through the new features and you’ll find something very familiar
Price £25 | $30
Developer Ino-Co Plus
Publisher Paradox Interactive  
Multiplayer Up to eight  DRM Steam Web www.warlock2.com
Recommended specs 3.2GHz CPU, 4GB RAM, 1,024MB GPU

this will all sound familiar. And 
if you’ve glanced over the 
screenshots, this will all look 
familiar as well. Warlock 2 does 
the sequel essentials – new 
races, units, monsters and 
buildings – but its changes are 
more subtle.

The most significant new 
feature here is Exiled mode, a 
campaign in which each Mage 
is cast out to a small ‘shard’ 
dimension. Your empire must 
spread across multiple worlds 
as you use portals to work 
your way home. 

In the sandbox campaign, 
these shards fall on the wrong 
side of risk/reward, hiding 
valuable resources behind an 
absurd number of monsters. 
My armies were torn apart 
quicker than I could reinforce 
them. In Exiled, the shards are 
smaller, and scale in difficulty. 

My empire is in ruins. It 
had such a strong start, 
too. My cities were 
spreading, my resources 

were all finely balanced, and 
my army was developing into a 
fearsome force of monsters 
and heroes. Now they’re all 
gone, having been consumed 
on three sides by the 
continuously spawning might 
of ginormous, armoured, 
fire-breathing reptiles. I have 
been defeated. By turtles. 

At the broadest level, 
Warlock 2 plays like Civilization 
V with wizards. It’s a hex-grid 
turn-based fantasy 4X where 
you found cities, construct 
buildings, conduct research, 
raise an army and war against 
rival Great Mages. Instead of 
technology, you have spells; 
instead of wheat, you have 
Magic Fields; and instead of 

Warlock 2: The Exiled
The focus becomes 
exploration: working from 
forest world, to lava world, to 
death world, while taking out 
spawn points and dispatching 
scripted bosses.

Of course, that’s assuming 
you don’t find yourself 
stranded on the wrong end of 
a randomly generated map. 
One time, my units were 
teleported to a section of an 
ice world surrounded by 
impassable terrain. Had it 
happened later, I could have 
used spells to flatten the 
mountains. Instead, I was 
forced to wait while my 
opponents made full use of 
their advantage. 

Creative damage
Exiled’s strength is the way in 
which it encourages players to 
push forward. Progress means 
you’re closer to victory, but 
also that your armies are 
increasingly stretched. An 
unexpected attack two maps 
behind your main force can 
require some inventive 
solutions. Spells can help, but 
do you summon monsters, 
target with elemental damage, 

 Cool dragons don’t  
 look at explosions
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or haste your troops and rush 
back to a city under siege?

For all the mode’s triumphs, 
quests are repeated each 
playthrough, so the majority 
of my time was spent in the 
more dynamic sandbox. Here, 
the changes from the original 
game are relatively minor. The 
best is a new spell tech tree for 
spells, which gives proper 
progression to research. 

Rather than requiring you to 
specialise each city around the 
production of a particular unit, 
each of Warlock 2’s military 
buildings offers a limited 
number of bonuses. This shifts 
building management to an 
empire-wide level, and avoids 
the late-game churn of 
ultra-powerful units.

These changes are offset by 
some lingering problems, 
most noticeably the AI, which 
would often fail to seize the 
initiative, offering alliances and 
non-aggression pacts while I 

happily raised my armies. To 
be fair, the campaign setup 
options are flexible enough to 
mitigate such pacifism. 
Balance issues aside, it’s easy 
to spend hours warring 
against fantasy factions. 

Warlock 2 is definitely the 
best version of the enjoyably 
streamlined strategy series. 
Having said that, for owners of 
the original game, it isn’t so 
much better that it is worth 
giving a wholehearted 
recommendation. ■

Oh look, devs who 
like Monty Python

 “I am Turtle, destroyer of worlds!”

 Doomford is a lovely 
 chasm-side retreat

 The battle of the 
 floaty magic lizards

 The aptly named 
 Armageddon spell

A fun strategy game that 
improves on its predecessor, 
but not as much as we’d like.

Shard-enfreude
What to expect on other worlds

Lava world
Dragons are the uber-jerks of 
fantasy fighting and their 
flames extend across two 
hexes. They can only be 
attacked at range.

 Dead world
Vampires are powerful, 

deadly and hard to kill. As if 
that wasn’t enough, they 

leach health from your 
units, too.

 Tropical world
The flame breath attack of 
turtles is powerful, but it’s 

the absurd number of 
hit-points that makes them 

so troublesome.

Ice world
Snow Queen’s icy attacks 
can be devastating. They 
stun targeted units, 
preventing them from 
moving for two turns.

Upgrade 
Warlock 2: The Exiled
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 Each track has three  
 bespoke challenges

Four-man multiplayer 
is local only

 The lighting is insane
 Tracks contain warp points 

 and secret squirrels

 Superman over a canyon? 
 Sure, why not

weight accordingly, rock back, 
then snap forwards with 
purpose. The controls are 
basic but versatile, and you’ll 
find your own methods of 
moving between the buttons.

That’s the reason those 
montages of rad dudes doing 
cool stuff are better to watch 
than play – because essentially 
all they’re doing is holding 
‘Accelerate’ and letting the 
course do the work. It’s fun, 
but hardly challenging. Trials 
Fusion comes into its own 
when making slow progress.

Tricks and tracks
Trials Fusion, like its 
predecessors, almost qualifies 
as two different games. While 

Going head over handlebars for a bike-based physics lesson
Price £16 | $20
Developer RedLynx
Publisher Ubisoft   
Multiplayer Up to four  DRM Steam Web www.bit.ly/QgxvOb
Recommended specs Intel Core i3 550 3.2GHz, 3GB, GeForce GTS450 

the punishing second half 
deals in piecemeal progress, 
the first is all about monster 
tricks and constant forward 
motion. There are urban 
sprawls where shiny 
spaceships dock and cars 
whizz down roads. While 
impressive to look at, it’s 
almost distracting.

Tricks are new. They don’t 
net you points, unless we’re 
talking about the FMX mode 
where only top stunts assure a 
good finish. If anything they’re 
more like a great temptation, 
making the fight not only 
between you and the course, 
but also your ego. You could 
do the job quickly, or you 
could do it right.

Trials Fusion has one of 
the most brutally 
honest trailers ever. 
Ignore the early 

dubstep-fuelled montages of 
rad dudes doing cool stuff; 
that’s only part of the game. 
Mostly, you’ll be biting it. Hard. 

The trailer presents an 
ignoble reel of spills. After 
each one, the player’s name 
plummets down a 
leaderboard. It captures the 
spirit of a game devious 
enough to continuously knock 
you on your backside, but 
compelling enough to keep 
you rising to your feet. 

It’s about friction, 
momentum and gravity. To 
jump, you must distribute your 

Trials Fusion
If it wasn’t clear from the 

booming electronic menu 
music with its “Welcome to 
the future!” chorus, collection 
of detailed tracks, and a 
primed and ready-to-go 
method of letting players 
create and share tracks, Trials 
Fusion is a Big Game. It is a 
bona fide platform. However, 
while that’s great, that isn’t the 
best part. No, the best part, 
just like in a touching sports 
movie, is in all the tumbles, 
trips and spills. The small 
motions rather than the 
massive gestures. ■

The thrill is found in the 
clearing of an overhanging 
ledge with efficient grace.
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spent on new units – if you’ve 
kept a path clear to receive 
them. The in-game AI is still 
so bloody good and the game 
so fast-moving that I resorted 
to much slower game speeds 
just to have a chance. Careful 
recon and fast decisions are 
key, especially given the 
reduced lines of sight of the 
jungle setting. The major 
absence is of the strategic 
cards from AirLand, and 
Wargame is more pure without 
them, if a little less strategic.

Ship shape
The biggest addition is naval 
warfare. You get landing craft 
and amphibious units, and 
the ability of the bigger ships 
to destroy any land or air 
enemy changes the structure 
of any battle with a coastline. 
Naval-only skirmishes are of 

Alternative history suggests an uncomfortable future
Price £30 | $40
Developer Eugen Systems
Publisher Focus Home Interactive  
Multiplayer Up to 20  DRM Steam Web www.wargame-rd.com
Recommended specs Dual Core, 2GB RAM, Radeon X1800/GeForce 7600GT

limited value, as the maps are 
rarely big enough, but they’re 
good training. 

Eugen has also introduced 
over 600 new units, from 
Australasia, Korea and China. 
Many merely replicate 
others, but the new REDFOR 
troops are often relatively 
cheap, enabling you to easily 
outnumber your opponent 
– even if they can’t hit the 
broad side of a Berlin Wall.

Four mid-length campaigns 
explore four conflicts of the 
chosen era in Asia. They’re 
enjoyably provocative and 
well-presented, featuring a 
range of battles. Using a 
high-tech post-Falklands UK 
against China over Hong Kong, 
or US marines in a touchy 
second Korean war is very 
different from a tough battle 
between lower tech Russia 

The 1970s-90s conflicts 
in the latest Wargame 
expandalone have a 
grim ring of familiarity. 

Campaigns include a second 
Korean War, Russia against 
China and Japan, and the US 
against Russia – all horribly 
plausible today. 

As in previous games in the 
series, you control roughly 
modern armies fighting over 
a post-WWII world. In the 
campaigns and solo skirmishes 
you move battlegroups on 
a high-level strategic map, 
taking turns with your foe. If 
you’re on the same territory, 
either of you can start a 
conflict in a more familiar 
real-time strategy setting, 
shared with the multiplayer. 

At this level you receive 
resources from holding 
capture points, which can be 

Wargame: Red Dragon and the US/Japan/South Korea. 
The only annoyance of note 
here is the removal of the 
co-op campaigns. 

The multiplayer is again 
the heart of the game. It’s a 
lovely system, but lightweight 
strategy gamers who want the 
Age of Empires popcorn thrill of 
an easily-understood conflict 
are going to balk at the 1,400+ 
units, lack of tutorials and 
the speed of play, especially 
online. Turtlers will find the 
game’s speed and mobility 
challenging. Open-minded 
strategy veterans who haven’t 
played the first two can 
probably get them cheaper 
than this in a Steam sale – 
the original is just £8 at the 
time of writing. Old hands 
will enjoy the ships, changed 
environments and array of 
new units – but then they’re 
probably already playing. ■

Gives with one hand and 
takes with the other, but is 
still the best war sim around.

 If I bomb that town I get 
 a buff to my golf skill 

 Naval combat is the big 
 addition in Red Dragon 

 This is not the way to  
 defend against North Korea 

 Keeping corridors 
 clear is crucial 

 Note to self: 
 buy more napalm 

Upgrade 
Wargame: Red Dragon
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Your disc
Hello and welcome 
to your free disc, 
exclusive to 
Windows 7 Help & 
Advice. This month’s 

packed CD-ROM features great 
programs to help you get the 
best from your computer, plus 
essential resources for every 
Windows user.

This issue we’ve put together 
a brilliant set of tools to help 
you keep your files in order, 
plus an assortment of apps 
for giving your computer a 
thorough cleaning. You’ll also 
find a set of free media players 
for your music and films. Enjoy! 

Jeremy Ford Disc editor
jeremy.ford@futurenet.com

Welcome This issue’s highlights

1 Get started 
Place your free disc into your computer’s disc drive. The 

AutoPlay prompt should appear on your screen and once this  
has happened, click ‘Run OWV.exe’ to start up the disc interface.  
A new window appears, telling you some important information. 
Read it, then click on ‘I agree’ to continue.

2 Browse the categories 
Click on one of the categories in the menu underneath the 

magazine logo to discover all the programs that are contained in 
each. Simply click on an app’s name to find out more about it.  
Full commercial products usually have information about how  
to register. To try out an app, just click the ‘Install Now’ button.

Step-by-step How to use your free disc

73 Let CCleaner give your 
computer a good clean and tidy

26 Process photos in batches  
with FastStone Image Viewer

76 Use iObit Uninstaller to get  
rid of unwanted programs

34 Take the hassle out of file 
management with DropIt

 full productS   Handpicked toolkitS   eSSential reSourceS
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Your disc
Make the most of it!

3 install the program 
When you begin to install your chosen applications, the  

disc brings up another message window to take you through the 
installation process. Each one of these is different – just follow the 
prompts until you get a message telling you that the installation 
is complete. Now it’s time to try out your free apps – have fun!

Find the solution! How to get your disc to play
If the disc doesn’t start automatically, hit the Windows key, then 
click Computer. Now double click the DVD drive to get going.

if you have  
a problem…
Please visit www.
futurenet.com/support. 
To contact our reader 
support team, email 
support@futurenet.com 
or call 01225 822743, 
quoting the magazine 
name and issue. We are 
only able to provide help 
with this disc, not the 
software contained on it.

 
file manaGement
•  CloneSpy
•  Comodo Backup
•  DocFetcher
•  DropIt
•  EagleGet
•  Everything
•  Explorer++
•  MultiCommander
•  PeaZip
•  TeraCopy

media playerS
•  AIMP
•  Clementine Music Player
•  GOM Media Player
•  IrfanView
•  MediaPortal
•  Miro
•  OrangeCD Player
•  RarmaRadio
•  VLC Media Player
•  XnView Extended

SyStem cleaninG
•  CCleaner
•  Cloud System Booster
•  GeekUninstaller
•  Glary Utilities
•  IObit Uninstaller
•  PrivaZer
•  System Mechanic FREE
•  ToolWiz Care
•  WinDirStat
•  Wise Care 365 Free

extraS
•  Auslogics Disk Defrag
•  Avira AntiVir Personal
•  CopyQ
•  Essential guides
•  FastStone Image Viewer
•  Malwarebytes Anti-

Exploit
•  Pale Moon
•  RogueKiller
•  SmartPower
•  Windows Repair

Full disc  
contents
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